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Password Safe Cloud Administration Guide

Password Safe Cloud is your privileged access management solution to ensure your resources are protected from insider threats. It
combines privileged password and session management to discover, manage, and audit all privileged credential activity.

Password Safe Cloud creates and secures privileged accounts through automated password management, encryption, secure storage of
credentials, and a sealed operating system.

Password Safe Cloud's random password generator algorithm does not use any common phrases or dictionary words as inputs or in its
generation. It selects each password character randomly from the list of allowable characters, numerals, and symbols to build the
password.

Password Safe Cloud is supported on hardened secured virtual machines in an Azure environment that create and secure privileged
accounts through automated password management, encryption, secure storage of credentials, and a sealed operating system.

More specifically, you can use Password Safe to accomplish the following:

Scan, identify, and profile all assets for automated Password Safe management, ensuring no credentials are left unmanaged.
Control privileged user accounts, applications, SSH keys, cloud admin accounts, RPA accounts, and more.

Use adaptive access control for automated evaluation of just-in-time context for authorization access requests.

Monitor and record live sessions in real time and pause or terminate suspicious sessions.

o & b=

Enable a searchable audit trail for compliance and forensics, and achieve complete control and accountability over privileged
accounts.

6. Restrict access to critical systems, including assets and applications, keeping them safe from potential inside threat risks.

For more information on configuring resource zones and installing resource brokers, please see the Password Safe Cloud
Resource Broker Installation and Configuration Guide at https://www.beyondtrust.com/docs/beyondinsight-password-
safe/ps/cloud/resource-broker/index.htm.
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Log In to the Beyondinsight Console

The admin credentials used to log in to the BeyondInsight console for the first time are configured during the installation process.
Afterward, the credentials you use to log in to the console depend on the type of authentication configured for your BeyondInsight system.
Logging into the console varies depending on the type of authentication configured for your system.

The following authentication types can be used:

« BeyondInsight: Create local users in BeyondInsight and add them to groups to assign permissions to features. Local users can
log in to the console from the BeyondInsight login page.

« Active Directory: Add Active Directory users in BeyondInsight and add them to groups to assign permissions to features. Active
Directory users can log in to the console from the BeyondInsight login page.

* Microsoft Entra ID: Add Entra ID users in BeyondInsight and add them to groups to assign permissions to features. Entra ID
users can log in to the console from the BeyondInsight login page.

x Note: To use Entra ID credentials for logging into Beyondinsight, the accounts must use SAML authentication. For more
information on configuring Entra ID SAML with Beyondinsight, please see Configure Microsoft Entra ID SAML with
Beyondinsight SAML at https://www.beyondirust.com/docs/beyondinsight-password-safe/bi/authentication/security-
provider.htm#configure-entra-id.

o LDAP: Add LDAP users and add them to groups to assign permissions to features. LDAP users can log in to the console from the
BeyondInsight login page.

« Two-Factor Authentication: Configure two-factor authentication with a RADIUS server or time-based one-time password
(TOTP) authenticator app, and assign it to users in BeyondInsight. Users are prompted for their two-factor login options after
providing their credentials on the BeyondInsight login page.

« Smart Card: Configure BeyondInsight to allow authentication using a smart card PIN. Users can bypass the BeyondInsight login
page and navigate to the smart card site access URL provided by the administrator to use smart card authentication.

« SAML Authentication: Configure SAML identity providers in BeyondInsight to use authentication for web tools that support
SAML 2.0 standard, such as PingID, Okta, and ADFS. Users can authenticate with the default SAML identity provider configured
in BeyondInsight by clicking the Use SAML Authentication link on the BeyondInsight login page. To log in using a SAML identity
provider other than the default provider, users can navigate to the SAML site access URL provided by the administrator.

« Claims-Aware: Configure a claims-aware website to bypass the current BeyondInsight login page and authenticate against any
configured Federated Service that uses SAML to issue claims.

x Note: When working in the console, the times displayed match the web browser on the local computer unless stated
otherwise.

Tologin:
1. Open a browser and enter the URL for your BeyondInsight / Password Safe cloud instance:
https://[<hostname>/WebConsole/index.html.

2. Enteryour username and password. The default username is Administrator, and the password is the administrator password you
setin the initialization email.

3. Ifapplicable, select a domain or LDAP Server from the Log in to list.
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Tip: The Log in to list is only displayed on the Login page when there are either AD or LDAP user groups created in the
BeyondiInsight console. The Log in to list is displayed by default, but may be disabled / enabled by an admin user by toggling
the Show list of domains/LDAP servers on login page setting from Configuration > System > Site Options page.

4. Click Log In.

5. Tologin using SAML Authentication, click the Use SAML Authentication link below the Log In button. You are redirected to the
single sign-on access site for the default SAML identity provider configured by your administrator in Beyondinsight.

x Note: If the initial login attempt fails, and two-factor authentication (2FA) is enabled, the user is taken to the 2FA page for
security reasons.

i For more information, please see the BeyondInsight and Password Safe Authentication Guide at

https.//www.beyondtrust.com/docs/beyondinsight-password-safe/bi/authentication/index.htm.

Log Out of the Console

To log out of the console, click Profile and preferences in the top-right

corner, and then click Log Out. . .
- e (W LogOut
Account Settings
Preferences
Theme
BeyondTrust Brand Colors -
Language
English (United States) A
BeyondInsight and Password Safe can be displayed in the following languages:
« English
« French
« German
+ Japanese
o Korean
« Portuguese
e Spanish
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If the Show language picker option is enabled in Configuration > System > Site Options > Localization, you can select a language
from the list on the Log In page or by clicking the Profile and preferences button, and then selecting it from the Language dropdown.
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Navigate the Console

Once logged into the BeyondInsight console, you are taken to the Home T wad
page, where the suite of features is easily accessible using any of the

following methods:

« Click the container cards.

yyyyyyyyyy

o Click the icons in the left sidebar.

ssssss

o Click Menu in the left sidebar to expand it, and then click your
desired feature.

« Click Quick Navigation in the top-right corner or press CTRL+K to
access a list of the commonly used features and your favorites.

uuuuuuuuuu

o Locate your desired feature from the list by typing at least 3
characters.

o Click the star next to any of the features in the list to add
them to your favorites. Favorites are displayed at the top of
the list.

o Click the star next to any favorite to remove it as favorite.

Container Cards

You can quickly access the following functionality from the container cards:

« Initiate a discovery scan to discover new systems and accounts.
« Create a new managed system manually.
« Set up Resource Brokers and Resource Zones to allow for connectivity to network segments.
» Access configuration settings for BeyondInsight and Password Safe components and objects.
o Access Password Safe to execute password requests and approvals.
+ View and manage assets.
« View and edit managed systems.
« View and edit managed accounts.
You can also view the following most recent information for your Resource Zones and Resource Brokers from the dynamically updated
dashboard card:
o List of Resource Zones and how many Resource Brokers are checked in for each Zone
« List of Resource Brokers, as well as the Zone they are in, and their health statuses

Left Sidebar

The following features are available from the left sidebar:

« Dashboard (Preview): Customize your dynamic dashboards using the Dashboard Editor.

+ Assets: Display and manage all assets. Access the Smart Rules page to create and manage Smart Groups. Add assets to
Password Safe management.

« Smart Rules: View and manage Smart Rules.
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« Discovery: Run and schedule discovery scans, review active, completed, and scheduled scans, and view the list of discovery
scanners.

« Managed Systems: View and configure properties for Password Safe managed systems, managed databases, managed
directories, managed applications, and their associated Smart Rules.

+ Managed Accounts: View and configure properties for Password Safe managed accounts and their associated Smart Rules.

« Password Safe: Access the Password Safe web portal to request passwords and remote access sessions and to approve
requests.

+ Secrets Safe: View and manage team secrets.
« Analytics & Reporting: Access reports on collected data.

« Configuration: Configure BeyondIinsight and Password Safe components and objects, such as users and groups, authentication
settings, connectors, and much more.

o About: Access helpful links. View the current BeyondInsight version information, as well as the history of installed versions.

Switch Between BeyondTrust Applications

If you have BeyondTrust Identity Security Insights, you can connect Password Safe Cloud and other BeyondTrust applications, and then
switch between applications without needing to re-enter credentials. Re-entering credentials may be necessary in some circumstances,
depending on the login configuration of the different applications.

The App Switcher menu appears in the upper right. Click the menu for a list of connected applications, and click an application. There
can be more than one instance of an application, except for Identity Security Insights.

The menu only appears if there are connected applications. If all connected applications are removed from the Insights instance, then the
menu no longer displays.

Configuration of this feature is managed in BeyondTrust Identity Security Insights.

For more information on installing and configuring Resource Brokers and Zones, please refer to the Password Safe Cloud
Resource Broker Configuration and Installation Guide at https://www.beyondtrust.com/docs/beyondinsight-password-
safe/ps/cloud/resource-broker/index.htm.

Manage Toast Messages and Notifications in Beyondinsight

During your session, BeyondInsight displays toast messages to indicate

successes, failures, warnings, and errors for actions you have taken. Toast ‘ - i

messages auto-dismiss after 8 seconds based on a timer. There may be 4 CQuick Navigation 328 £ 9
multiple messages displayed at once. A control bar displays above the

message(s) that can be used to control the message timer. You can control

the messages as follows:

« Click Dismiss directly in a message to dismiss that specific o REE ° Resume o Dismiss All
message immediately.

« Use the control bar above the message(s) to pause all timers, ,
There was a problem fetching

resume all timers, or dismiss all messages. . Dismiss
domains.
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Toast messages that you haven't dismissed but instead have timed out can
be reviewed in the Message Notification Center by clicking the
Notifications (bell) icon in the top right of the console. This allows you to ® ATQ:;: was a problem ftching domains. x
view more details for errors or warnings if they exist, and dismiss them. S

Notifications

There are one or more invalid fields. Please correct the >

More details about the Message Notification Center are as follows: @ errors andtry again. x

Apr 03, 2024, 2:56 PM

» Success messages are not sent to the notification center, whether - -
or not they were dismissed.

1

« A max of 6 messages can be displayed at once and a scroll bar is
provided to view more as needed.

« The notification center can show up to 100 of the most recent notifications, sorted from newest to oldest.
« Notifications that are older than 1 hour are not available.
« Once you log out of BeyondInsight, any notifications that existed in the notification center are cleared and are no longer available.
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Add Assets to Password Safe

This chapter provides a high-level overview of adding systems and accounts to be managed by Password Safe. Once assets are
managed by Password Safe, selected users can request access to them. For details on adding specific systems, please refer to the
chapter for the particular system in this guide.

A system and the associated account can be added to Password Safe in any of the following ways:

+ Manually: After an asset is added to the management console, you can add the asset to Password Safe.

« Smart Rules: You can create a Smart Rule with selected filter criteria, to match on the systems that you want to add to Password
Safe.

+ Discovery Scanning: You can run a Discovery Scan in BeyondInsight on a selected range of IP addresses.

Note: To maintain a manageable database size, assets and scan data is purged every 30 days. We recommend running
discovery scans at least every 30 days to refresh asset data.

Add Managed Systems and Accounts to Password Safe

There are three ways to add systems and accounts to Password Safe:

o Add the asset manually.
+ Run a Discovery Scan and then import the assets using an address group or directory query.

+ Use API scripts.
The following is a high-level overview of the steps required to add systems and accounts to be managed in Password Safe.

1. Add the functional account: A functional account is one that can access the system with the privileges required to manage and
change passwords for shared accounts on the system.

2. Add the managed system: A managed system is a computer or device where one or more account passwords are to be
maintained by Password Safe. Managed systems can be Windows machines, Unix/Linux machines, network devices, databases,
firewalls, routers, iLO machines, and LDAP or Active Directory domains.

3. Add the managed account: A managed account is an account on the managed system whose password is being stored and
maintained through Password Safe. Typically, managed accounts are privileged accounts that can perform administrative tasks
on the managed system.

4. Configure managed system settings: After a system is added to Password Safe, configure settings that apply to the managed
system.

5. Set up role based access: Create user groups that permit users to:

« Login to the Password Safe web portal.
« Assign Password Safe roles, such as Requester or Approver.
« Create access policies to permit accounts to access the systems, applications, and sessions, and to request password

releases.
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Create a Functional Account

A functional account on a managed system is required to manage passwords for accounts on that managed system. The passwords for
functional accounts cannot be retrieved through the Password Safe web portal.

(1) IMPORTANT!

Do not set up a functional account as a managed account. Functional accounts have built-in management capabilities and passwords
might fail to synchronize, causing issues.

x Note: The settings vary, depending on the type and platform chosen.

In BeyondInsight, go to Configuration > Privileged Access Management > Functional Accounts.
Click Create New Functional Account.

Select a type from the list.

Ll

Select a platform from the list.

x Note: The DSS authentication and Automatic password management settings are not supported if you are using the
elevated credential pbrun jumphost.

5. Provide credentials and a description for the account.

6. Provide an alias. The Alias value is shown in the selectors throughout Password Safe where you must select a functional account
to use.

7. Selecta Workgroup, if applicable.

8. Ifdesired, enable Automatic Password Management, and then select the password policy and change frequency. This option
enables automatic password changes for each managed system that this functional account is associated with at the designated
frequency.

Note: If the Automatic Password Management option is enabled, passwords are set immediately when a new functional
account is added to Password Safe. They are changed during the next scheduled rotation.

9. Click Create Functional Account.

Override a Functional Account Password

Every managed system that uses a specific functional account has a unique password associated with that functional account. The
password on the managed system might be out of sync with the password in Password Safe. You can override a functional account
password from the Functional Account section in the Advanced Details of a managed system.
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Add a Managed System Manually

Note: Settings vary depending on the platform type. When an account is manually added to a managed system, the default
configuration of the account is set to what is configured on the managed system.

There are two ways to add a managed system to Password Safe manually:

« From the Managed Systems page, click Create New Managed System, and then complete the Create New Managed System

form.

« From the Assets page, click the vertical ellipsis for an asset, then select Add to Password Safe, and then complete the Create
New Managed System form.

Below are the fields and settings with their descriptions that are available when creating a new managed system. The available fields
change depending on the Entity Type and Platform for the system.

Field / Setting Description or Action

Entity Type

Platform

Name

Port

Instance Number (SAP only)

Domain (Directory types only)
Description
DNS Name
IP Address

Allow Managed System to be
an Application Host (non-
Windows systems only)

NetBIOS Name (Windows,
Active Directory, and LDAP
systems only)

Workgroup
Port

Automatic Password Change
Options

Password Policy

Change Agent (available only
when Endpoint Privilege
Management is installed)

Type of system: Asset, Database, Directory, or Cloud.
The platform for the system based on the Entity Type.
Unique name for the system.

Default RDP port for new managed systems.

If you have added your System Application Products (SAP) environment to Password Safe
management, provide the instance number.

Name of the Domain where the directory resides.
Description for the system.
DNS name for the system.
IP address for the system.

Toggle on or off to allow the system to be an application host.

Unique NetBIOS name for the system.

Select a pre-defined workgroup from the list.
Enter a port number.

Toggle Enabled to automatically check and update managed account passwords at a set frequency
or after password releases.

Select a Password Safe password policy or use the default policy. The policy provides the
requirements used by Password Safe to create passwords, such as password length and permitted
characters.

Select Password Safe or Endpoint Privilege Management client from the list.
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Field / Setting Description or Action

Elevation

Change Agent (available only
when Endpoint Privilege
Management is installed)

Functional Account

Use Login Account for SSH
Sessions

Account Name Format (For
Windows, Linux, Oracle, MS
SQL Server, and Active
Directory only)

Timeout

SSH Key Enforcement Mode

Default DSS Key Policy

Release Duration

Max Release Duration

Contact e-mail

Select an elevated account to run as: sudo, pmrun, pbrun, pbrun jumphost.

If you are using pbrun jumpost, enter the IP address for the Privilege Management for Unix & Linux
policy server that you want to connect to.

x Note: SSH Key Enforcement Mode is not available if you are using pbrun jumphost.

Select Password Safe or Endpoint Privilege Management Client from the list.

Select a functional account from the list. If a functional account is not available, click the Create New
Functional Account link. The link is located in two places, below the dropdown and within the
dropdown list. This allows you to create a functional account without leaving the Managed Systems

page.

x Note: The Create New Functional Account link is available to users with the Password
Safe Configuration Management feature permission.

Create a login account to allow the user to open an SSH session in environments where remote shell
access is not permitted, for instance the root account.

Login Account: Select the account name.

Select a format for the account name from the list: Domain\Account, UPN:
accountName@domainName, or sAMAccountName: Account Name only.

The timeout value determines the amount of time in seconds that a connection attempt to the
managed system remains active before being aborted. In most cases, we recommend you use the
default value (30 seconds). If there are problems with connection failures with the system, this value
can be increased.

Verifies SSH host keys from a known host. You can import SSH keys from a host using a Smart Rule.

Auto Accept Initial Key: The first key imported is automatically accepted. Any new key imported
after the initial key must be manually accepted.

Manually Accept Keys: SSH connections to the host are permitted for accepted keys only. If a new
key is detected from the host, the key is stored in the database and an email is sent to the
Administrators user group. The key must then be accepted or denied.

If you are using DSS authentication for the system, select a key policy or use the default.

The duration that can be requested during the request process. The default value is 2 hours. When
the Requested Duration (as entered by the user on the Requests page in the web portal) is
exceeded, the session ends if the Force Termination option is enabled for the access policy.

The maximum length of time the requester is permitted to enter on the Requests page. Applies to
password and session requests. The maximum length that can be set is 365 days.

Enter the email address where you want Password Safe system notifications to be sent.

1 For more information, please see the following:
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1 o "Add SAP as a Managed System" on page 120

o "Create Password Policies" on page 75
o "Enable Login Accounts for SSH Sessions" on page 140
o "Import an SSH Server Key Using a Smart Rule" on page 31
o "Manage the SSH Server Keys" on page 31
o "Set DSS on the Managed Account"” on page 154
o "Configure Password Safe Access Policies" on page 70
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Add Managed Systems and Accounts Using Smart Rules

You can add assets to Password Safe using an asset-based Smart Rule.

¥

v g

Tip: Before proceeding, consider the selection criteria to use to add the assets. There are several options available, including

Operating System and Directory Query.

Note: SSH key enforcement is not supported when using the pbrun jumphost elevated credential. The settings display as
available after pbrun jumphost is selected. However, the settings will not work with the elevated credential.

o g ks wbh==

From the left menu, click Smart Rules.

Leave Asset selected as the Smart Rule type filter.
Click + Create Smart Rule.

Select a Category from the dropdown.

Enter a Name and Description for the Smart Rule.

Select a Reprocessing Limit from the dropdown to limit how often the Smart Rule processes. Default means the Smart Rule
processes when necessary. This is the preferred setting for less intensive processing. For more intensive processing select

another option to restrict the Smart Rule to run once per selection.

Note: A Smart Rule always processes when first saved or updated.

Set the Selection Criteria by selecting ALL or ANY from the Include Items that match the following dropdown and selecting
the filter criteria from the list. Address Group is a very useful filter and more than once condition may be added.

In the Actions section, select Manage Assets Using Password
Safe from the list.

Select the Platform, Functional Account, and Account Name
Format. Other settings may be left as defaults or changed as
required.

Note: These settings are the same settings available when
adding the system manually by creating a new managed system.

10.
11.

12.

SALES: www.beyondtrust.com/contact

In the Actions section, click Add another action.

Select Show asset as Smart Group from the list. This is helpful for
grouping assets and accounts by their type.

Click Create Smart Rule.

Create New Asset Based Smart Rule

Selection Criteria 8

Include Items that match | ALL v ofthe following.
Address Group

‘ Linux Servers

Use to discover new assets during scans

‘Add another condition  Add a new group

Actions &

Manage Assets using Password Safe
Platform | Windows
Password Safe

Change Agent

Account Name Format  Domain\Username

Functional Account | UVM function account
Enable Automatic Password Management ‘ yes
Enable Accounts For AD Queries ‘ no

Password Rule

Connection Timeout (g 30
port @ 3389

‘ Show asset as Smart Group

Default Password Policy

Add another action
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Tip: To view the contents of a Smart Rule when creating a new rule or editing an existing rule:
o Once the rule is saved, click View Results.

» You are taken to the associated grid, where the contents of the Smart Rule are listed.
« Ifthe rule is actively processing, a banner displays letting you know that.

;{ Note:

o View Results displays only if you have permissions to the grid corresponding to the Smart Rule, i.e.; Assets, Managed
Accounts, Managed Systems.

o The Smart Rule must be saved with Show <entity> as Smart Group selected under Actions to view the results.

Tip: Because the Smart Rule must process to display the contents in the grid, we recommend viewing the results using only
the Show <entity> as Smart Group action and before adding additional actions that may make changes to accounts and
assets in your network.

-

Once you have confirmed the rule contains your desired items, you can then add additional actions to the Smart Rule.

Ll

1 For complete descriptions, please see "Add a Managed System Manually” on page 17.

Add Active Directory Managed Accounts Using a Smart Rule

You can create a Smart Rule that discovers and adds Active Directory accounts to Password Safe, using the below procedure. The
procedure also shows how to link domain accounts to the system.

;{ Note: A directory query and a domain should be created prior to creating a Smart Rule.

1. From the left menu, select Smart Rules.
2. From the Smart Rule type filter list, select Managed Account.
3. Click + Create Smart Rule.
4. Selectthe Selection Criteria as applicable:
o Asset Smart Group: Select a Smart Group from the list.
o Child Smart Rule: Select a Smart Rule you want to filter the child Smart Rules from.
o Dedicated Account: Select an account filter from the list. Enter a keyword to search on.
« Directory Query: Choose to Include or Exclude accounts from Directory Query.
o Select a query from the list, or click Create New Directory Query to open the form and create a new query.
o Provide the frequency for the query to run. Leave the entry as 0 for a one time run.
o Enable the Discover accounts for Password Safe Management option to discover accounts when the Smart
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Rule processes.

o Select a Domain from the list.
+ Managed Account Fields: This filter only applies to existing managed accounts.

o Select afilter: Account Name, Create Date, Description, Domain Name, Last Change Date or Last Change
Result.

o Select an expression, and then enter a keyword to search on, for example, WIN for Windows.
+ Managed System Fields: The Smart Rule is filtered according to the managed system you select.

o Select afilter: System Name, Create Date, Last Update Date.
o Select an expression, and then enter a keyword to search on, for example, WIN for Windows.

o Platforms: Select a platform or check Select All.
» User Account Attribute: Select the attribute from the list, and then provide the filter condition and value for that attribute.
For each attribute filter, select Yes for Discover accounts for Password Safe Management, and then select a Smart
Group to search in.
o Privilege: Select is one of oris not one of. Select All or one, or a combination of Administrator, Guest, or User.
o SID: Select an expression, and then enter a keyword to search on.
o Account Name: Select an expression, and then enter a keyword to search on.
o Password Age: Select an expression, and then select age parameters to search on.
5. Inthe Actions section, select Manage Account Settings to add the accounts that match on the criteria to Password Safe. The
settings are the same as when you add the accounts manually.
6. Additional properties can be set under Actions:
« Assign preferred Domain Controller on each Active Directory account: Select the Active Directory domain and
Domain Controller from the lists.

« Assign workgroup on each account: Used with agent workgroups in multi-active deployments, this action enables you
to define groups of accounts that will be assigned to specific password change agents. Select a workgroup from the list, or
select Any.

« Link domain accounts to Managed Systems: When used with Directory Accounts filter criteria, this action creates a
linked association between the directory accounts and the target asset Smart Groups for role-based access control.

« Link managed accounts to Remote Applications: Assigns the application(s) to any managed accounts that match the
Session Criteria.

« Map Dedicated Accounts To: Use only when the Dedicated Accounts filter criteria is selected. This action identifies the
group of user accounts that are used to match against the dedicated account mask condition.

« Send an email Alert: Select to send an email alert when the Smart Rule processes. The email contains a summary of the
results the managed accounts matched by the Smart Rule and any changes since its last execution.

o Set attributes on each account: Select to assign an attribute to filter and sort managed accounts. When viewing the
Smart Groups on the Managed Accounts page, the groups are organized based on the filters selected in the Smart
Group. You can use the default attributes that are available or create an attribute on the Configuration page. When the
Smart Rule runs, the attribute is applied to all managed accounts that match on the selected filter criteria.

7. Under Actions, click the link to Add another action, and then select Show managed account as Smart Group.
8. Click Create Smart Rule.
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Add Endpoint Privilege Management for Windows Systems and Local
Accounts into Password Safe

The integration between Password Safe and Endpoint Privilege Management for Windows (EPM) allows for agent-based local account
password rotation and privileged account retrieval to run as actions for accounts on Windows systems where an EPM agent is running.

Prior to BeyondlInsight 24.1, EPM agents could only use certificates to authenticate with BeyondInsight. You can download the certificate
from Configuration > System > Downloads > Download Client Certificate in the BeyondInsight console. BeyondInsight configuration
segments can be included in the EPM policy to enable policy management from one console and password policy from Password Safe.

Using BeyondInsight 24.1 or a later version, you can use installer activation keys to leverage OAuth authentication when configuring the
integration between BeyondInsight and Endpoint Privilege Management (EPM) agents that support OAuth communications. Prior to this,
the integration between EPM agents and BeyondInsight was certificate-based only. While certificate-based authentication is still available,
the addition of OAuth authentication greatly simplifies the setup process.

In Endpoint Privilege Management for Windows, features to support Password Safe integration include:

« Off-network account management: The EPM agent contacts Password Safe for password tests or password changes.
« Allow as Password Safe user: You can run an application using managed account credentials sourced from Password Safe.

For more information on configuring OAuth authentication for EPM agents, see Configure OAuth Authentication for Agents
Using Installer Activation Keys.

Discover Local Accounts on EPM Windows Systems

For 22.4 and later releases of Password Safe in conjunction with the Endpoint Privilege Management for Windows 22.9 EPM agent,
discovery can be performed by the EPM agent on the EPM Windows system on a scheduled basis, eliminating the need to run a discovery
scan in BeyondInsight. The EPM agent, running on a Windows system, publishes local user data to the Assets grid in BeyondlInsight. You
can then add the local accounts to Password Safe using a Smart Rule or add them manually.

For Password Safe releases prior to 22.4, you can add well-known local admin accounts into Password Safe using a Smart Rule,
eliminating the need to run a discovery scan in BeyondlInsight, as documented in the next section.

1 For more information on configuring the Endpoint Privilege Management for Windows integration with Password Safe, as well
as discovering and onboarding accounts from EPM Windows systems, please see Integrate Endpoint Privilege Management
for Windows with Password Safe at https://www.beyondtrust.com/docs/privilege-management/integration/pmw-password-
safe/password-safe-integration.htm.

Add Known Local Admin Managed Accounts Using a Smart Rule

It can be useful in some cases to onboard well-known local admin accounts, such as the Windows administrator or the Linux root account,
from endpoints into Password Safe without the need to run a discovery scan against the endpoints. You can create a managed system
Smart Rule that uses the Create Managed Account on each system action to accomplish this.

One scenario in which this is useful is when you have Endpoint Privilege Management (EPM) clients in your environment. You can create
a managed system Smart Rule to add local accounts as managed accounts from the EPM client endpoints so that a password rotation
event exists when the EPM agent requests it. Having these preconfigured managed accounts saves time by not having to configure and
run a discovery scan after the EPM agent makes the request.
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Create the Smart Rule as follows:

o gk wN =

From the left menu, click Smart Rules.

From the Smart Rule type filter list, select Managed System.
Click + Create Smart Rule.

From the Category dropdown, select Managed Systems.
Provide a name and description.

For the Selection Criteria, select Asset Smart Group and
Endpoint Privilege Management Clients from the dropdowns.

For Actions, select Show managed system as Smart Group and
Create Managed Account on each system from the dropdowns.

Leave the remaining settings for Actions as default or modify as
required.

Note: Administrator is the default account name, because that
is standard for Windows systems. You can modify the name if you
have configured something other than default standard local
admin account name in your environment. You can also add
multiple Create Managed Account on each system actions if
you have additional local admin accounts you wish to manage
with Password Safe.

9.
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Click Create Smart Rule.
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Create New Managed System Based Smart Rule

Details &

Category

Managed Systems

Name

Create EPM Admin Managed Accounts

0‘ Active

Description

Reprocessing limit

Default

Selection Criteria ©

Include Items that match | ALL -

vlo

of the following

Asset Smart Group

Endpoint Privilege Management Clients

Add another condition ~ Add a new group

Actions &

Show managed system as Smart Group

Create Managed Account on each system

Account Name | Administrator

ADMIN GUIDE

Password Rule | Default Password Policy

Enable Automatic Password Management | yes -

Change Password Time | 23 v 30 v

Change Password Frequency ~ Every 30 Days

Default Release Duration  Days: 0 Hours: 2 Minutes: 0

Maximum Release Duration  Days: 0 Hours: 2 Minutes: 0

15A Default Release Duration  Days: 0 Hours: 2 Minutes: 0

Max Concurrent Request (@3 1

Account Options ‘ Change Password after Release, Check Password

O change Password on Mismatch

Email release notifications to

Create Managed Account on each system

Account Name | btadmin

Password Rule | Default Password Policy

Enable Automatic Password Management | yes

Change Password Time 23 v 30 v

Change Password Frequency ~ Every 30 Days

Default Release Duration  Days: 0 Hours: 2 Minutes: 0

Maximum Release Duration  Days: 0 Hours: 2 Minutes: 0

15A Default Release Duration Days: 0 Hours: 2 Minutes: 0

Max Concurrent Request (G ‘ 1

Account Options ‘ Change Password after Release, Check Password

[ change Password on Mismatch

Email release notifications to

Add another action
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. ’ Tip: To view the contents of a Smart Rule when creating a new rule or editing an existing rule:
» Once the rule is saved, click View Results.

» You are taken to the associated grid, where the contents of the Smart Rule are listed.
« Ifthe rule is actively processing, a banner displays letting you know that.

x Note:

o View Results displays only if you have permissions to the grid corresponding to the Smart Rule, i.e.; Assets, Managed
Accounts, Managed Systems.

o The Smart Rule must be saved with Show <entity> as Smart Group selected under Actions to view the results.

5 ’ Tip: Because the Smart Rule must process to display the contents in the grid, we recommend viewing the results using only
the Show <entity> as Smart Group action and before adding additional actions that may make changes to accounts and
assets in your network.

Once you have confirmed the rule contains your desired items, you can then add additional actions to the Smart Rule.

1 For more information, please see the following:

o "Add a Managed System Manually" on page 17

o "Add Directory Accounts” on page 80
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Configure Functional Account Requirements in Azure

Follow the steps below to set up Entra ID for use with BeyondTrustPassword Safe.

x Note: Accounts can be managed with or without multifactor authentication enabled in Azure.

Create Enterprise Application

1. In Microsoft Azure, go to Enterprise Applications and select New application.

2. Select Create your own application.

Browse Microsoft Entra Gallery

Cloud platforms

Amazon Web Scrvices (AWS) ‘Google Cloud Platform Orade

-~ 1~
Name your application, select the application type (App you're developing) and click Create.
4. Update the name if necessary, select the Supported Account Types (this directory only) and click Register.

Under Properties, disable Assignment required and Visible to B e N e
users, and click Save. fena

B Caries

e

D Depiayment Plan

A
L]
Pber 3 ot privde i nfarmaion

Puber 53 ot pronse s reormanin 5]

Configure App Registration

6. In Overview section, copy the Application (Client) ID and
Directory (Tenant) ID. These are needed later to configure the
Password Safe functional account.

Build your application with the Microsoft identity platform
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In the Authentication section, enable Allow public client flows,
and click Save.

In the Certificates and secrets section, click New client secret.
Enter the Description, an expiration date, and click Add.

9. Copy the secret Value. This is needed later to configure the

Password Safe functional account.

f Note: The value is displayed only once, immediately after adding

the new secret.

10.

11.

12.

13.
14.
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In the API permissions section, add Microsoft Graph, and select
type Application permissions.

Add Microsoft Graph application permission
UserAuthenticationMethod.ReadWrite.All, Domain.Read.All,
Group.Read.All, and User.EnableDisableAccount.All.

If User.Read is not already added, select Delegated permissions
and add it.

Click Add Permissions.

Click Grant admin consent for for your organization, and click Yes
on the confirmation message.
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Home > BeyondTrust QA | App registrations > Passwordsafe

3 PasswordSafe | Authentication =

B Gotfeecbck?
+ Add apltiorm

Supported account types

Advanced settings

[ flows

Enable the following mobile and desktop flows:

Support + Troubleshooting . J— .
+ Nokeybosrd (Device Code Flow) Learn mare
+ S50 fordo ed Windows (Windows Integrated Auth Flow) Learn more !

2 Toubleshooting

B Newsupportrequest

Add a client secret x

S ST P—

@ PasswordSafe | Certificates & secrets  »

B o
& e [T ——

#

SrtiD
R L

Raquast API permissions

5. PasswordSafe | API permissions ¢
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From the main menu, select Roles and administrators, then
select the Helpdesk administrator role.

Add assignments

Click Add assignments, then assign the application to the
Helpdesk administrator role.

- oo =
This completes configuration in Microsoft Azure. The remaining steps are done in BeyondTrust Password Safe.
BeyondTrust Password Safe Configuration
17. Go to Configuration > Privileged Access Management > Bl sorenaisi | contgraion &

Functional Accounts.

18. Click Create New Functional Account.
19. Forthe Entity Type, select Directory.
20. Forthe Platform, select Microsoft Entra ID.
21. Enter the Username in UPN format. -
| Ex=xmEen
22. Enterthe previously saved values for the Application (Client) ID,
Tenant ID, and Client Secret.
23. Setthe Alias.
24. Click Create Functional Account.
25. Goto Managed Systems. ey | anaged ystems e
26. Click Create New Managed System. sme
27. Forthe Entity Type, select Directory.
28. Forthe Platform, select Entra ID.
29. Enter the Domain, select the Functional Account created above,
and select the Account Name Format.
30. Click Create Managed System.
The Managed Account can be created manually or by using a Smart Rule. ;::' .

31. Create the Managed Account manually.

« Select the Managed System created above.

o Click the vertical ellipsis at the right end of the row. =

o Select Create New Managed Account.

o Enter the Username in UPN format, and enter Objectld for the User and UPN.
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32. Create the Managed Account using a Smart Rule.

» Accounts can be onboarded by using Group Name or UPN
(starts with/ends with) filters.

For more information on using Smart Rules, please see "Work
with Smart Rules" on page 43.

Beyondinsight | Configuration
o R
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Work with Managed Systems

A managed system is any system being managed by Password Safe. A managed system can be an asset, database, directory, or cloud
platform. By default, all managed systems are listed on the Managed Systems page, as the Smart Group filter is set to the built-in Smart
Group All Managed Systems. You can filter the systems listed in the grid by selecting a different Smart Group from the Smart Group
filter list.

Managed systems can be manually created from the Managed Systems page, as well as from the Assets page. Managed systems can
also be added using Smart Rules.

Beyonlé'.l‘!nsid%ht M g nagEd SySte ms 9 1l Default Organizatic

Manage Smart Rule

MANAGED SYSTEMS

Smart Group fit

All Managed Systems -

Create New Managed System @) o X m & I

99 items

() system & 1P Address Entity Type Platform Workgroup Auto Managed Description
O Asset Windows BeyondTrust Workgroup @
O Dstsbsse MySQL BayonaTrust Workgroup @
O Asser Windows BeyondTrust Workgroup

O Cloud Azure Default Warkgroup

O Aszer AX BeyondTrust Warkzroup

O Cloud Amazon BeyondTrust Workgroup @
O Asset Windows BeyondTrust Workgroup

O Asser Generic Platform Default Warkgroup

O Domain Active Directory BeyondTrust Workgroup @
O Domsin Active Directory Default Warkgroup

O Asser Generic Platform Default Workgroup

O Asser Windows BayondTrust Workgroup

1-99 of 99 items

i For more information on adding managed systems, please see the following:
o "Add a Managed System Manually" on page 17

o "Add Managed Systems and Accounts Using Smart Rules" on page 20

View Managed Systems Details

You can view details about the managed system, such as:

« Identifying details, attributes, and policies

» Managed accounts on the managed system

« Smart Groups associated with the managed system

» Accounts linked to managed accounts on the managed system
« Public keys related to the managed system

o Functional account for the managed system
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View the details of a managed system as follows:

1. From the Managed Systems page, click the vertical ellipsis for the managed system.
Select Go to Advanced Details.

Click through the tabs in the Advanced Details pane to view details 5., qnggne  Managed systems ® e
on each topic. Gromir |
p—— e

x Note: For managed systems that are linked to assets, you can
click the View Asset link in the upper left to view the details of the
asset. Click View Managed System to return the Advanced
Details for the managed system.

Import an SSH Server Key Using a Smart Rule

You can import SSH Server keys from a host and accept the key on the Advanced Details for a managed system. Supported key types
are RSA, DSA, and ECDSA. From the Smart Rules page, create an asset-based Smart Rule using Actions settings such as the below:

1. Select Manage Asset Using Password Safe from the dropdown. Crente New Asset Based Smart Rule
2. Select a Platform that supports server keys, such as Cisco. Actions ©
3. Select the Functional Account. argerent g Tt o e
Platform | Cisco v
4. Forthe Key Enforcement Mode option, choose either Auto Alow g systemtobean Appcaton Host[ o -
Accept Initial Key or Manually Accept Keys. Accoun Name Format. | DomaimUsername .
Set the other settings as desired or leave as defaults. z
Enable Automatic Password Management | yes. -
Add another action to Show Asset as Smart Group. i ccouss Fo 0 Querts [0 .
CIle Create Smart Rule_ Password Rule | Default Password Policy -
Key Enforcement Mode | | N
ConnectionTimeout (@ None
port (@ 22 Auto Accept Initial Key
Add another action Manually Accept Keys

CREATE SMARTRULE | DISCARD

The settings here are the same as when adding a system on the Create Managed Systems page. For descriptions for all the
settings, please see "Add a Managed System Manually” on page 17.

Manage the SSH Server Keys

After the Smart Rule processes, hosts with SSH server keys are populated in the Smart Group you created.

An email notification is sent to the Administrators user group when a key is imported and the Key Enforcement Mode is set to Manually
Accepted Keys. The email notifies the administrators that a fingerprint requires action, what asset the key is on, and also provides details
about the fingerprint.

SALES: www.beyondtrust.com/contact SUPPORT: www.beyondtrust.com/support DOCUMENTATION: www.beyondtrust.com/docs 31
©2003-2024 BeyondTrust Corporation. All Rights Reserved. Other trademarks identified on this page are owned by their respective owners. BeyondTrust is not a chartered bank or trust company, or TC: 5/2/2024
depository institution. It is not authorized to accept deposits or trust accounts and is not licensed or regulated by any state or federal banking authority.



PASSWORD SAFE CLOUD 24.1

I BeyondTrUSt ADMIN GUIDE

The Fingerprint Verification email template can be modified from Configuration > Privileged Access Management > Mail
Templates.

i For more information on modifying email templates, please see "Customize Mail Templates"” on page 163.

Accept or Deny a Key

From the Managed Systems page, click the vertical ellipsis for the managed system.
Select Go to Advanced Details.
Click the Server Keys tab.

> n o=

Click the vertical ellipsis for the server key you wish to work with.

« [fauto approved, no further action is required.

o If manually approved, click Accept or Deny. .

LoginAccount

5. After a key is accepted, from the Functional Accounts tab, click the Test Functional Account button to verify the key with the
functional account.

Add a Key Manually

From the Managed Systems page, click the vertical ellipsis for the managed system.
Select Go to advanced details....

Click the Server Keys tab.

Click + Create New Server Key above the grid.

Click Accept or Deny.

Select a Key Type from the list and enter a Fingerprint and a Description.

Click Create Key.

After a key is added, from the Functional Accounts tab, click the Test Functional Account button to verify the key with the
functional account.

© Nk

x Note: The fingerprint must be unique. An error message is displayed if the key is already imported.
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Work with Managed Accounts

Managed accounts are user accounts which are local or active directory accounts on the managed system.

View Managed Accounts

When viewing managed accounts, you can change the number of items Beyondinsatt | marased Accounts
displayed on the page using the Items per page dropdown at the bottom of i € e
the grid. You can use the filters above the grid to filter the list by smart group MANAGED ACCOUNTS

and the various attributes listed in the Filter by dropdown. :

coooooooo ol

Shoving ems 1:250f 403

View Managed Account Details

After the account is added to Password Safe management, you can:

+ Review the attributes and settings assigned to the account, such its identifying details, settings, and policies.
« View managed systems linked to the account.

+ View Smart Groups associated with the account, as well as their last process date and processing status.

« See which accounts are synced to the managed account.

+ View a list of password changes and the reason for each change.

To view details on a specific managed account:

1. From the Managed Accounts page, click the vertical ellipsis for the account.
Select Go to Advanced Details.

Managed account details, such as identification information, BT ‘ Managed Accounts ® MEm

account settings, policies and attributes are displayed under e

Details & Attributes for quick access. '& “e
4. To see more granular details, click through the tabs in the . ijwﬁ .

Advanced Details pane to view details on each topic.

= ’ Tip: Click the View Managed System link above the grid to view
the advanced details for the managed system associated with the | ==
managed account. To return to the advanced details for the
managed account, click the View Managed Account link.
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i For more information on propagation actions, please see "Add Propagation Actions to Managed Accounts" on page 83.

Delete Managed Accounts

Managed accounts can be deleted, except for synced accounts. A message is displayed if an account cannot be deleted.

1. From the menu, select Managed Accounts.
2. Select the account or multiple accounts you want to delete, and

then click the Delete button above the grid. MANAGED ACCOUNTS
Smart Group filter Filter by
‘ All Managed Accounts v ‘ ‘ T
Q+ Add To Smart Group S:i @ m

173 items (3 selected | Select all 173 rows)

= Account Description System

(< I <

3. Click Delete on the confirmation message.

Unlink Managed Accounts

You can unlink managed accounts from managed systems; however, this applies to Active Directory accounts only. If accounts included in
the unlink selection are not domain accounts, no action is taken on those accounts.

1. From the menu, select Managed Accounts.
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2. Select the account or multiple accounts you want to unlink, and then dinsieh
click the Unlink button above the grid. Beyondinsight Managed Accounts

lbl BeyondTrust

MANAGED ACCOUNTS

Smart Group filter Filter by

‘ All Managed Accounts v ‘ ‘ T

@+ Add To Smart Group Ss @ m’

403 items (3 selected | Select all 403 rows)

O Account Description

3. Click Unlink on the confirmation message.

Change Passwords for Managed Accounts

1. From the menu, select Managed Accounts.

2. Select the account or multiple accounts for which you want to B dinsich
change the password, and then click the Change Password button eyondinsight Ma naged Accounts

lbl BeyondTrust

above the grid.
MANAGED ACCOUNTS
Smart Group filter Filter by
‘ All Managed Accounts v ‘ ‘ T
Q+ Add To Smart Group Ss @ 'm'

403 items (3 selected | Select all 403 rows)

D Account Description

3. Click Change Password on the confirmation message.

35
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Configure Subscriber Accounts

Any managed account can be synced to multiple accounts. These synced accounts become subscribers to the managed account. The
managed account and all of its subscribers always share an identical password. When the password of the managed account or any of the
subscriber accounts is changed, Password Safe automatically changes the password of the primary managed account and all of its
subscribers to a new password.

Once an account is synchronized as a subscriber account, settings modifications are limited to:

« Enable API
» Allow for scanning
« Application

To sync an account:

1. From the Managed Accounts page, click the vertical ellipsis button for the account.
2. Select Go to Advanced Details.
3. Under Advanced Details, click Synced Accounts. Acvanced Detalls < || synced Accounts
4. Select the account or multiple accounts that you want to sync. Jrmm——————"
5. Click Sync Accounts above the grid. e ey <L
y 9 B

Synced Accounts

Events Account Name AccountType  Account Status.

<}

Domain © Actve
Propagation Actions

Asset © Active

o

Password History

O Asset © Active
o Asset © Actve
m) Domain © e
6. Toremove a synced account, select the account, and then click the Advenced Details synced Accounts
Unsync Accounts button above the grid. R i i managedprimer ccous
v ey
Linked Systems Synced Accounts only - v

i3

Synced Accounts 2items (2 selected)

Events

Account Name AccountType  AccountStatus  System

v Domain Active
Propagation Actions a ©

Asset © Active
Password History

Configure Password Reset for Managed Account Users

You can grant managed account users permission to reset the password on their own managed account, without granting them
permission to reset passwords on other managed accounts. You can do this by creating a group, adding the managed account to the
group, and then assigning permissions and the Credential Manager role to the group.

1. Inthe Beyondlnsight console, go to Configuration > Role Based Access > User Management.
2. From the Groups tab, click Create New Group.
3. Select Create a New Group.
4. Provide a name and description for the group, and then click Create Group.
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From the Group Details pane, select Users.

Group Details § (Users @
Select users to add to the group, and then click Assign User above Dets . Atrures ‘ F— =
the grid. Features + rosignuser
Smart Groups 5600items (2 selected)
[
API Registrations
a
oo

From the Group Details pane, select Features.

Select the Management Console Access and Password Safe Account Management features, and then click
Assign Permissions.

9. Select Assign Permissions Read Only. Do not grant Full Control.

10. From the Group Details pane, select Smart Groups. Group el < | SmartGroups Permisions 0

T

11. Filter the list of Smart Groups by Type > Managed Account.

12. Select the Smart Group that contains the applicable managed
accounts. Jen—

13. Click the vertical ellipsis button for the Smart Group, and then select
Edit Password Safe Roles.

14. Select the Credentials Manager role, and then click Save Roles. Smart Groups Permissons © Al Managed pecounts Pesemord >

Safe Roles

Show e

The managed account user can now log in to the console and reset the password for the managed account as follows:

Go to the Managed Accounts page.
Select the account.
Click the vertical ellipsis button for the account.

Ll .

Select Change Password.

Use a Managed Account as a Discovery Scan Credential

A managed account can be used as a credential when configuring a Discovery Scan.

Note: Once the Scanner option is enabled, the key must be specified again if the account is edited. It may be the same key or
anew one.

The following credential types are supported:

« Windows,

« SSH
SALES: www.beyondtrust.com/contact SUPPORT: www.beyondtrust.com/support DOCUMENTATION: www.beyondtrust.com/docs 37
©2003-2024 BeyondTrust Corporation. All Rights Reserved. Other trademarks identified on this page are owned by their respective owners. BeyondTrust is not a chartered bank or trust company, or TC: 5/2/2024

depository institution. It is not authorized to accept deposits or trust accounts and is not licensed or regulated by any state or federal banking authority.



PASSWORD SAFE CLOUD 24.1

lEI BeyondTrUSt ADMIN GUIDE

« MySQL
« Microsoft SQL Server.

The following platforms are supported:

+ Windows

« MySQL

« Microsoft SQL Server

» Active Directory

o Any platform with the IsUnix flag (AIX, HP UX, DRAC, etc.)

To add the managed account as a scan credential:

1. From the Managed Accounts page, click the vertical ellipsis button for the account.

2. Select Edit Account.

3. Expand Scanner Settings.

4. Click the toggle to enable the scanner. Edit )
5. Forthe Scanner Credential Description, enter a name for the View Advanced Details...

account that can be selected as the credential when setting up the
scan details. The name is displayed on the Credentials

Management dialog box when setting up the scan.

) . Automatic Password Change Options
6. Assign and confirm a key so that only users that know the key can

use the credential for scanning.
7. Click Update Account. Account Settings

1 For more information on configuring credentials, please see Add
Credentials To Use in Scans in the Beyondinsight Cloud User
Guide.

Scanner Settings (&)

° Scanner Enabled

Scanner Credential Description

Scanner Key

Confirm Scanner Key

Applications

Update Account Discard Changes
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Managed Account Aliasing

Aliases are accessible using the APl only. Account mappings can be changed without affecting the alias name. At least one managed
account is required to be mapped for the alias to be active; when an alias has two or more managed accounts mapped, it is considered to
be highly available. An account can only be mapped to one alias. Managed account aliases can be accessed from Configuration >
Privileged Access Management > Managed Account Aliases.

Create a New Alias

1. Navigate to Configuration > Privileged Access Management > Beyondinsight | Configuration
- GrserondTist | > esersticm aasensz > Moo Ao tes
Managed Account Aliases.

Click Create New Alias +.
Enter a name, and then click Create Alias. °

MANAGED ACCOUNT ALIASES <

The new alias appears in the grid under Account Mappings, which displays all aliases ready to be mapped. New aliases show as
Unmapped until they are associated with accounts.

x Note: Each managed account can only be mapped to a single alias.

You can use the dropdown to select which accounts to display: All Accounts, Mapped, or Unmapped Accounts only.
The Filter-by allows you to filter accounts by System, Account Name, Account Status, or Last Changed Date.

To unmap an account, select the account and click the broken link icon. R .

5 Unmap Accounts -

Y Ss m % I

2items (1 selected)

Account Name & c s Last Changed Date
e Mey 18,2020, 1055 AM
Acve May 19,2020, 1055 AM

Page 1 | oft 100 v Items per page 1-20f2items

Mapped accounts have three status values:

Details

Create anew Managed Account Alla or select an existing one to manage mappings.

« Active: The account credentials are current and can be requested.

« Pending: The account credentials are current but the password is

queued to change.
« Inactive: The account password is changing. RS ]

The list of mapped accounts is rotated in a round-robin fashion, typically in

order of last password change date. The preferred account, or the account o
. . . O = a Acive May 19,2020, 10:55 AM.
whose status is active and has the oldest change date, is returned on the | —— R
Alias API model.
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Disabled at Rest Managed Accounts

Just-in-Time (JIT) is a critical aspect of controlling access to assets and identities within an organization. When flagged by a Password
Safe administrator, Active Directory and Entra ID accounts can leverage JIT capabilities by disabling these accounts when checked in to
Password Safe. When a requestor checks out an account, a workflow is initiated that re-enables the account for use. Once checked back

in, the account is disabled again.

When enabling or disabling an account, Password Safe uses the Preferred Domain Controller (DC), if set, for the managed account.

x Note: The Disabled at Rest feature is only available for Active Directory (AD) and Entra ID accounts.

For more information, please see Register and Configure an Application in Entra ID at
https.//www.beyondtrust.com/docs/beyondinsight-password-safe/bi/authentication/azure-ad-app-registration.htm.

Enable the Disabled at Rest Setting

The Disabled at Rest setting can be activated by using a toggle switch, located in Managed Accounts > Account Settings, or by
creating a Smart Rule.

Enable Disabled at Rest with Toggle Switch

1. From the left hand menu in the BeyondInsight console, click Managed Accounts.

2. Select a managed account and then click the vertical ellipsis to the right of the account.

3. From the menu, select Edit Account. ]

4. Under Account Settings, click the Disabled at Rest toggle switch to enable the M 4
setting. .

Account Settings (&)

° Disabled at Rest

@  ~PiEnabled

5. Click Update Account.

e SSH Login Enabled

Create a Smart Rule for Disabled at Rest Accounts

In addition to setting the Disabled at Rest option in an individual managed account, you can also set the Disabled at Rest flag by
creating a smart rule. The flag automatically turns on the Disabled at Rest setting for all matching accounts included in the smart rule, as

follows:

1. From the left menu in the BeyondInsight console, click Smart Rules.
2. Select Managed Account from theSmart Rule Type Filter dropdown.

40
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3. Click Create Smart Rule. 3 Create New Managed Account Based Smart Rule

Actions €

Select Managed Account Settings for Disabled at Rest Accounts from the first e o
dropdown under Actions.

siatorm |

5. Under Platform, select either Active Directory or Microsoft Entra ID.

Password . Select All

6. Complete the smart rule, and then select Create Smart Rule.

(1) IMPORTANT!

Ifthe Disabled At Rest setting is set at the account level, it is overwritten by the Manage Account Settings action in a Smart Rule,
which sets Disabled at Rest for all affected accounts to No. You must use the Manage Account Settings for Disabled At Rest
Accounts action instead, which sets Disabled at Rest for all affected accounts to Yes.

x Note:

o Concurrent accounts, those that are used by multiple users, are disabled only after the account is no longer in use by
anyone.

o The Disabled at Rest feature is not supported with Password Cache. This service checks out the account it is
configured for and keeps a cache locally. The cache is an active request, meaning the cached account is enabled, and
it will stay enabled.

Verify Disabled at Rest Setting

Verify that the Disabled at Rest setting is enabled, as follows:

1. Click the vertical ellipsis to the right of the account that was updated.
2. From the menu, select Go to Advanced Details.
3. Under Details & Attributes > Account Settings, Disabled at Rest should be set to Yes.

Changes can also be viewed under User Audits, as follows:

1. Go to Configuration > General > User Audits.

2. Click the information icon to the right of the updated item. The Edit Details pane displays the action that was taken and the
changes made.

Sample Disabled At Rest Workflow Description

Disabled accounts are temporarily enabled when a new Password Safe request is made. Using the View Password request as an
example, view the workflow, as follows:

« Click the left menu in the BeyondInsight console and click Password Safe.

« Goto Accounts > Directory Linked Accounts.

« Click Access (key icon) to the right of the request.

« Inthe Access pane, under Quick Launch, set the time length of the session.
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o Click Retrieve Password.

o The account is now enabled.

o |t remains enabled for the duration of the session. If the user checks-in the request or the request expiry time is reached
(whichever comes first), the account is queued to be disabled.

x Note: When enabling the Disable at Rest feature on a managed account, the account is set to disabled in AD or Entra ID. If
the account does not become disabled, a check out/check in may be required.

Affected Settings

When your account is set to Disabled at Rest, the following settings are not available:

o Account Settings > Use Own Credentials.

o Account Settings > Directory Query Enabled

« Scanner Settings > Scanner Enabled

« Managed Account > Advanced Details > Propagation Actions
« Test Password is not available in the ellipsis menu.

For more information about site replication considerations when leveraging the Disable at Rest feature, please refer to your
Active Directory administrators.
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Work with Smart Rules

You can use Smart Groups to add assets, systems, and accounts into Password Safe management. The Smart Rule filters that you
configure for the Smart Groups determine the assets that are added as managed systems and managed accounts in Password Safe.

There are three types of Smart Rules available with a Password Safe license: Asset, Managed Account, and Managed System.

You can use Smart Rules to add the following types of assets:

o Systems

« Network Devices

« Databases

o Local Linux and Windows accounts
« Active Directory accounts

« Dedicated accounts

x Note: The settings in a Smart Rule override the settings configured on the managed system.

For more information on using Smart Rules, please see the Beyondinsight User Guide at
https://www.beyondtrust.com/docs/beyondinsight-password-safe/bi/user/smart-rules/index.htm.

Predefined Smart Groups

By default there are Smart Groups already defined and created.

The following tables list Smart Groups useful in Password Safe environments.

Asset Based Smart Groups

All Assets in Password Assets and Devices All assets under Password Safe management.

Safe

Recent Assets not in Assets and Devices All assets discovered in the last 30 days that have not yet been added to

Password Safe Password Safe.

Recent Non Windows Assets and Devices All non Windows assets discovered in the last 30 days that have not yet been

Assets not in Password added to Password Safe.

Safe

Recent Windows Servers | Servers Windows servers discovered in the last 30 days that have not yet been added to

not in Password Safe Password Safe.

Recent Virtual Servers Virtualized Devices Virtualized server assets discovered in the last 30 days that have not yet been

not in Password Safe added to Password Safe.
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}{ Note: Virtual machine processing within Smart Rules has been deprecated as of BeyondInsight and Password Safe 24.1. For
upgrades to the Beyondinsight and Password Safe 24.1 release, the Virtualized Devices category for Smart Rules still
displays in the Ul; however, any Smart Rules based on this category are marked as inactive. For upgrades to the 24.1 release,
Child Smart Rule filters that use any of the following built-in rules are removed:

e Microsoft Hyper-V

o Parallels

» Recent Virtual Servers not in Password Safe
o Virtual Servers

o Virtual Workstations

o VMware vSphere

o Xen

Managed System Smart Rules

Database Managed Types Database Managed Systems

Systems

Directory Managed Types Directory Managed Systems

Systems

Cloud Managed Systems Types Cloud Managed Systems

Asset Managed Systems | Types Asset Managed Systems

All Managed Systems Managed Systems All Managed Systems associated with BeyondInsight Assets

associated with
BeyondInsight Assets

All Managed Systems not | Managed Systems All Managed Systems not associated with BeyondInsight Assets
associated with

BeyondInsight Assets

All Managed Systems Managed Systems All Managed Systems

Recently Added Managed Systems Managed Systems added less than 30 days ago

Managed Systems

Managed Accounts Smart Groups

Smart Group Definition

All Managed Accounts All accounts managed by Password Safe.
Recently Added Managed Filters on managed accounts added less than 30 days ago.
Accounts

Database Managed Accounts Filters on the database platform and includes SQL Server and Oracle platforms.

Hardware Device Managed Filters on hardware devices including Dell DRAC and HP iLO platforms.

Accounts

Linux Managed Accounts Filters on the Linux platform.
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Mac Managed Accounts Filters on the macOS platform.
Unix Managed Accounts Filters on the Unix platform.
Windows Managed Accounts Filters on the Windows platform.

Considerations When Designhing Smart Rules

« Theffilter criteria is processed hierarchically. When creating the filter structure, place the filters that reduce the largest number of
entities at the top of the hierarchy.

+ When adding Active Directory accounts using a directory query, ensure the query is as restrictive as possible. For example,
configure the query on a smaller set of data in your environment.

+ When adding assets to Password Safe, be cautious about creating more than one Smart Rule with the same systems or accounts.
If the Smart Rules have different actions, they will start continually overwriting each other in an endless loop.

« There can be delays when a Smart Rule depends on external data source, such as LDAP, as processing can take longer. For
example, a directory query that uses the discover accounts feature (managed account Smart Rule) or discover assets feature
(asset-based Smart Rule).

Smart Rule Processing

A Smart Rule processes and updates information in Smart Groups when certain actions occur, such as the following:

« The Smart Rule is created, or edited and saved.
o Atimer expires.
« You manually kick off the processing by selecting the Smart Rule from the grid on the Smart Rules page, and then click Process.

Note: The Process action from the grid on the Smart Rules page does not apply to managed account and managed system
Quick Group Smart Rules, because these only run once upon creation and cannot be triggered to run again.

o A Smart Rule with Smart Rule children triggers the children to run before the parent completes.

« Managed account Smart Rules with selection criteria Dedicated Account process when a change to a mapped group is detected.
This can occur in the following scenarios:

°© A new userlogs on.

o The group refreshes in Active Directory by an administrator viewing or editing the group in Configuration > Role Based
Access > User Management.

Change the Processing Frequency for a Smart Rule

By default, Smart Rules process when asset changes are detected. The assets in the Smart Rule are then dynamically updated. For
Smart Rules that require more intensive processing, you might want Smart Rules to process less frequently.

To provide more restrictive processing, you can select alternate frequency settings to override the default processing. The Smart Rules
process in the selected time frame (for example, the rule processes once a week).
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When creating a new Smart Rule or updating an existing one, select your Beyondinsight |~ Configuration
desired frequency from the Reprocessing limit list in the Details section. @oeyonmust | e s

> Managed Accounts: All Managed Accounts
Note: A Smart Rule is always processed when first saved or Details @
updated. Category
Managed Accounts v
Name
All Managed Accounts o Active
Description
All accounts managed by Password Safe °
Reprocessing limit
Default -~ @

Default

Every hour 2 following
Every 6 hours

Every 12 hours

Every day .

View and Select Smart Rules Processing Statistics

The Smart Rules grid displays some processing statistics by default. Additional Smart Rules processing statistics, such as Processed
Date, Successful Attempts, and Failed Attempts are available and can be displayed in the Smart Rules grid.

To add this information to the grid:

1. From the left menu in BeyondInsight, click Smart Rules.
2. Click the Column chooser icon in the upper right of the grid.

3. Click the desired column to add that information to the grid.

o Check marks indicate columns currently displayed.
« You can remove a displayed column by clicking the column name in the Column chooser list.

o If there are more columns displayed than can fit in the width of the screen, a scroll bar appears at the bottom of the grid. It
may be necessary to scroll sideways to view any additional columns.

Create and Use Dedicated Account Smart Rules

A dedicated account Smart Rule allows you to dynamically map dedicated administrative accounts outside of BeyondInsight to users in a
BeyondInsight group. This allows a lower privileged BeyondInsight user to access a higher privileged user's account temporarily while
using Password Safe.

The below procedures provide instructions for configuring BeyondInsight users with the ability to access a dedicated directory account's
credentials, using a query matching on directory attributes. Once configured, the users are able to request a password checkout for the
dedicated account from the Password Safe portal. The user can then access resources using the dedicated account credentials.

You must configure the following in BeyondInsight:
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« Create a directory query to retrieve the directory account as well as its attributes.

« Create a Smart Rule to run the directory query to find the account and its directory attributes, and add it as a managed account in
Password Safe.

o Create a Smart Rule to map the dedicated account to a user group in BeyondInsight.

« Assign user group permissions to the two newly created Smart Rules.

Create the Directory Query

1. Navigate to Configuration > Role Base Access > Directory Queries.
2. Click + Create New Directory Query, and complete form as follows:

o Directory Type: Leave as Active Directory. New Directory O
ew Directory Query

o Title: Provide a meaningful name that allows for easy Directony Type
identification of the query. | Active Directory -
o Credentials: Select a credential that has permissions to e
query the dll’GCtOl’y user aCCOuntS ‘ Dedicated Account Directory Query o ‘
. H Credentials
° Query Target: Provide the LDAP path to the target. creden
o Scope: Leave as This Object and All Child Objects. | Active Directory -
o Object Type: Select User Objects. CresteNew Gedertiol.
. Q T
o Dynamically refresh results each use: Leave enabled. ey Tereet
o Basic Filter: Provide the name of the dedicated account. | osecampiesomaniocac-tsersC @
. . Scope
3. Click Create Directory Query. ‘ThlsObjeclAndAIICh\IdObjecls - ‘
Object Type
‘Computer Objects - ‘

° Dynamically refresh results each use.

BASIC FILTER

A“*"wildcard character may be used anywhere in the name and description to match multiple values.

Name

‘ Denise.sa (] ‘

Description

TEST

Query Test Results

Resullts limited to first 100 for preview

0 items

Name Description

There are no records to display.

CREATE DIRECTORY QUERY DISCARD
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Create the Smart Rule to Run the Directory Query and Add Managed Account

x Note: This example is specific to managed accounts. Similar instructions apply for the other rule or entity types

From the left menu, click Smart Rules.

Select Managed Account from the Smart Rule type filter dropdown.
Click + Create Smart Rule.

Configure the Smart Rule as follows:

> n o=

« Category: Select Managed Accounts.

« Name: Provide a meaningful name that allows for easy
identification of the Smart Rule.

« Selection Criteria:

o Select Directory Query from the dropdown.

o Leave Include accounts from Directory Query
selected.

o Select the directory query created in above steps.

o Leave Discover accounts for Password Safe
Management enabled.

o Select the Domain from the dropdown.
o Actions:

o Select Manage Account Settings from the
dropdown and set its related options as desired.

o Add another action and select Show managed
account as Smart Group from the dropdown.

o Add another action and select Link domain
accounts to Managed Systems from the
dropdown, and then select your desired Asset or
Managed System Smart Group from the
dropdown.

5. Click Create Smart Rule.

Create New Managed Account Based Smart Rule

Details &
Category
Managed Accounts -
Name
Dedicated Account Query Smart Rule [ Active
Description
Reprocessing limit
Default - ©

Selection Criteria &

Include Items that match | ALL v | ofthe following

Directory Query
Include accounts from Directory Query
Dedicated Account Directory Query
Re-run the query every X hours (3 0

Discover accounts for Password Safe Management

Domain | example.com

Add another condition  Add a new group

Actions &

Manage Account Settings

Password Rule | Default Password Policy

Enable Automatic Password Management | no -

Default Release Duration  Days: 0 Hours: 2 Minutes: 0
Maximum Release Duration  Days: 0 Hours: 2 Minutes: 0

1A Default Release Duration  Days: 0 Hours: 2 Minutes: O

Max Concurrent Request (@ ‘ 1

Account Options

Email release notifications to

Show managed account as Smart Group

Link domain accounts to Managed Systems

Asset or Managed System Smart Group | Asset Managed Systems - (Managed System group)

Add another action

Create smarcRule | view Resuts

v s

o Once the rule is saved, click View Results.

:’: Tip: To view the contents of a Smart Rule when creating a new rule or editing an existing rule:

o You are taken to the associated grid, where the contents of the Smart Rule are listed.
 Ifthe rule is actively processing, a banner displays letting you know that.
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x Note:

Accounts, Managed Systems.

» View Results displays only if you have permissions to the grid corresponding to the Smart Rule, i.e.; Assets, Managed

o The Smart Rule must be saved with Show <entity> as Smart Group selected under Actions to view the results.

v g

assets in your network.

. ’: Tip: Because the Smart Rule must process to display the contents in the grid, we recommend viewing the results using only
the Show <entity> as Smart Group action and before adding additional actions that may make changes to accounts and

Once you have confirmed the rule contains your desired items, you can then add additional actions to the Smart Rule.

Create the Smart Rule to Map the Dedicated Account to the User Group

From the left navigation pane, click Smart Rules.

Select Managed Account from the Smart Rule type filter dropdown.
Click + Create Smart Rule.

Configure the Smart Rule as follows:

L nh o=

o Category: Select Managed Accounts.

« Name: Provide a meaningful name that allows for easy
identification of the Smart Rule.

« Selection Criteria:

o Select Dedicated Account from the dropdown.

o Select Directory Attribute Match from the
dropdown.

o Select the directory attribute you wish to match.
e Actions:

o Select Show managed account as Smart Group
from the dropdown.

° Add another action and select Map Dedicated
Accounts to from the dropdown.

o Select the applicable User Group to map to.

5. Click Create Smart Rule.

Managed Accounts: Dedicated Account Mapping Smart Rule

Details &
Category
Managed Accounts v
Name
Dedicated Account Mapping Smart Rule [x] Active
Description
Reprocessing limit
Default v ©

Selection Criteria &

Include Items that match | ALL v | of the following

Dedicated Account - O
Directory Attribute Match v
employeeNumber v

Add another condition Add a new group
Actions B
Show managed account as Smart Group v 0
Map Dedicated Accounts To v 0

User Group ‘ LowPriv

Add another action

E—— T
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, Tip: To view the contents of a Smart Rule when creating a new rule or editing an existing rule:
« Once the rule is saved, click View Results.

» You are taken to the associated grid, where the contents of the Smart Rule are listed.
« Ifthe rule is actively processing, a banner displays letting you know that.

x Note:

o View Results displays only if you have permissions to the grid corresponding to the Smart Rule, i.e.; Assets, Managed
Accounts, Managed Systems.

o The Smart Rule must be saved with Show <entity> as Smart Group selected under Actions to view the results.

, Tip: Because the Smart Rule must process to display the contents in the grid, we recommend viewing the results using only
the Show <entity> as Smart Group action and before adding additional actions that may make changes to accounts and
assets in your network.

Once you have confirmed the rule contains your desired items, you can then add additional actions to the Smart Rule.

Assign User Group Permissions to the Smart Rules

1. Navigate to Configuration > Role Based Access > User Management.
2. Locate the user group you had selected when creating the Smart Rule for dedicated account mapping.
3. Click the vertical ellipsis for the group, and then select View Group Details.
4. Inthe Group Details pane, click Smart Groups. Beyondinsight ‘ Configuration
.. . @ » e
5. Inthe Smart Group Permissions pane, select the two dedicated
account smart groups you created. G."°:"= LOWPRIV
. . . . . BQy | rooius
6. Click Assign Permissions > Assign Permissions Read Only @ | 0 0o retprorsones
above the grld Group Details < Smart Groups Permissions @
el . At o | © Yo
Features
Smart Groups items e
Users (1)
JR—— Dedicated Account Mapping Smart Rule:
Dedicated Account Query Smart Rule
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From the Smart Rules page, process the two newly created smart groups. Beyond Insight Configu ration
After processing, the dedicated account discovered by the directory query

is listed on the Managed Accounts page. Users belonging to the group
you chose to map the dedicated account to are indicated in the Mapped to

lal BeyondTrust > General > SmartRules

User column. You might need to add this column to the grid using the SMART RULES
Column Chooser button above the grid. Smart Rule type filie Filte by
Managed Account - | T

@ create Smart Rule (® Dpeactivate PROCESS il

2 items (2 selected)

Category 4 Name Description

Dedicated Account Mapping:

@ Managed Accounts P

Dedicated Account Query Smart

@ Managed Accounts Rule

Use an Entra ID Smart Rule

An Entra ID Smart Rule enables Password Safe to automatically discover Entra ID accounts. This allows privileged accounts in Entra ID to
be managed, including password rotation and check-in and check-out. RDP sessions, from an Azure-joined VM, can use Entra ID
credentials to connect to an Azure-joined VM.

Follow the steps below to discover Entra ID accounts.

1. From the left menu, click Smart Rules.
2. Select Managed Account from the Smart Rule type filter dropdown.
3. Click + Create Smart Rule.
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4. Configure the rule as follows:

Create New Managed Account Based Smart Rule

+ Category: Select Managed Accounts. Details ©
ooy
« Name: Provide a meaningful name and description that [Managed Accounts -
allows for easy identification of the Smart Rule. ‘m
Accounts o Active

« Reprocessing Limit: If desired, select a reprocessing limit.

Description

o Under Selection Criteria:

Reprocessing imit

o Select Azure Directory Query from the dropdown.
There are several filters, and options are dynamic, e oo &
. . election Criteria
depending on other selections: Incude ems tht match | ALL « | cfthe folowing

® |nclude ALL or ANY of the selection criteria. paure Directory Query -9

Group Name -

| Defauit )

B There are two matching options available for
discovering Entra ID accounts: Group Name

equals (=) -

and User Principle Name. Use a Group roacn °
Name match to discover all accounts that Rennthequeryevryxbors B 0|
are a member Of the Specified grOUp. Use a Discover accounts in Azure synced from on-premise
User Principle Name match to allow a Discover accounts for Password safe Management
partial name match. omin. | examplecom .
= |fusing a Group Name, equals is the only dd anathercondiion Addaneweroun
match option. Enter the Group Name. Actions ©
= |fusing a User Principle Name, select Show managed ccountas smart Grovp -lo
starts with or ends with and enter the | anage pccoun seags -le
name. Password Rule | Default Password Policy v
. Enable Automatic Password Management | yes v
o Set the value for how many hours for rerunning the
Change Password Time 23 v 30 v
query.
R B Change Password Frequency Every 30 Days
o Check the Discover accounts in Azure synced
from On-premise Option to include Entra ID Default Release Duration  Days: 0 Hours: 2 Minutes: 0
accounts synced from on-premises Entra ID, as well
as Azure-only accounts.
ISA Default Release Duration  Days: 0 Hours: 2 Minutes: 0
o Leave Discover accounts for Password Safe
Max Concurrent Request (g 1

Management checked.

Account Options | Change Password after Release, Check Password v

o Select an Azure domain from the dropdown.

O change Password on Mismatch

o Add additional selection criteria and groups, as Email release notfications o | bob@example.com °
required.

Add another action

5. Under Actions, select Show managed account as Smart Group,
and then add other actions as required to manage settings or work
with the managed account.

6. Click Create Smart Rule.

L

:’: Tip: To view the contents of a Smart Rule when creating a new rule or editing an existing rule:
e Once the rule is saved, click View Results.

» You are taken to the associated grid, where the contents of the Smart Rule are listed.
o [fthe rule is actively processing, a banner displays letting you know that.
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x Note:

» View Results displays only if you have permissions to the grid corresponding to the Smart Rule, i.e.; Assets, Managed
Accounts, Managed Systems.

o The Smart Rule must be saved with Show <entity> as Smart Group selected under Actions to view the results.

-

Tip: Because the Smart Rule must process to display the contents in the grid, we recommend viewing the results using only
the Show <entity> as Smart Group action and before adding additional actions that may make changes to accounts and
assets in your network.

Once you have confirmed the rule contains your desired items, you can then add additional actions to the Smart Rule.

Use Quick Groups

For a simpler way to organize managed accounts, you can group them using a Quick Group. The default processing time on a Quick
Group is Once.

1. Inthe console, click Managed Accounts.

2. From the Smart Group filter dropdown, select an existing smart
group in which the managed accounts are members.

MANAGED ACCOUNTS

Smart Group filter Fiter by

| Al Managed Accounts - [x

5 s
2 Select all 403 row:

403 tem: ed | S

ADD TO MANUAL SMART GROUP

3. Check the boxes for the managed accounts that you want to add to
the Quick Group.

4. Click Add to Smart Group above the grid.

Select a group from the Smart Group dropdown or create a new
one by typing in the name and clicking Add as New Option.

Select an existing manual Smart Group or create a new manual Smart Group.

Smart Group (manual)

my quick group -

Category
Managed Accounts -
Description (Cptional)

Managed Accounts manual Smart Group ©

Select Quick Groups from the Category dropdown.

Leave the default description or enter a new one.
Click Add Selected Accounts To Smart Group.

Your new smart group is now available in the Smart Group filter dropdown.

© © ® NO

To remove accounts from the Quick Group:
» Select the group from the Smart Group filter dropdown.
» Check the boxes for each account you wish to remove, and then click Remove From Smart Group above the grid.
« To quickly locate Quick Groups from the Smart Rules page, select Quick Groups from the Category dropdown.

« To change the name and description for a Quick Group, or to deactivate a Quick Group:

o From the Smart Rules page, click the vertical ellipsis for the group, and then select View Details.
o Make your changes, and then click Save Changes.

You can also quickly manually add managed systems to Smart Groups from the Managed Systems page.

Note: Managed systems do not have a Quick Group category; however, the concept and process is essentially the same as it

is for managed accounts.
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In the console, click Managed Systems.

From the Smart Group filter dropdown, select an existing Smart Group in which the managed systems are members.

Check the boxes for the managed systems that you want to add to the Quick Group.

Click Add to Smart Group above the grid.

Select a group from the Smart Group dropdown or create a new one by typing in the name and clicking Add as New Option.
Select a Category from the dropdown.

Leave the default description or enter a new one.

Click Add Selected Systems To Smart Group.

Your new smart group is now available in the Smart Group filter dropdown.

© o Nk N~

To remove a managed system from a Smart Group:

1. Select the Smart Group from the Smart Group filter.
2. Check the boxes for the managed systems that you want to remove from the group.
3. Click Remove From Smart Group above the grid.

To change the name and description for a managed system Quick Group, or to deactivate a Quick Group:

Navigate to the Smart Rules page.

Select Managed System from the Smart Rule type filter.

Locate the Quick Group you created.

Click the vertical ellipsis for the group, and then select View Details.

o bk N =

Make your changes, and then click Save Changes.

x Note: You cannot add or modify filters or actions for Quick Groups.

For more information about Smart Rule processing, please see "Change the Processing Frequency for a Smart Rule" on page
45.

Edit Smart Rules

From the left menu in BeyondInsight, click Smart Rules.

1 " Beyon;lnslght Configuration A ok nemon © I oeropmanen

2. Click the vertical ellipsis to the right of the Smart Rule. > | —— o >

3. Select Edit Smart Rule.

4. Make the necessary changes and then click Save Changes.

o
- o
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Tip: To view the contents of a Smart Rule when creating a new rule or editing an existing rule:
o Once the rule is saved, click View Results.

o

» You are taken to the associated grid, where the contents of the Smart Rule are listed.

« Ifthe rule is actively processing, a banner displays letting you know that.

;{ Note:

o View Results displays only if you have permissions to the grid corresponding to the Smart Rule, i.e.; Assets, Managed
Accounts, Managed Systems.

o The Smart Rule must be saved with Show <entity> as Smart Group selected under Actions to view the results.

Tip: Because the Smart Rule must process to display the contents in the grid, we recommend viewing the results using only
the Show <entity> as Smart Group action and before adding additional actions that may make changes to accounts and
assets in your network.

o

Once you have confirmed the rule contains your desired items, you can then add additional actions to the Smart Rule.

Delete Smart Rules

1. From the left menu in BeyondInsight, click Smart Rules.
2. Select one or more Smart Rules.
3. Click the Trash Can icon above the grid. You can also click the vertical ellipsis to the right of a single Smart Rule and select Delete.

;{ Note: Built in Smart Rules cannot be deleted. These are identified by the Lock icon.

;( Note: A Smart Rule that is used in another Smart Rule cannot be deleted or marked as inactive.

Audit Smart Rules

To audit new or edited Smart Rules:

1. Go to Configuration > General > User Audits.
2. Select Section from the Filter by dropdown.
3. Select Smart Rule from the Section dropdown.
4. Click the information icon to the right of the Smart Rule.
o IfaSmart Rule is added, the Add Details pane displays with all added information.
o Ifa Smart Rule is edited, the Edit Details pane displays with all edited information.
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Configure Role Based Access

Creating groups gives you great flexibility in delegating access to managed systems. Permissions provide access to BeyondInsight
system components, while Password Safe roles determine the scope of access to managed systems.

+ Group permissions: Permissions are assigned when you create a group. Permissions are system-wide and provide access to
various components of the BeyondInsight infrastructure. There are permissions that are specific to accessing and using features
of the Password Safe application.

« Password Safe roles: The roles define the actions that Password Safe users can take when using the Password Safe web portal
for password releases or access to applications.

Group Features

The following table provides information on the Password Safe features that you can assign to your groups.

Feature Full Control permission assigned
Password Safe Account Grants permissions to the following features on the Managed Accounts page:
Management

o Bulk delete accounts

« Add accounts to a Quick Group

+ Remove accounts from a Quick Group
o Add, edit, and delete accounts

Password Safe Admin Session | Allows non-ISA users access to the Admin Session feature in Password Safe.

Using an Admin Session allows administrators to open ad-hoc RDP / SSH sessions without going
through the request process.

Password Safe Bulk Password  Use the bulk password change feature on the Managed Accounts page.

Change

Password Safe Agent Grant a user administrator permissions to the Configuration > Privileged Access Management
Management Agents page.

Password Safe Configuration Grant a user administrator permissions to the Configuration > Privileged Access Management
Management page.

Password Safe Policy Grant a user administrator permissions to the Configuration > Privileged Access Management
Management Policies page.

Password Safe Role Manage roles provided they have the following permissions: Password Safe Role Management
Management and User Accounts Management.

Password Safe System Users can manage systems on the Managed Systems page, including:

Management

« Create, change, and remove directory and cloud systems.
o Link and unlink directory accounts to managed systems.

Note: Password Safe Account Management is needed with Password Safe System
Management to manage Password Safe accounts. Full Control is required for both.

Smart Rule Management - Users can create and edit Managed Account Smart Rules.

Managed Account
SALES: www.beyondtrust.com/contact SUPPORT: www.beyondtrust.com/support DOCUMENTATION: www.beyondtrust.com/docs 56
©2003-2024 BeyondTrust Corporation. All Rights Reserved. Other trademarks identified on this page are owned by their respective owners. BeyondTrust is not a chartered bank or trust company, or TC: 5/2/2024

depository institution. It is not authorized to accept deposits or trust accounts and is not licensed or regulated by any state or federal banking authority.



PASSWORD SAFE CLOUD 24.1

I BeyondTrust ADMIN GUIDE

Smart Rule Management - Users can create and edit Managed System Smart Rules.
Managed System
Secrets Safe Users can access the Secrets Safe feature.

In addition to Password Safe features permissions, users need the following general permissions:

Asset Management Read, create, and delete assets and databases.

Management Console Access  Access to log on to the management console.

Password Safe Roles

In Password Safe, a role is the connection between a Password Safe user account and a managed system. A role defines what the user or
group can do with respect to that managed system. Roles are assigned to Smart Groups, and the roles that you can assign depend on the
Smart Group type, as follows:

o Asset Smart Group: The ISA and Auditor roles may be assigned.

 Managed Account Smart Group: The Requestor, Approver, Credentials Manager, Recorded Session Viewer, and Active
Session Reviewer roles may be assigned.

Role Description

Requester Allows users to submit a request to retrieve managed passwords or remote session connection files.

When assigning the Requester role, you must select an access policy.

Approver Allows users to approve requests for the release of managed passwords or remote session
connection files.

Typically, system administrators and network engineers are assigned to this role.

Note: In peer approval environments, users may be both approvers and requestors. In
this case, a user cannot approve their own requests when dual control is enforced.

Information Security Allows users to setup managed systems and accounts.

Administrator (ISA
(ISA) The ISA role provides the functionality required for security help desk personnel. User with the ISA

role can delegate limited authority to those responsible for resource management.

This role enables a user to bypass every workflow and security measure, like approval workflows or
checked out accounts.

Note: If another user has an account checked out and the password is known by this
user, an ISA user can view the password. ISA users are not permitted to use the Admin
Session feature.

Auditor Users with the Auditor role can:

« Run reports in BeyondInsight Analytics & Reporting
« Replay recorded sessions in the Password Safe web portal

The Auditor role can be assigned with other roles.

Credentials Manager Allows users to set credentials using the PUT ManagedAccounts/{accountld}/Credentials API.
SALES: www.beyondtrust.com/contact SUPPORT: www.beyondtrust.com/support DOCUMENTATION: www.beyondtrust.com/docs 57
©2003-2024 BeyondTrust Corporation. All Rights Reserved. Other trademarks identified on this page are owned by their respective owners. BeyondTrust is not a chartered bank or trust company, or TC: 5/2/2024

depository institution. It is not authorized to accept deposits or trust accounts and is not licensed or regulated by any state or federal banking authority.



PASSWORD SAFE CLOUD 24.1

lEI BeyondTrUSt ADMIN GUIDE

Recorded Session Reviewer Allows users to view and take action on completed recorded Password Safe sessions, including:

+ Add comments
« Mark the session as reviewed
« Archive sessions if configured on the U-Series Appliance

Active Session Reviewer Allows users to view and take action on active Password Safe sessions, including:

o Lock session
« Terminate the session
o Cancel the request

On all systems where a user is granted the ISA role, the user can change the following system details:

o Grant users/groups roles to the managed system.

« Review password release and session requests.

« Add and change accounts on managed systems.

« Assign a system to a collection (provided the ISA role is granted to the user for both the system and the collection).
o Remove their ISA role from a system.
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Create a Group and Assign Roles

x Note: You cannot assign roles to the BeyondInsight administrator.

Roles are only available to BeyondInsight features.

1. Navigate to Configuration > Role Based Access > User Management.
2. From the Groups tab, click + Create New Group.
3. Select Create a New Group.
4. Enter a name and description for the group.
5. Click Create Group.
6. Assign users to the group:
o Under Group Details, select Users.
« From the Show dropdown list, select Users not assigned.
« Filter the list of users displayed in the grid by Type, Username, Name, Email, and Domain, if desired.
« Select the users you wish to add to the group, and then click Assign User above the grid.
« Assign features permissions to the group:
o Under Group Details, select Features.
o Filter the list of features displayed in the grid using the Show and Filter by dropdown lists.
o Select the features you wish to assign permissions to, and then click Assign Permissions.
o Select Assign Permissions Read Only or Assign Permissions Full Control.
» Assign Smart Groups permissions and roles to the group:
o Under Group Details, select Smart Groups.
o Filter the list of Smart Groups displayed in the grid using the Show and Filter by dropdown lists.
o Select the Smart Group or groups you wish to assign permissions to, and then click Assign Permissions.
o Select Assign Permissions Read Only or Assign Permissions Full Control.
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® Select the Smart Group you wish to assign Password
Safe roles to, and then click the vertical ellipsis button. ED a rA

® Select Edit Password Safe Roles.

Password
Permission Safe Roles
Full control 3 E
F . ..
g Assign Permissions Read Only
Fu - - -
€ Disable Permissions
Fu
@ Edit Password Safe Roles
Ful
®m Select the role(s). If selecting Requestor, also Password Safe Roles

select an access policy from the dropdown.

= Click Save Roles.
A role is the connection between a Password

Safe user account and a managed system. A
role defines what the user or group can do with
respect to that managed system.

Requestor

Access Policy for Requestor -

Approver

Credentials Manager
Recorded session reviewer

Active session reviewer

SAVE ROLES DISCARD CHANGES
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Quarantine User Accounts

You can turn on the quarantine feature as a preventative measure when suspicious activity is detected. When quarantine is turned on, the
user account can no longer log in to the console or API, and any active sessions are terminated immediately.

The difference between account lockout and account quarantine is that account lockout cannot terminate sessions.

Turn on the setting at the user account level as follows:

Navigate to Configuration > Role Based Access > User Management.
Select the Users tab.

Click the vertical ellipsis for the user account.

Select Edit User Details.

Check the Account Quarantined option to enable it.

Click Update User.

o gk wh=

Set the Refresh Interval on the Quarantine Cache
You can set the length of time that passes before the cache is updated with the user accounts from the database. The quarantine is only
applied to the user account after the cache is updated.

The user can remain logged in and sessions remain active up until the refresh interval time passes (and the cache is updated with the
quarantine status).

1. Go to Configuration > System > Site Options.

2. Under Session, enter the number of seconds that pass before the cache is updated with the most recently discovered quarantined
user accounts.

The default value is 600 seconds (10 minutes). The maximum value is 1200 seconds (20 minutes).

3. Click Update Session Options.
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Configure API Access

When using the Password Safe API, the group where the users are assigned must permit access to the API. Additionally, any managed
accounts that must be accessible by the APl must also be configured.

Configure Group with APl Access

A BeyondInsight user has APl access if at least one of the user groups they belong to has APl access enabled.

Navigate to Configuration > Role Based Access > User Management.
From the Groups tab, click the vertical ellipsis for the group.

Select View Group Details.

Under Group Details, select APl Registrations.

O &~ Dd =

Select the API registrations for the group.

Enable API Setting for Managed Account

You must turn on API access for a Password Safe managed account to be accessible to the API methods.

1. Navigate to the Managed Accounts page.
2. Click the vertical ellipsis for a managed account, and then select Edit Account.
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3. Scroll down and expand Account Settings.
4. Click the toggle to turn on the API Enabled option. Edit )
5. Click Update Account. View Advanced Detalls...

Managed Systern

‘ mike asset (Db Instance: test, Port;1025) ‘

Entity Type

‘ Database - ‘
Platform

‘ Teradata - ‘

@' Collapse All Expand All

Identification (&

Only specific fields will be editable, this account’s
password is synced to account:
Nameb370563312832001100Test ID

Warkgroup

| Default Workgroup -

Credentials

Automatic Password Change Options

Account Settings (&
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Restrict Access to the Password Safe Login Page

When using SAML, smart card, or claims-aware authentication to access the Password Safe web portal, you might not want users to log in
directly to the web portal URL. You can disable direct access to the Password Safe web portal URL for Active Directory, LDAP, and local
BeyondInsight users by enabling the Disable Login Forms setting. Users must then always provide the SAML, smart card, or claims-

aware credentials before gaining access to the web portal.

The following procedure assumes the group and user are already created.

1. Navigate to Configuration > Role Based Access > User Management.
2. Fromthe Users tab, click the vertical ellipsis for the user.
3. Select Edit User Details.

64
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4. Check Disable Login Forms to enable it.

Edit User >

View User Details...

First Name

Last Name

Email

Username

(J Account Quarantined

Credential

Create New Credential...

Domain / Domain controller

Any domain controller v

Authentication Options @

(] override Smart Card User Principal Name

Disable Forms Login

Two-Factor Authentication

None -

Update User
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Configure Approvals

You can control the number of approvers required for a requester. You can also control the number of approvers required for each access
type: View Password, RDP, and SSH. This is configured in an access policy, which can then be assigned to a group when assigning
Password Safe roles to the group.

x Note: Any of the approvers in the group can approve the request. If other subsequent approvers click the link, they will see
that the request has already been approved. Other approvers can, however, override the approval and deny the request. If a
request is denied by one approver, no approvers can subsequently override and approve. It is not possible to deny the request
once the schedule window has actually begun.

1 For more information, please see:
o "Create a Group and Assign Roles" on page 59

« Approve or Deny Requests for Passwords and Sessions in the Password Safe User Guide at
https://www.beyondtrust.com/docs/beyondinsight-password-safe/documents/ps/ps-user-cloud.pdf.
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Use a Managed Account as a Credential

You can use a managed account for the credential when you are configuring queries and user groups for Active Directory and LDAP.

x Note: You cannot delete a managed account if it is used as a credential for a user group. You can delete a managed account
used as a credential for a directory query; however, the query will no longer run. You must select another credential for the
query to run again.

i For more information on managed account settings, please see "Add a Managed System Manually" on page 17.

Configure the Managed Account

Before you configure the query or group, the managed account must be in place and specific settings must be selected.

When you configure the managed account settings, be sure to select the Allow this account to be used in Beyondinsight and
Directory Queries option.

If there are several managed accounts organized in a Smart Group, select Enable Accounts for AD/LDAP queries in the Smart Rule.

IMPORTANT!

Disable the Change Password After Release option on the managed account, because log files can grow significantly in a short
time when using managed account credentials with a directory query.

Configure the Query

Active Directory and LDAP queries can use a managed account as a credential.

An Active Directory or LDAP group can use a managed account as the credential. When you create the group, the managed account is
listed as a credential.

For more information on creating directory queries, please see Create a Directory Query at
https://www.beyondtrust.com/docs/beyondinsight-password-safe/bi/user-cloud/tools/directory-query.htm.
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Configure LDAP Groups

Before logging in to Password Safe using LDAP, you must configure an LDAP group.

For more information on creating and configuring LDAP groups, please see Add an LDAP Directory Group at
https.//www.beyondtrust.com/docs/beyondinsight-password-safe/bi/user-cloud/role-based-access/create-groups/Idap.htm.
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Real Time Authorization

Real Time Authorization allows administrators to remove users from groups while they are logged in with a directory account and use the
registry key to perform an additional check to ensure that the user still has access to the password at the time they requested it. This puts
the user through the log in process every time a password is requested.

Enable the following registry key to turn on this feature:

HKLM\SOFTWARE\BeyondTrust\PBPS\EnableCheckoutAuthorization

After the user is removed from the group, they receive the following error
.. . Account  RCUsert on WINS-VM
message when they request password access: Missing required Password
Safe role.
Reason:  fest
P
Ticket System: (None) v | (optional)
Ticket Number: (optional)
Screen Resolution: 1024x768 v
Record Session ¥
Missing required PasswordSafe role.
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Configure Password Safe Access Policies

An access policy defines the time frame and frequency that users can request passwords, remote access sessions, or access applications
under Password Safe management.

An access policy is selected when you are configuring the Requester role.

Create an Access Policy

1. Go to Configuration > Privileged Access Management Policies > Access Policies.
2. Inthe Access Policies pane, click Create New Access Policy.
3. Enter a name for the policy, and then click Create Access Policy. ACCESS POLICIES £ EDIT SIHAN

Search

Q

‘ Basic Details

Create New Access Policy 0

Create New Access Policy AN
Access Policy Name
| Techcom Access Palicy o ‘
all day
Create Access Policy
Showing all 35 Access Policies \ 9:00 AM

4. On the Basic Details tab:

« Enter a description for the policy.
« Optionally, enable the Email Notifications option to send emails when a request is received for the policy.

Note: Recipients may receive a large number of email notifications. Selective use of this option is strongly advised. Multiple
addresses cannot be added at once. Each email address must be added one at time by clicking Add Another Email.

5. Select the Schedule tab, and then click Create Schedule.
6. Configure the recurrence, time, and date settings for the policy. If you select a daily recurrence, you can optionally select Allow
multi-day check-outs of accounts. This option allows the user continuous access to a granted request over a span of days.
7. Optionally, enable the Enable Location Restrictions option, and then select a location from the list.
8. Ifapplicable, select an address from the X-Forwarded-For list. This field is an allowed value of X-Forwarded-For header, which
was added by an F5 load balancer or proxy. It uses address groups to verify if the IP address is to be in that list. The URL and
named host will be ignored. If the X-Forwarded-For field has a value of Any, then no X-Forwarded-For header is required or
verified. In the case where it is configured, the X-Forwarded-For header is required and its value should be in the list of IPs in the
address group.
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}{ Note: In the case of a new configuration, this error message can be found in the log:

CheckLocationAllowed: XForwardedForHeaderValue 1.1.1.1 is not registered/trusted. Add
this XForwardedForHeaderValue to the TestGroupName Address group

9. Select the type of access to permit: View Password, RDP, SSH, or Application.
10. For each type of access selected, configure the parameters as required. Descriptions for each parameter are as follows:

Approvers Select the number of approvers required to permit access. Check
Auto Approve if the requests do not require any approvers.

Allow API Rotation Override Check this option for View Password access, to allow API callers
such as Password Safe Cache to override the Change
Password After Any Release managed account setting for view-
type requests.

Record Check the box to record the session.

Keystroke Logging Keystrokes can be logged during RDP, SSH, and application
sessions. Uncheck the boxes for each policy type to disable
keystroke logging for that type.

Enhanced Session Auditing Enhanced session auditing applies to RDP and application
sessions and is on by default. Click the toggle to turn off enhanced
session auditing.

Concurrent Set the number of sessions permitted at a time. Check Unlimited
to permit the user any number of connections to occur at the same
time.

Log off on Disconnect Check this box to automatically log off the user when the

connection to the session disconnects or the session window
closes. This option applies only to RDP and RDP application
sessions, and is active only when Enhanced Session Auditing is
enabled.

Note: If the session has been terminated by an Active
Sessions reviewer, the logoff on disconnect occurs
regardless of the access policy setting.

Force Termination Check this box to close the session when the time period expires.
When Log off on Disconnect is also selected, the user is logged
off the session. This check box applies to RDP, SSH, and
application sessions.

When the Requested Duration (as entered by the user on the
Requests page in the web portal) is exceeded, the session ends if
the Force Termination box is checked for the access policy.

The default and maximum release durations are configured on the
Managed Accounts page and Managed System Settings page.
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RDP Admin Console Select this option to show the RDP Admin Console check box on
RDP-based requests. This option allows administration of a
Remote Desktop Session host server in console mode (mstsc
/admin). This can be useful if the number of remote sessions is
maxed out on the host.

Using the RDP Admin Console allows you to use a remote session
without requiring other sessions to disconnect. Running a remote
session using the RDP Admin Console disables certain services
and functionality, such as, but not limited to:

» Remote Desktop Services client access licensing
» Time zone redirection
» Remote Desktop Connection Broker redirection
o Remote Desktop Easy Print
Connection Profile Select a profile from the list or click Manage Connection Profiles

to be taken to the Connection Profiles page to create a new
profile.

11. Under Policy Options:

« If you want users to provide a reason when making requests in Password Safe, click the toggle for the Reason is required
for new requests option to enable it.

« If you want users to provide a ticket number for a ticketing system when making requests in Password Safe, click the toggle
for the Require a ticket system and a ticket number for requests option to enable it.

o Once enabled, select the Ticket System from the dropdown. If you leave the Ticket System as User Selected,
the user can select any ticket system from the list when making their request. If you select a specific ticket system
for this option, the user is unable to change the ticket system when making their request.

12. Click Create Schedule. If the access policy is not yet marked as available, you are prompted to activate it now.
13. Assign the access policy to a user group as follows:

o Select the Assignees tab.

« Click Manage Assignees. You are taken to the User Management page.

o Click the vertical ellipsis for a group, and then select View Group Details.

« From the Group Details pane, click Smart Groups.

o Click the vertical ellipsis for a managed account Smart Group, and then select Edit Password Safe Roles.
« Check Requestor, and then select the access policy you just created from the dropdown.

« Click Save Roles.

14. Confirm the group is now listed as an assignee on the Assignees tab for the access policy you just created.

1 For more information, please see the following:
o "Configure Keystroke Logging" on page 147

o "Enhanced Session Auditing" on page 148

o For configuring release durations, "Add a Managed System Manually" on page 17

o Forinformation on how to use mstsc /admin, mstsc at https.//docs.microsoft.com/en-us/windows-
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"Create a Connection Profile" on page 73

Create a Connection Profile

Connection profiles allow administrators to create a deny list of keywords, host names, and IP addresses. Each deny listed item can be
given a separate action which is triggered when requesters type a deny listed item in an active SSH session.

Administrators can choose to have Password Safe perform the following actions when a match occurs:

No Action: Select to be alerted only if a match occurs.

Block: Blocks the transmission of the command to the remote machine.

Lock: Locks the session for the requester.

Block and Lock: Performs both a block and lock as described above.

Terminate: Ends the remote session.

",

Note: Connection policies apply to SSH and SSH application sessions.

Ll

Go to Configuration > Privileged Access Management Policies > Connection Profiles.

From the Connection Profiles pane, click Create New Connection Profile.

Enter a name for the profile, and then click Create Connection Profile.

Optionally, to send email notifications when a deny listed item is triggered, click Email Notification Settings to expand it and add
an email recipient

Note: Recipients may receive a large number of email notifications. Selective use of this option is strongly advised.

0o 0N oo

-

Click Save Changes.
Click Create Match Condition.
To add a deny listed item, select one of the following from the Match dropdown: Keyword, Hostname, or IP Address.

Enter the match criteria in the Value box.

From the Session Control dropdown, select the action to take when the deny listed item is triggered.

Click Create Condition. Each deny listed item is displayed on a separate line.

Apply the connection profile to an access policy schedule, as follows:

Go to Configuration > Privileged Access Management Policies > Access Policies.
Select the policy.

From the Edit Policy pane, click the Schedule tab.

Double-click a schedule to open it, or create a new schedule.

Scroll down to the Connection Profile dropdown, and then select the newly created profile from the list.
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Use a Predefined Connection Profile

The following predefined connection profiles are available for an access policy: Lateral Movement and Suspicious Activity.

The profiles are configured to match on keywords that might indicate suspicious behavior occurring on your network. If a match is detected
on any of the keyword values then the session is blocked.

You can add or delete keywords in the predefined connection profiles.

74
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Create Password Policies

Password Safe ships with a default password policy used to generate new passwords for auto managed accounts. You can change the
settings for the default policy, such as password length and complexity, but you cannot delete the default password policy. You can also
create new password policies.

Note: Ensure the policies you create in Password Safe align with password complexity and restrictions in place on the
managed system; otherwise, Password Safe might create a password that does not comply with the rules in place on that
managed system.

Go to Configuration > Privileged Access Management Policies > Password Policies.
Click Create New Password Policy.
Enter a name for the password policy, and then click Create Password Policy.

Ll .

Optionally provide a description for the policy, and set the following parameters:
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Check Allow use for Secrets Safe to allow the policy to be available for
selection within team password credentials. The policy can be selected when a
credential is using the Auto Generate option for setting the credential's
password.

Use the - and + buttons to incrementally lower or raise the Minimum length and
Maximum length of passwords for the selected policy. You can also manually
enter the numbers in the text fields. Valid entries are 4 - 255 characters.

Select the First Character Value.
Uppercase Characters: Use the toggle button to permit or deny the use of
uppercase characters in passwords. If uppercase characters are permitted:
o Setthe Minimum number of required uppercase characters using
the - and + buttons or by entering a number in the text field.
o Enter permissible characters in the Allow only the following
uppercase characters field.

Lowercase Characters: Use the toggle button to permit or deny the use of
lowercase characters in passwords. If lowercase characters are permitted:

o Setthe Minimum number of required lowercase characters using
the - and + buttons or by entering a number in the text field.

o Enter permissible characters in the Allow only the following
lowercase characters field.

Numeric Characters: Use the toggle button to permit or deny the use of
numeric characters in passwords. If numeric characters are permitted:

o Setthe Minimum number of required numeric characters using the -
and + buttons or by entering a number in the text field.

o Enter permissible characters in the Allow only the following numeric
characters field.

Techcom Password Policy Details

Password Policy Name

7 characters remaining.

Techcom Password Policy [:]

Description (Optional)

Allow use for Secrets Safe
Minimum length

e =
Maximum length

|8 v

First Character Value

QO Alpha Characters Only

QO AlphaNumeric Permitted

@ Any Character Permitted
Uppercase Characters
° Permit uppercase characters

Minimum number of required uppercase characters
e

Allow only the following uppercase characters

ABCDEFGHIJKLMNOPQRSTUVWXYZ [

Reset to Default
Non-Alphanumeric Characters
@ Permit non-alphanumeric characters

Minimum number of required non-alphanumeric characters

e ' o

Allow only the following non-alphanumeric characters
~1@#$%MH()+=2/<>| [ o

Reset to Default

Update Password Policy Discard Changes

Non-Alphanumeric Characters: Use the toggle button to permit or deny the use of non-alphanumeric characters in

passwords. If non-alphanumeric characters are permitted:

o Setthe Minimum number of required non-alphanumeric characters using the - and + buttons or by entering a

number in the text field.
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o Enter permissible characters in the Allow only the following non-alphanumeric characters field.

5. Click Update Password Policy.
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View Recorded Sessions

For auditing purposes, all RDP and SSH sessions in Password Safe can be recorded and accessible for viewing from the Sessions >
Completed Sessions grid. Session recording is available for regular sessions, ISA sessions, and Admin sessions. The following users
can view recorded sessions:

o Administrators

¢ Users with the Auditor role

« Users with the Recorded Session Reviewer role

o Users with the ISA role

To access and review completed sessions in Password Safe, follow these steps:

1. From the left navigation, click Menu, and then click Completed Sessions under Password Safe.

2. Use the Protocol and Filter By dropdowns above the grid to filter the list to assist with locating the desired session. Once you
have located the session you wish to view, click the vertical ellipsis for it, and then select View Session .

« Alternatively, you can select View Details and then click the View Session link from the Session Details pane.

‘@ Tip: Ifa session recording has been archived, the View Session option is not available. If available, select the Restore
Session option to restore the recording. You can also restore the archived session from the session's details by selecting
View Details and then clicking the Restore link.

3. Once the session displays, click Play to review the recording. You Beyondinsight | Password Safe e @
can hover over any part of the video progress bar to reveal the time D || eemmas
stamp and click anywhere on the bar to select an instance in the .
recorded session. Use the control buttons below the recording to
pause and restart the recording.

Tip: Keystrokes that occurred within the session, such as the
user opening a window, accessing an application, or clicking an
option, are stored as events and listed in the Events pane to the
left of the recorded session. You can click specific listed events or
click the Prev and Next buttons below the recording to skip to
those events within the recording.

o

To take a screenshot of a session frame and export it as a

JPEG file, click the Snapshot button. The file exports with a
resolution of 1024 x 768. The JPEG file is automatically saved to
the default download location specified in your browser settings.

4. Add comments and check Mark as Reviewed for auditing purposes.

5. The number of audits is displayed as a link above the session recording. Click the link to view who viewed the session and when,
as well as to see their comments.

SALES: www.beyondtrust.com/contact SUPPORT: www.beyondtrust.com/support DOCUMENTATION: www.beyondtrust.com/docs 77

©2003-2024 BeyondTrust Corporation. All Rights Reserved. Other trademarks identified on this page are owned by their respective owners. BeyondTrust is not a chartered bank or trust company, or TC: 5/2/2024
depository institution. It is not authorized to accept deposits or trust accounts and is not licensed or regulated by any state or federal banking authority.



PASSWORD SAFE CLOUD 24.1

laI BeyondTrUSt ADMIN GUIDE

Use Keystroke Search

To find sessions in either Active Sessions or Completed Sessions, enter seyoncinsight | Password Sofe e o
aword or phrase in the Quick filter field. The list of sessions is , B
automatically filtered based on what is entered in the field.

To search for global keystrokes, select Keystroke from the Filter by
dropdown list, and then enter a word or phrase in the Keystroke field.

Restore Archived Session

In Password Safe Cloud, sessions older than six months are automatically archived. This prevents data storage issues for Cloud users.
However, archived sessions can easily be restored so they can be replayed. To restore an archived session:

1. Navigate to Password Safe > Sessions > Completed Sessions. B I m—— P
[

) BeyordTrst |+ Sessons

2. Locate the archived session, and then click the vertical ellipsis to
the right of the session.

Meourts | Aopeonss | Sessons | Adevn Session

3. Select Restore Session. The restore takes place in the e Je [x .
background. : AR

Once the session has been restored, follow the steps in the "View

[ -

Recorded Sessions" on page 77 section to view the restored session. >
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Manage Active Sessions

Password Safe Administrators, ISA users, or users that have been granted permissions to the asset through a Smart Group that is
assigned the Active Session Reviewer role can view and manage active sessions in real time. While viewing an active session you can
lock, terminate, and cancel the session, as detailed in the steps below.

Note: Admin sessions are listed in the grid only for users who have read permissions to the Password Safe Admin Session
Reviewer feature.

1. From the left navigation, click Menu, and then under Password Safe, click Active Sessions.

2. Use the dropdowns above the grid to locate the session you wish to Beyondinsight | Password Safe 7 e @
view or manage, and then click the vertical ellipsis for the session. O i

o Click Lock to immediately lock the session.
o Click Terminate to immediately disconnect the session.

« Click View Session to view the active session.

;{ Note: Keystrokes, such as those used when the user opens a
window, accesses an application, or clicks an option, are logged
in the Events pane as they are executed. You can sort these
chronologically but you cannot select them during an active
session.

3. Wh|le viewing an active session, use the controls below the session Beyondinsight | Password Safe G @
display window as follows: ot | sempomme

& Accoune £ osce: reb 26, 2029.810 44 (D) Duraton: 0seconds

o Click Lock to immediately lock the session
o Click Terminate to immediately disconnect the session.

+ Click Terminate and Cancel to immediately end a session
and check in the request.

;{ Note: The Terminate and Cancel button is only present for
sessions initiated by requestors. It is not available for sessions
initiated by administrators or ISA users. It is also not available for
Admin Sessions.

}( Note: When a session is locked or terminated, the user receives a message indicating the session has been locked or
terminated and to contact their administrator. Terminated sessions are removed from the Active Sessions grid, and can be
viewed from the Completed Sessions grid.
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Add Windows Components to Password Safe

Password Safe can manage Active Directory and LDAP directories and directory accounts, as well as credentials used to run the
following:

« Windows services

+ Windows scheduled tasks

« |IS application pools

« COM+ and DCOM applications

o SCOM RunAs identities

Add a Directory

From the left menu, select Managed Systems.

Click Create New Managed System.

From the Type list, select Directory.

From the Platform list, select Active Directory or LDAP.

o wDh =

Configure the settings for the directory, and then click Create Managed System.

1 For more information on adding managed systems manually, please see "Add a Managed System Manually"” on page 17.

Add Directory Accounts

You can add directory accounts manually or by creating an Active Directory account with a Smart Group.

Add Directory Accounts Manually

1. Onthe Managed Systems page, select the managed system for the directory, and then click the vertical ellipsis button for the
managed system.

Tip: Filter the list of managed systems in the grid by selecting Directory Managed Systems from Smart Group filter to
quickly find your managed system.

2. Select Create Managed Account.

3. Configure the managed account settings as necessary, and then click Create Account.

v s

a ’ Tip: When configuring the managed account settings for an Active Directory account, you can choose a domain controller to
change or test a password. The domain controller on the managed account overrides a domain controller on the functional

account selected.
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i For more information on adding managed accounts manually, please see "Add a Managed System Manually" on page 17.

Discover Active Directory Accounts with an Active Directory Query

1. From the left menu, click Smart Rules.
2. From the Smart Rule type filter list, select Managed Account.
3. Click + Create Smart Rule.
4. Select Managed Accounts from the Category list.
Create New Managed Account Based Smart Rule
5. Provide a name and description for the Smart Rule. et
6. Setthe following Selection Criteria: ‘ T -
« Directory Query > Include accounts from Directory ‘ o
AD Quel o 84 Active
Query. B
Description
o Select the query from the list, or click Create New Directory
Query to open the form and create the query. S
o Ensure the Discover accounts for Password Safe [oeeut v|e
Management option is enabled. Selection Crieria ©
. . Include Items that match | ALL ¥ | of the followin;
o Select a Domain from the list. )
Directory Query v 0
7. Setthe following Actions: [ ncude account rom Dirctory Query -
« Show managed account as Smart Group. sppseconeoardng ~

Re-run the query every X hours (3 [

Discover accounts for Password Safe Management

« Manage Account Settings: Configure these settings as
necessary, ensuring to select the following options from the
Account Options dropdown: Do [ examplecom v

Add another condition  Add a new group

o Change Password after Release

Actions &
© Chec'( Password ‘ShowmanagedaccounlasSmanGmup - 9
o Enable accounts for AD/LDAP queries [ wansge accoun srings -0
Password Rule | Default Password Policy -

Enable Automatic Password Management | yes -

Change Password Time | 23 v 30 v

IMPORTANT!

Change Password Frequency Every 30 Days

By default, the Smart Rule auto manages the passwords for the
directory accounts. If you do not want this, set Enable Automatic
Password Management to no; otherwise, ALL accounts in the query

Default Release Duration Days: 0 Hours: 2 Minutes: 0

Maximum Release Duration  Days: 0 Hours: 2 Minutes: 0

will have passwords changed. I5A Default Release Duration ~ Days: 0 Hours: 2 Minutes: 0
Max Concurrent Request (@ 1
8. Click Create Smart Rule. Account Options ‘Change Password after Release, Check Password v ‘

[ change Password on Mismatch

Email release notifications to ‘ ‘

nother acti
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Tip: To view the contents of a Smart Rule when creating a new rule or editing an existing rule:
« Once the rule is saved, click View Results.

» You are taken to the associated grid, where the contents of the Smart Rule are listed.
« Ifthe rule is actively processing, a banner displays letting you know that.

x Note:

o View Results displays only if you have permissions to the grid corresponding to the Smart Rule, i.e.; Assets, Managed
Accounts, Managed Systems.

o The Smart Rule must be saved with Show <entity> as Smart Group selected under Actions to view the results.

Tip: Because the Smart Rule must process to display the contents in the grid, we recommend viewing the results using only
the Show <entity> as Smart Group action and before adding additional actions that may make changes to accounts and
assets in your network.

o

Once you have confirmed the rule contains your desired items, you can then add additional actions to the Smart Rule.

9. To view the Active Directory accounts:

« Go the Managed Accounts page.
o Select the newly created Smart Group from the Smart Group filter list.

Link Active Directory Accounts to Managed System

You can link Active Directory accounts to managed systems on a specified domain.

From the left menu, click Managed Systems.

Select the managed system, and then click the vertical ellipsis button for the managed system.
Select Go to Advanced Details.

Under Advanced Details, click Linked Accounts.

Filter the list by Not Linked.

Select the accounts, and then click Link Accounts above the grid.

I

Create an Active Directory Functional Account

When creating an Active Directory managed account, the functional account requires a domain controller. Administrators can choose a
targeted domain controller from the menu, or select Any Domain Controller, which allows Active Directory to choose.

x Note: If a failure occurs when connecting to a target domain controller, Password Safe connects at the domain level.
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Add Propagation Actions to Managed Accounts

Password Safe allows you to manage the credentials for Windows Services, Task Scheduler, 1IS Application Pools, Windows Auto Logon,
COM+ Applications, DCOM Applications, and SCOM RunAs Identities. These accounts can be added as managed accounts in Password
Safe. When their passwords are changed by Password Safe, the credentials are updated in any systems associated with the managed
account, if these options are assigned under Advanced Details > Propagation Actions on the managed account.

Note: The below information applies only for propagation actions that target Windows systems. It does not apply for Unix or
Linux systems, or for SSH script actions.

For propagation actions that target Windows systems, Password Safe deploys a local agent to managed systems via the Password Safe
Propagation Service to complete its tasks.

When a managed account password change occurs and Password Safe determines that a propagation action must occur, the Password
Safe Propagation Service connects to the remote host using the Named Pipes (SMB) protocol over TCP port 445 (as well as UDP ports
137, 138, 139) to access the ADMIN$ share and authenticates using the functional account specified in the managed system. This
connection occurs directly from the Resource Broker(s).

Once connected, the Password Safe Propagation Service creates a temporary folder on the ADMIN$ share,
\\remotehost\\admin$\RBExecService, and deploys the BTExecService.exe local agent in this folder. The propagation service then
completes all of the required propagation actions locally using the BTExecService.exe.

After all required propagation actions are complete, the propagation service deletes the BTExecService.exe agent, as well as the
temporary folder on the ADMINS$ share.

The following access is required for propagation actions to succeed:

« Functional account requires access to the ADMIN$ share on the target managed system(s).

o The Microsoft .NET Framework must be at version 4.7.2 or above on the target managed system(s).

« The \\remotehost\\admin$\RBExecService folder and BTExecService.exe agent must be exempt from any security or endpoint
protection software on the target managed system(s).

The following network ports must be accessible between the Password Safe Resource Broker(s) and target managed system(s):

. 445(TCP)
. 137 (UDP)
. 138 (UDP)
. 139 (UDP)

Assign Propagation Actions to Managed Accounts

You can manually assign propagation actions to a managed account as follows:

1. From the Managed Accounts page, click the vertical ellipsis for an account.
2. Select Go to Advanced Details.
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3. Under Advanced Details, click Propagation Actions. Beyondinsight - Managed Accounts 0 e
4. Click Assign Propagation Action above the grid. - @8
(]

@ | conssen.

Advanced Details. < Propagation Actior

Asignor prope

Deails & Atrbutes

5. Select a Propagation Action from the list. ropagation acions signPropagaion Acion >

x Note: To create a custom propagation action, click Create New
Propagation Action below the dropdown and complete form.
Please see "Create Custom Propagation Action to Run a Script"
on page 85 for more information.

6. Selecta Propagation Set to assign to this managed account. The
Propagation Action runs on each managed system found in the
Propagation Set.

o Select Latest Discovery Data to use managed systems from the most recent detailed discovery scan.
+ Selecta Managed System-Based Smart Rule from the list to use managed systems associated with a Smart Rule.

Propagation actions are also available when creating a managed account Create New Managed Account Based Smart Rule

Smart Rule by selecting Manage Propagation Mappings under Actions, selection Criteria ©

and then checking the applicable actions from the Propagation Action et e that matehy [ALL =7 ofthe folowing

dropdown. = e
| Incude accounts from Directory Query -
[ sppsec ongcraing -]
Re-run the query every X hours (@ 0 ‘

Discover accounts for Password Safe Management

Domain | example.com .

Add another condition  Add a new group

Actions B

Manage Propagation Mappings A %)

Propagation Action | Update Services, Update and Restart Services, Update Scheduled Tasks, Update IIS Applic... v

Managed System Smart Rule | All Managed Systems -

Clear any existing propagation mappings

Add another action

Available built-in Propagation Actions

o Update Services

« Update and Restart Services
o Update Scheduled Tasks

o Update IIS Application Pools
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o Update and Restart IIS Application Pools
+ Update Windows Auto Logon

o Update COM+ Applications

o Update DCOM Applications

o Update SCOM RunAs Identities

Create Custom Propagation Action to Run a Script

Password Safe also allows you to create new propagation actions to run PowerShell, Windows Command, and Unix Shell scripts as
follows.

Note: Ensure you have deployed your script to your desired systems prior to creating a custom propagation action to run a
script, as Password Safe does not deploy the script.

1. Navigate to Configuration > Privileged Access Management > Propagation Actions.
Click + Create Propagation Action.

Complete the form by selecting the type of script to run, providing a

name and description for the action, entering the full path (including Create New Propagation Action >
script name) to the script you want to execute, and specifying the . _ .
command line parameters. The following parameters can be used: Select an action to conflgure its options

o Action Type
¢ %u managed account name Run PowersShell Script -

« %p managed account password

e %h script host name General Details

e %i script host ip Run Update Script °
* %] managed system name
. Action Description
o %k managed system ip
Timeout (seconds)
; —| 120
Note: The %p parameter must be in quotes to be passed N
correctly in the command line.
Shell Script Details
4. Click Create Propagation Action. myscript.bat e
96U %p %h %i 0@
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When a propagation action is triggered, the activity is logged as an event for the managed account. You can view events by viewing the
advanced details for a managed account and clicking Events in the Advanced Details pane. Password changes as well as propagation
actions that occurred for that account are listed in the Events grid.

Manage Windows Service Accounts

x Note: When managing Windows services on managed systems in a clustered configuration, the Windows Services Cluster
APl is used. For successful update of clustered service credentials, all nodes of the cluster must be managed by Password
Safe.

When a service is under Password Safe management, the following occurs when the managed account password changes:

o Aservice thatis running restarts when the password is changed.
o Aservice that is stopped is not restarted when the password is changed.
« Dependent services may or may not restart based on the state of the primary service.

Before adding a service account to Password Safe management, we recommend you do the following:

« Verify machines are in the domain, if applicable.

« Verify assets are managed with a local administrator account if not in the domain, or with a domain administrator account if in the
domain.

Complete the following procedures to prepare and add a service account to Password Safe management.
Prepare the Service

1. Onthe asset where the service resides, open the Windows Services snap-in and stop the service if running.
Right-click the service, and then select Properties.

Select the Log on tab and enter the local or active directory account and current credentials. If required, retrieve a password using
the Password Safe administrator credentials.

4. Restart the service to verify it starts successfully.

Run a Scan on the Service Assets

1. Inthe BeyondInsight Console, click Discovery Scan to run a Detailed Discovery Scan against the target systems to add the
systems as assets in BeyondlInsight. The detailed scan collects data of the services for the targets.

Add the discovered assets to Password Safe management.
Verify the following:
o From the Assets page:
o Select the asset, and then click the vertical ellipsis button for the asset.
o Select Go to Advanced Details.
o Under Scan Data, click Services.
o Confirm the services have been collected, their Status is Running, and the Log On As account name is correct.
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« From the Managed Systems page:

o Select the managed system, and then click the vertical ellipsis button for the system.
o Select Edit Managed System.
o Verify that NetBIOS Name is entered.

4. Fromthe Managed Accounts page:

« Select the managed account associated with the service, and then click the vertical ellipsis button for the managed
account.

o Select Go to Advanced Details.
o Click Propagation Actions from the Advanced Details pane.

+ Click Assign Propagation Action and assign the Update Services or Update and Restart Services action for this
account.

5. Fromthe Managed Accounts page:

« Select the managed account associated with the service, and then click the vertical ellipsis button for the managed
account.

o Select Test Password. A slide-out status message with the results of the change attempt is displayed at the bottom of the
page.

o Click the vertical ellipsis button for the managed account again.

« Select Change Password. A slide-out status message with the results of the change attempt is displayed at the bottom of
the page.

6. Restart the service to verify the password change. The password change is successful if the service restarts. Otherwise, the
password change is not successful. Go through all the steps in this chapter to troubleshoot.

Manage Windows Scheduled Task Accounts

When a scheduled task is under Password Safe management, the following occurs when the managed account password changes:

o A scheduled task that is running stops when the password is changed.
» A scheduled task that is stopped will run again at its next scheduled interval time.

Before adding a scheduled task account to Password Safe management, be sure to:

« Start the Task Scheduler service on the target.
« Verify machines are in the domain, if applicable.

« Verify assets are managed with a local administrator account if not in the domain, or with a domain administrator account if in the
domain.

Complete the following procedures to prepare and add scheduled task accounts to Password Safe management.
Prepare the Scheduled Tasks

1. Onthe asset where the scheduled task resides, open the Task Scheduler snap-in and end the task if running.
2. Right-click the scheduled task, and then select Properties.
3. Onthe General tab, click Change User, and enter the local or active directory account and current credentials. If required, retrieve
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a password using the Password Safe administrator login.

4. Run the task to verify it runs successfully.

Run a Scan on the Scheduled Tasks Assets

1. Inthe BeyondInsight Console, click Discovery Scan to run a Detailed Discovery Scan against the target systems to add the
systems as assets in BeyondInsight. The detailed scan collects data for the scheduled tasks for the targets.

2. Add the discovered assets to Password Safe management.
Verify the following:
o From the Assets page:

o Select the asset, and then click the vertical ellipsis button for the asset.
o Select Go to advanced details.
o Under Scan Data, click Scheduled Tasks.
o Confirm the scheduled tasks were collected.
o Click the i button for each scheduled each task and verify the Run As account name is correct.

« From the Managed Systems page:

o Select the managed system, and then click the vertical ellipsis button for the system.
o Select Edit Managed System.
o Verify that NetBIOS Name is entered.

4. Fromthe Managed Accounts page:
« Select the managed account associated with the scheduled task, and then click the vertical ellipsis button for the managed
account.
o Select Go to Advanced Details.
o Click Propagation Actions from the Advanced Details pane.
+ Click Assign Propagation Action and assign the Update Scheduled Tasks action to this account.

5. Fromthe Managed Accounts page:

« Select the managed account associated with the scheduled task, and then click the vertical ellipsis button for the managed
account.

+ Select Test Password. A slide-out status message with the results of the change attempt is displayed at the bottom of the
page.

« Click the vertical ellipsis button for the managed account again.

« Select Change Password. A slide-out status message with the results of the change attempt is displayed at the bottom of
the page.

6. Run the scheduled task to verify the password change. The password change is successful if the scheduled task starts.
Otherwise, the password change is not successful. Go through all the steps in this chapter to troubleshoot.

Manage Windows IIS Application Pool Accounts

When an IS application pool account is under Password Safe management, the following occurs when the managed account password

changes:
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« An IS application pool that is running restarts when the password is changed.
« An lIS application pool that is stopped is not started when the password is changed.

Before adding an IIS application pool account to Password Safe management, be sure to:

« Start the IS Admin Service on the target.

« Verify machines are in the domain, if applicable.

« Verify assets are managed with a local administrator account if not in the domain, or with a domain administrator account if in the
domain.

Complete the following procedures to prepare and add 1IS application pool accounts to Password Safe management.
Run a Scan on the lIS Application Pool Assets

1. Inthe Beyondlnsight Console, click Discovery Scan to run a Detailed Discovery Scan against the target systems to add the
systems as assets in BeyondInsight. The detailed scan collects data for the 1IS application pools for the targets.

Add the discovered assets to Password Safe management.
Verify the following:

« Fromthe Assets page:

o Select the asset, and then click the vertical ellipsis button for the asset.

o Select Go to advanced details.

o Under Scan Data, click Application Pools.

o Confirm the IIS application pools have been collected, and that their Identity account name is correct.

« From the Managed Systems page:

o Select the managed system, and then click the vertical ellipsis button for the system.
o Select Edit Managed System.
o Verify that NetBIOS Name is entered.

4. Fromthe Managed Accounts page:

« Select the managed account associated with the IS application pool, and then click the vertical ellipsis button for the
managed account.

o Select Go to Advanced Details.
« Click Propagation Actions from the Advanced Details pane.
+ Click Assign Propagation Action and assign the Update IIS Application Pools or Update and Restart 1IS
Application Pools action to this account.
5. Fromthe Managed Accounts page:

« Select the managed account associated with the IS application pool, and then click the vertical ellipsis button for the
managed account.

» Select Test Password. A slide-out status message with the results of the change attempt is displayed at the bottom of the
page.

« Click the vertical ellipsis button for the managed account again.

« Select Change Password. A slide-out status message with the results of the change attempt is displayed at the bottom of

the page.
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Manage Windows Auto Logon, COM+ Application, DCOM Application, SCOM
RunAs Identities Accounts

Complete the following procedures to prepare and add a service to Password Safe management.
Run a Scan on the Service Assets

1. In BeyondIinsight, click Discovery Scan to run a Detailed Discovery Scan against the target systems to add the systems as
assets in BeyondInsight. The detailed scan collects data of the services for the targets.

2. Addthe discovered assets to Password Safe management.
From the Managed Accounts page:
« Select the managed account associated with the service, and then click the vertical ellipsis button for the managed
account.
» Select Go to Advanced Details.
« Click Propagation Actions from the Advanced Details pane.
« Click Assign Propagation Action and assign the the appropriate Windows Auto Logon, COM+ Applications, DCOM
Applications, and SCOM RunAs Identities propagation actions for this account.
4. Fromthe Managed Accounts page:
« Select the managed account associated with the service, and then click the vertical ellipsis button for the managed
account.
o Select Test Password. A slide-out status message with the results of the change attempt is displayed at the bottom of the
page.
« Click the vertical ellipsis button for the managed account again.

« Select Change Password. A slide-out status message with the results of the change attempt is displayed at the bottom of
the page.

x Note: The functional account associated with the SCOM Managed System must be added to the Operations Manager
Administrators profile in the SCOM Operations Manager Console.
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Configure Password Safe Global Settings

1. Inthe Beyondlnsight console, go to Configuration > Privileged Access Management > Global Settings.
2. Setthe options in each of the sections below. Click the Update button for each section to apply changes made in that section.

Sessions

Setting Description / Action

Connecting to systems using | Choose how you want to connect to systems. Select DNS Name or IP Address, or All if you want
multiple connection options to be available.

Default RDP port for new Change the default port for all RDP sessions.
Managed Systems

Token timeout for remote Change the default timeout. The default is 30 seconds. The range is 10 - 60 seconds.
session playback

Session initialization timeout = Change the default session token value. The default is 60 seconds. The range is 5 - 600 seconds.
Applies to SSH, RDP, and application sessions.

Default RDP screen Change the default screen resolution. Range is 640x480 - 1920x2058 pixels. An option is available to
resolution allow the client application to select screen resolution.
Allow multiple monitors in Check this option to allow more than one monitor in a remote desktop session.
remote desktop sessions
Enable smart sizing by Check this option to resize the RDP window to match the size of the user's screen.
default
Make smart card device When this option is checked, the user must log in to the session using smart card credentials when
available in remote desktop configured for the system. This setting applies to all RDP sessions and is disabled by default.
sessions
Hide record check box for ISA | This option is checked by default. When this option is checked, ISA sessions are recorded and the
sessions Record Session check box is not available on ISA session requests. Uncheck this option if you want
the Record Session check box available on the requests, giving the user the option to record the
session.
Hide record check box for This option is checked by default. When this option is checked, Admin sessions are recorded and the
Admin Sessions Record Session check box is not available on the Start Admin Session form. Uncheck this option if
you want the Record Session check box available on the form, giving the user the option to record
the session.
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Setting Description / Action

Allow desktop background in
remote desktop sessions

Bypass SSH Connection
Tests

Requests

Controls whether the desktop background is displayed in the remote session. Can be disabled in
scenarios of slower network connections.

This option is disabled by default; therefore, Password Safe performs a quick connectivity test to the
target system to validate it's online and available. Checking this option to bypass the SSH
connectivity test can be useful in environments when systems may not always be online and
available.

d

Note: Allowing the test to happen can result in a faster connectivity failure response back
to the user (ie: a 5 sec test vs a 30 sec timeout for an SSH connection). If systems are
consistently available, then the test can be bypassed to slightly reduce the initial
connection time.

Setting Description / Action

Require a ticket system and
ticket number for
ISA requests

Display who has approved
sessions

Reason is required for new
ISA requests

Auto-select access policy for
Quick Launch

Bypass SSH Landing Page
for Quick Launch

Bypass SSH Landing Page
for regular or ISA requests

Domain Account
Concurrency Behavior

View Password and SSH
Session request display
timeout (seconds)

Enable to have mandatory completion of the Ticket System and Ticket Number fields on all
requests.

Enable this option on all requests.

Enable this option on all requests.

Enable to automatically select the best access policy. When this option is selected, the access policy
with the most available actions, or multiple access policies will be selected if each one has a different
action. When this option is not selected, all the available access policy schedules will display when
using Quick Launch.

Enable to save time for users when connecting using Quick Launch.

Enable to bypass the SSH landing page when running an SSH Session or SSH Application Session,
and instead directly open PuTTY. This setting applies only to regular requests, ISA requests, and
admin sessions. It does not apply to sessions initiated using Quick Launch.

This setting defines how the Concurrent setting in an access policy applies the checkout
concurrency for a domain account.

When Account is selected, Password Safe applies the checkout concurrency to how many
concurrent sessions a domain account may have per environment.

When Account and System is selected, Password Safe applies the checkout concurrency to how
many concurrent sessions a domain account may have per system in an environment.

Enter a number between 0 and 300 seconds, to set the maximum time for viewing a credential. The
default is 120 seconds. Setting this number to 0 disables the timer, and the credential remains visible
until the user closes the view or navigates away from the screen.
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i For more information, please see "Add Ticket Systems to the List on the Requests Page" on page 160.

Session Monitoring

Keystroke logging for admin  Records keystrokes for recorded RDP admin sessions that can be viewed in the right pane when
session (RDP) viewing a recorded session. This is enabled by default. Uncheck this option to disable keystroke
recording for RDP admin sessions.

Keystroke logging for admin | Records keystrokes for recorded SSH admin sessions that can be viewed in the right pane when
session (SSH) viewing a recorded session. This is enabled by default. Uncheck this option to disable keystroke
recording for SSH admin sessions.

Keystroke logging for ISA Records keystrokes for recorded RDP ISA sessions that can be viewed in the right pane when

(RDP) viewing a recorded session. This is enabled by default. Uncheck this option to disable keystroke
recording for RDP ISA sessions.

Keystroke logging for ISA Records keystrokes for recorded SSH ISA sessions that can be viewed in the right pane when

(SSH) viewing a recorded session. This is enabled by default. Uncheck this option to disable keystroke
recording for SSH ISA sessions.

Keystroke logging for ISA Records keystrokes for recorded ISA application sessions that can be viewed in the right pane when

(Application) viewing a recorded session. This is enabled by default. Uncheck this option to disable keystroke

recording for ISA application sessions.

Enhanced session auditing Enhanced session auditing captures and records all mouse activity in the Keystrokes menu of

for ISA (RDP) Recorded Sessions for RDP sessions. Enhanced session auditing is enabled by default. It uses the
rules in the access policy for Admin Session multi-session checkouts. During a recorded RDP
session, an agent called pbpsmon is installed on the host for the duration of the session. The agent
monitors and audits Windows click events.

Enhanced session auditing Enhanced session auditing captures and records all mouse activity in the Keystrokes menu of

for ISA (application) Recorded Sessions for RDP application sessions. Enhanced session auditing is enabled by default.
It uses the rules in the access policy for Admin Session multi-session checkouts. During a recorded
RDP session, an agent called pbpsmon is installed on the host for the duration of the session. The
agent monitors and audits Windows click events.

}{ Note: Session monitoring captures text that is copied in an RDP session window. The copied text is captured only the first
time. Any subsequent copy tasks of the same text are not captured for the session.

;{ Note: To use enhanced session auditing, the functional account of the managed Windows host or Remote Desktop Services
host must have administrative rights.

1 For information on Session Monitoring options, please see "Configure Session Monitoring" on page 146.
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Purging
| setng | Descripton/Acon

Minimum retention for old Set the number of days to retain old passwords. The default is 30 days. The range is 1 - 360 days.
password

Number of old passwords to | Set the number of past passwords to retain. The default is 5 passwords. The range is 1 - 30
retain passwords.

}? Note: Password Safe will retain, at minimum, a number of passwords equal to the total of
the current password (1) plus the value for Past Passwords. Password Safe will delete
all passwords that are older than the number of days equal to the value of Minimum
Retention Days.

Retention period for sent mail Set the number of days to store log entries for sent email. The default is 30 days. The range is 1 - 365

log days.

Retention period for admin Set the number of days to store the administrator activity logs. The default is 90 days. The range is 30
log - 365 days.

Retention period for Set the number of days to store password change logs. The default is 90 days. The range is 30 - 365
password change log days.

Retention period for Set the number of days to store success and failure results for automated password tests. The default
password test results is 30 days. The range is 10 - 90 days.

Retention period for system  Set the number of days to store system event logs. The default is 365 days. The range is 5 - 1095
event log days.
Miscellaneous

Setting Description / Action
Unlock accounts on Enable for locked accounts to automatically unlock when their password has changed.

password change
Enable Rebex debug logging Enable Rebex debug logging to troubleshoot custom platform issues.

Jumphost connection format | Select Hostname or IP Address.

Enable automatic admin Failed email notifications can be sent to multiple admin accounts. Disable to stop sending admin

notifications for failed notification emails, or enable to start sending admin notification emails. This setting is disabled for

password events new installations but enabled for existing installations.

Enable automatic Notifications are sent to the email address assigned to the Managed System, Managed Account, or

notifications for failed Active Directory managed system. Disable to stop sending propagation notification emails, or enable

propagation events to start sending propagation notification emails. This setting is enabled by default for all new
installations.

! Tip: To access propagation and password events from the BeyondInsight console, click Managed Accounts in the left menu.
. Click the vertical ellipsis to the right of a managed account, and then select Go to Advanced Details. Under Advanced
Details, click Events.
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Changes made to Global Settings can be seen on the User Audits page:

1. Go to Configuration > General > User Audits.

2. Changes that were made to Password Safe Global Settings are indicated as PMM Global Settings in the Section column. Click
the i button for the audit item to view more details about the action taken.

‘ rAa
Showing all 2 User Audits — m # LdJ
Section Username IPAddress
a
PMM Global Serrings Administrator

Network traffic can create delays in establishing the connection. Increase the token timeout if you are experiencing network
timeouts. For more information on multi-node session playback, please see "Configure Session Monitoring" on page 146.
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Manage the IP Allow List

BeyondTrust provides additional security controls with an IP Allow List. Administrators can specify which IP addresses are allowed to
access your Password Safe Cloud instance using IP rules. If anyone attempts to access the instance from an IP address that is not within

the list of allowed addresses, they will not be able to reach the host.
Changes made to IP rules in the IP Allow List do not take effect until the IP rule is set to active and changes are saved using the Save IP
Allow List button below the grid.

IMPORTANT!

When configuring IP rules, it is important to start by adding the IP address you are currently using to the allow list, and then add IP
addresses for all the resource brokers in your environment. Warning messages and informational text are shown to encourage you to
add your own IP Address to the list first, to avoid a situation where you lose access to your instance.

If IP address changes are made in your network that cause you to lose access to your instance, BeyondTrust Cloud Operations can
reset your IP Allow List.

The below sections detail how to add, enable, disable, edit, or delete IP rules.

Add IP Rule

Add an IP rule to the IP Allow List, as follows:

1. Go to Configuration > System > IP Allow List.
2. C“Ck Add IP Rule. Beyor:;lnslght Configuration

1P ALLOW LIST

Star by adding yourown P scress

96
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3. Select rule Type from the dropdown list:

Add IP Rule >
+ CIDR Notation: This allows access from any IP addresses within a CIDR block -
identified using Classless Inter-Domain Routing (CIDR) notation. ‘ - - ‘
« Single IP Address: This allows access from a single IP address. ‘ ‘
CIDR Notation

+ IP Range: This allows access from any IP address within the range.

. . (| dd
Enter information for the rule. Single [P Address

Check the Active box to enable the rule. IP Range
Click Add To List. To IP Address

Description (optional)

O Active

7. Click Save IP Allow List at the bottom of the grid to save changes.

Enable the IP Allow List

Setting an IP rule to Active ensures that any IP outside of the rule cannot access the Password Safe Cloud instance. However, the rule
does not take effect until the Turn on network restrictions global setting is enabled. This setting is disabled by default for all customers
to prevent you from being locked out of your instance.

x Note: Users editing the IP Allow List and Resource Broker IPs must be added before restrictions are enabled. Resource
Broker IPs are located on the Resource Broker Grid, which can be found at the bottom of the BeyondInsight console home
page. If the Resource Broker IPs are located behind a VPN or NAT gateway, IP rules must be added accordingly to cover the
necessary address space.

Enable the Turn on network restrictions setting, as follows:

1. Fromthe IP Allow List page, click the toggle to enable the Turn on network P ALLOW LIsT
restrictions setting. ‘

2. Click Save IP Allow List to save changes.

Activate and Deactivate IP Rules

IP rules can be activated upon creation. They can also be activated and deactivated using actions in the IP Allow List grid, as follows:
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1. Check the box next to the IP rule. If the IP rule is active, the
Deactivate button appears above the grid. If the IP rule is inactive,
the Activate button appears.

2. Click the Activate/Deactivate button to change the Status of the IP
rule.

« Alternatively, you can click the vertical ellipsis button for the
rule and select Activate/Deactivate. =L T . - R

3. Click Save IP Allow List to save changes.

Edit and Delete IP Rules

You can edit an IP rule, as follows:

1. Click the vertical ellipsis for the rule and select Edit IP Rule.

2. Edit the rule, and then click Save Changes. =

3. Click Save IP Allow List to save changes.

You can delete the IP rule, as follows:

1. Check the box next to the IP rule to select it.
2. Click the delete icon above the grid.

« Alternatively, you can click the vertical ellipsis button for the rule and select Remove IP Rule.

3. A message displays, asking you to confirm your action. Click Remove to continue or Cancel to keep the IP rule.

Restrictions

Network security groups contain rules and restrictions for allowing the flow of network traffic to and from different Azure resources.
Restrictions that you should be aware of are, as follows:

« A unique name within the network security group. The name can be up to 80 characters long. It must begin with a word character,

and it must end with a word character or with'_". The name may contain word characters or'.","-', "
o Description maximum length 140
o |IPv4 range maximum number of addresses 1500
+ RestrictedAddress - Error message displayed: "Restricted IP address, see documentation for more details."

i For more information, please see Microsft Azure Network Security Rules.
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Add Databases to Password Safe

There are two ways to discover and manage database instances:

« Auto-discover using a scan template, and then auto-manage using a Smart Group. Use this method for SQL Server and Oracle.
+ Manually add and manage databases. Use this method for MongoDB, MySQL, Sybase ASE, and Teradata.

Auto Discover and Manage Database Instances

The following scan types include database instance data in the scan results:

« Detailed Discovery Scan: This scan requires credentials and it deploys a scan agent to the scan targets. Besides systems, this
scan provides associated information on services, scheduled tasks, users, and databases.

+ Advanced Discovery Scan: This scan performs the same operations of the detailed scan, but provides information on all
associated attributes.

After you run a scan, the assets are displayed on the Assets page. At this point, you can create a Smart Rule to manage the database
instances.

1. From the left menu, click Smart Rules.
2. Click + Create Smart Rule.
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3. Select or create a new category and provide a name and
description for the Smart Group.

4. For selection criteria, select Address Group, and then select the
group that includes the database instances.

5. Add another condition, select Host Database Instance, and then
select the database types.

6. Forthe actions, select Show asset as Smart Group.
7. Add more actions of Manage Assets using Password Safe, and

Create New Asset Based Smart Rule

Details &
Cotegory

Servers

Name

MSSQL and Oracle Databases

Description

Discover MSSQL and Oracle Databases

Reprocessing it

Default

] Active

Selection Criteria &

then select the platforms, account name formats, functional Inciude ems tht motch | ALL ~ | ofthe following
accounts, and other desired settings, ensuring to use the default Adress Group K
port numbers for the databases: [deress growp .
Use to discover new assets during scans
o Oracle: 1521
Host Database Instance - ‘ ()
L4 SQL Server 1433 o ‘MSSQLSeNer,Orade -
8. Click Create Smart Rule. e
Actions &
‘Show asset as Smart Group - ‘ [
x Note: An Oracle database can be part of a database cluster. If e s ot - e
several nodes are found through discovery, only a single oo M5 S -]
database managed system is created. Cluster fail over is eoommefomet. Lo ‘ |
SU O’.ted. Functional Account | uvm db functional account -
pp Enable Automatic Password Management | yes -
Enable Accounts For AD Queries | no -
Password Rule | Default Password Policy -
x Note: The Smart Rule auto-excludes the functional account comectonTimeous @[ 30
assigned for that system, as well as the sa account for MS SQL P @ 1 |
Server systems, from Password Safe onboarding. The sa -lo
account is excluded as a precaution against it being inadvertently Platiorm Orade -]
onboarded by mistake. If you want Password Safe to manage the Crangeagene | passora safe -
sa account, you can either manually create the managed account Acccun e Foma | Pomamsemare -]
or use the Create Managed Account on each system Smart poc s -]
Rule action in a Managed System Based Smart Rule. e samaticpssvord Monagemene [y -
Enable Accounts For AD Queries | no -
Password Rule | Default Password Policy - ‘
Elevation  None v ‘
Connection Timeout B‘ 30
port @ 1521
‘Add another action
. ’ Tip: To view the contents of a Smart Rule when creating a new rule or editing an existing rule:
e Once the rule is saved, click View Results.
« You are taken to the associated grid, where the contents of the Smart Rule are listed.
» Ifthe rule is actively processing, a banner displays letting you know that.
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x Note:

» View Results displays only if you have permissions to the grid corresponding to the Smart Rule, i.e.; Assets, Managed
Accounts, Managed Systems.

o The Smart Rule must be saved with Show <entity> as Smart Group selected under Actions to view the results.

. ’: Tip: Because the Smart Rule must process to display the contents in the grid, we recommend viewing the results using only
the Show <entity> as Smart Group action and before adding additional actions that may make changes to accounts and
assets in your network.

Once you have confirmed the rule contains your desired items, you can then add additional actions to the Smart Rule.

Manually Add Database Instances

You can manually add the following database instance types. When selecting the database platform, ensure the correct port number is
displayed.

e Mongo: 27017

« MS SQL Server: 1433

» MySQL: 3306

e Oracle: 1521

o PostgreSQL: 5432

« SAP HANA: 30015

o Sybase ASE: 5000

o Teradata: 1025

Manually Add Databases to Assets Managed by Password Safe

From the left menu, click Assets.

Click the vertical ellipsis button for the asset, and then select Go to Advanced Details.

Under General Data, click Databases.

Click + Add Database above the grid.

Provide a name, select the platform, add a version, leave the default port, and then click Save Database.

o wDh =

Manually Add Databases to Password Safe Management

1. From the left menu, click Assets.
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2. Assets that host database instances are indicated by a Database Host icon in the Solution
column.

Solution

W e BOy|E

3. Click the vertical ellipsis button for the desired asset, and then select Go to Advanced Details.
Under General Data, click Databases.

Click the vertical ellipsis button for the desired instance, and then
select Add to Password Safe.

6. Onthe Create New Managed System form, expand Credentials
and select the functional account.

7. Select other settings as desired, and then click Create Managed
System. o ———

Manage Database Instance Accounts

Once the database instances are managed, create a managed accounts Smart Rule to manage the database instance accounts. The
steps are the same for both auto-discovered or manually added database instances.

From the left menu, click Smart Rules.

Select Managed Account from the Smart Rule type filter dropdown.

Click + Create Smart Rule.

Select Managed Accounts from the Category dropdown.

o & b=

Provide a meaningful Name and Description for the Smart Rule.
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6. Select the criteria to match on the database instance account name, Create New Managed Account Based Smart Rule
filtering out any named functional accounts. o e
7. Select Yes from the Discover accounts for Password Safe e ems thacmarh (42 7| ofteiotewing
Management list. User Account Attrbute - O
8. From the Discover accounts from list, select the smart group o >
where the database instance resides. sarcerame o
9. Inthe Actions section, select Show managed account as a I :
Smart Group from the list. I b ccouns o .
10. Select Manage Account Settings from the list. Vo e -0
11. Select a password rule, and either auto-manage the accounts or do e
not. R e — °
1 2 . Clle create Smart Rule Discover accounts for Password Safe Management | yes -
Actions ©
Show managed account as Smart Group. -
Manage Account Settings A
Password Rule | Default Password Policy v
Enable Automatic Password Management | yes. -
Change Password Time | 23 v 30 -
Change Password Frequency ~Every 30 Days
Default Release Duration Days: 0 Hours: 2 Minutes: 0
ISA Default Release Duration Days: 0 Hours: 2 Minutes: 0
Max Concurrent Request  (G@ 1
/Account Options | Change Password after Release, Check Password -
O change Password on Mismatch
Email release notifications to

e Once the rule is saved, click View Results.

' Tip: To view the contents of a Smart Rule when creating a new rule or editing an existing rule:

« You are taken to the associated grid, where the contents of the Smart Rule are listed.

 Ifthe rule is actively processing, a banner displays letting you know that.

x Note:

o View Results displays only if you have permissions to the grid corresponding to the Smart Rule, i.e.; Assets, Managed

Accounts, Managed Systems.

o The Smart Rule must be saved with Show <entity> as Smart Group selected under Actions to view the results.

L

' Tip: Because the Smart Rule must process to display the contents in the grid, we recommend viewing the results using only
the Show <entity> as Smart Group action and before adding additional actions that may make changes to accounts and
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assets In your network.

Dnce you have confirmed the rule contains your desired items, you can then add additional actions to the Smart Rule.

Note: When using MYSQL with multiple accounts with the same name, Password Safe can only support rotating the
password on all instances of the username using a functional account.

Discover Accounts for SAP HANA Databases

Most database platforms leverage the Discovery Scanner to discover the asset and then find the accounts in the database . SAP HANA,
however, does not use the Discovery Scanner. With the SAP HANA database platform, you must manually create the asset and then
leverage a managed account Smart Rule for account discovery.

For more information, please see Add Assets to Password Safe at https.//www.beyondtrust.com/docs/beyondinsight-
password-safe/ps/cloud/admin/add-assets/index.htm.

When creating the managed account Smart Rule, select the following under Selection Criteria:

» User Account Attribute from the first dropdown list. Selctn Crneda .

« Account Name from the second list. —

« The appropriate operator from the third list, i.e. contains, equals (=), A ‘ -
starts with, etc. m -

unts for Password Safe Management | yes

« Enter the appropriate value in the next field.

+ Yes from the Discover Accounts for Password Safe
Management dropdown list. s

« An existing asset Smart Group that contains the SAP HANA asset Acions ©
(s) in your environment, from the Discover Accounts From o — - o
dropdown list. S il [URRPEREI z

All SAP Hana D85

Inchuda disabled accounts. | o

Enable Automati Password Management | ¥e3 v

For more information, please see Work with Smart Rules at https://www.beyondltrust.com/docs/beyondinsight-password-
safe/ps/cloud/admin/work-with-smart-rules.htm.
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Create a Functional Account for a SQL Server Database

When you are adding SQL Server as a managed system, you must first create a security login in SQL Server to use for the functional
account.

Permissions and Roles in SQL Server

The following roles and permissions are required for the functional account:

o Serverroles — public
e ALTERANY LOGIN
« CONNECT SQL

Apply Permissions to a Functional Account:
The following code samples show you how to apply the required permissions to the functional account.

GRANT CONNECT SQL TO [FunctionalAccountName];

GRANT ALTER ANY LOGIN TO [FunctionalAccountName];

Create the Account in SQL Server

1. Connect to a database as the SQL Server sa on the asset you manage.
2. Expand Security and expand Logins.
3. Right-click Logins and select New login.
4. Enter a Login name and select SQL Server Authorization. I Looe=ren ESaIES
_ : 5 Soit - [ Heo
5. Enter and confirm a password. %ﬂ?&?:&’::g e ] =
. . . 2 Securables * Windows authertication
6. Configure the user as desired and click OK. 2 Staus SR
Password [
Confirm password [
™ Specty oldpassword
0Oid password [
I¥| Enforce password policy,
¥ Erforce password expiration
¥ User must change password at next login
" Mappedto cerficate [ =l
" Mappedto asymmetric key | j
I Map to Credential [ = | Add
MErEIEEE D Credential Provider
é;::;zwards#a\CK_DwscavawT(
Connection:
HALIDOM\ckhalidom
&7 View connection properties
ETr— fenove
Ready Default database: master =l
Defautlanguage: [cdetauit> =l
Gl |
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7. To configure the user, right-click the user and select Properties.
8. Select Server Roles and ensure the public roles is selected. ¥ Loanpoperses | BIES

Select apage 8 Senpt + I Help
General

Server role is used to grant server-wide secuily privileges to a user

User Mapping
Securables

EE Server ioles
[ bulkadmin
] dbereator
] diskadmin
[ piocessadmin
vl public
[ securiadmin
] serveradmin
] setupadmin
[ sysadmin
Server
Passwordsafet,
Connection:
3 Wiew connection properties
Ready
EENp
9. Select Securables and click Search.
10. Select the serverinstance and click OK.
11. From the list of permissions, ensure the Alter any login and Expict | Efective |
Connect SQL are selected for Grantor sa. Permission Grant | Deny <]
. Alter arty linked server O | )
12 Click OK. g T | m
Alter ary server audit sa O O [}
Alter resources sa | | ||}
Alter server state sa O O O
Alter settings sa |m] || | m}
Alter trace: sa O O O
Autherticate server sa O O O
Connect SQL sa Il O -
Control server sa O O C
< | B I_I
_ Ceed |

Retrieve SQL Server Instance Port Number

To configure a SQL Server database for Password Safe, you must retrieve the port number on the managed database instance using a
query. The below query is required for database instances only. You do not need to provide a port number for the default instance.
Create aninstance on SQL Server.
Once the instance is running, open the database and then select New Query.
Execute the following query as shown on separate lines:

GO
xp readerrorlog 0, 1, N'Server is listening on'
GO

From the left menu in Beyondinsight, click Assets.

5. Onthe Assets page, find the asset where the SQL Server database is installed.
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Click the vertical ellipsis for the asset, and then select Go to Advanced Details.
Under General Data, click Databases.
Click + Add Database above the grid.
9. Enter a name for the instance.
10. Select MS SQL Server from the Platform dropdown.
11. Leave the default port or manually add the correct database port.
12. Click Save Database.

13. From the Databases grid, click the vertical ellipsis for the newly created database, and then select Add to Password Safe.

© N o

14. Select the details required for the managed system.
15. Click Create Managed System.

Add a PostgreSQL Database Instance

A PostgreSQL database instance must be added manually.

Before adding the instance to Password Safe management, you must create an account in PostgreSQL to use as the functional account in
Password Safe.

Create Accounts in PostgreSQL

x Note: The following instructions are for guidance only. For details on how to create an account, refer to the PostgreSQL
documentation.

To create the account with appropriate level permissions:

Run pgadmin from the icon on the tray.
Right-click Login/Group roles, and then click Create.
Enter a name. This is the functional account.

Ll

On the Privileges tab, ensure the following permissions are in place for the functional account: Login, Create role, and Inherit
rights from parent roles.

o

Right-click Login/Group roles, and then select Create.

Enter a name. This is the managed account.

On the Privileges tab, ensure the following permissions are in place for the managed account: Login, and Inherit rights from
parent roles.

You must also know the database instance name and the port number. In pgadmin, click Object , select Properties, and then click the
Connection tab.

Add the PostgreSQL Instance to Password Safe

1. Scan the asset where the PostgreSQL instance resides.

2. From the left menu in BeyondIinsight, click Assets.

3. Click the vertical ellipsis button for the asset, and then select Go to Advanced Details.

4. Under General Data, click Databases.
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5. Click the vertical ellipsis button for the desired instance, and then select Add to Password Safe.
6. Set the following:

+ Instance Name: Enter the instance name.
« Platform: Select PostgreSQL.
« Version: Enter the PostgreSQL version number. This is optional.
o Port: The default port value is 5432.
7. Click Create Managed System.
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Configure Settings on the Oracle Platform

When adding Oracle as a managed system, follow these steps:

o Add the functional account to the console.
« Add the functional account to the Oracle user list in Oracle.
o Setthe IP address for the host in Oracle Net Manager.

Add the Functional Account

Select Configuration.

Under Privileged Access Management, click Functional Accounts.
Click Create Functional Account.

Select Database from the Type dropdown list.

Select Oracle from the Platform list.

2N o e

Select SYSDBA from the Privilege list, and then enter the username and password. The SYSDBA role is required if you use the
SYS Oracle account as the functional account.

7. Continue to set the remaining options.

x Note: When adding the Oracle platform as a managed system, be sure to select the SYSDBA functional account.

i For more information, please see "Create a Functional Account" on page 16.

Set Permissions for the Functional Account in Oracle

In Oracle Enterprise Manager, the functional account (other than SYS) must be added to the Oracle user list.
The user account must be assigned the following Privileges & Roles:
« ALTERUSER

« CONNECT
« SELECT ON DBA_USERS (Required for auto Discovery of Oracle instance managed accounts.)
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ORACLE Enterprise Manager Database Express 1 ¢ o= | 1 sTEm gl O
B ADOPSOR (12.1.0.2 e Cord ton v O Rosm v 8 :
View User:TTTTTLLOCAL T mADMIN Poge Refrested 4:5%47PMGMT-0300
Account Sumemary
Mo (0 OUORACLEADNEN
Proble COFAAT

Airterdeaban  PASTWORD
Espration Date  Mon Oct 23, 2007 5614 P
Cefoul Tabdespace USORS
Tednpete oy Tablespace  TEMP
Accourt Rabus  OPIN
Crosted  'Wed Sor 26, 2017 4:56: 14 PM

Privibeges & Robes Climct Provioges Qe

Privileges. & Roles

s ® B riane

Priviegs Weiith: ey s Fooker Ol skt Bicke

[ arem usen h——— ' - e —|
| conecT " 5 |

Create the Functional Account in Oracle
To create a functional account in Oracle:

CREATE USER [FunctionalAccountName] IDENTIFIED BY password;
GRANT CONNECT TO [FunctionalAccountName];

To grant permission to the functional account to change passwords on a managed account:

GRANT CONNECT TO [FunctionalAccountName];
GRANT ALTER USER TO [FunctionalAccountName];
GRANT SELECT ON DBA USERS TO [FunctionalAccountName];
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Configure the Host

On the Oracle platform, you must configure the following settings:

« In Oracle Net Manager, the host name IP address must be explicitly ¥Torack et Manager —C Sprodut\{22.0\dbhome_T\NETWORK ADMIN,
set as a listener. Fio Eut o

©-%42 Oracle Net Configuration
v =
@Frofile o == ]
gsenice Narming 9 ]
tﬁ- [Desicated server -]
Listeners
L@ sTenErR

entification

Protacal: TCPIIP v

Hast Narme: 10,
Port Number: 1521

Show Advanced

« Alsoin Oracle Net Manager, set the service name as the host name 7 Oracle Net Manager - \dbhome_{|NETWORK\nDMIN,

IP address. =2 orate Net Connguraton
S Local dtrmee
B Profile ress
& Senice Naming
4
v
Listeners

[ sTENER)  Network Address

Port 1521
Show Advanced

Add Address | | Remove Address

Use Encrypted Connections

Password Safe supports Oracle database connections that are configured to use encryption. Using encryption is optional.

The following encryption protocols are supported:

o AES128

o« AES192

» AES256

« RC4_128,RC4_256, 3DES112
- 3DES168
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Configure encryption using Oracle Net Manager.

x Note: The following section is provided for guidance only. For more information, refer to Oracle product documentation.

On the Profile node, select Network Security and then set the following:

« On the Integrity tab, select:
o Server from the Integrity menu
o required from the Checksum Level menu
o SHA256 as the method

« On the Encryption tab, select:
o Server from the Encryption menu
o required from the Encryption Type menu
o AES256 as the method

x Note: If you select required for Checksum Level and Encryption Type, you must enter an encryption seed in the sqlnet.ora
file.

Oracle Internet Directories OID

OID Connect Descriptors (also known as TNS Connect Strings) define all parameters needed to connect to a specific Oracle database
service, such as the instance name, DNS name, IP address, and port. You can leverage OID Connect Descriptors to add Oracle database
systems to Password Safe.

When adding an Oracle database as a Managed System in Password Safe,
select the appropriate database service and Password Safe reads the Create New Managed System )
Connect Descriptor data when communicating with the Oracle database.

Database -
Platform
Oracle -

5D Collzpse All | (T Expand Al
Identification &

Connection Typs

Oracle Internet Directories h

OID LDAP hd

DB Service
TESTALIAST hd LOAD
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Configure an Oracle Internet Directory

To use this functionality, you must configure an OID, as follows:

Go to Configuration > Privileged Access Management > Oracle Internet Directories.
2. Click Create New Oracle Internet Directory +.

3. Enter a name for the directory, a short description, and information Create New Oracle Internet Directory
for the LDAP server.
Name
Check Use SSL if desired.
‘ New OID [x] ‘
5. If you turn off Use Anonymous, enter a name and password.
6. Click Create Directory when done, or Discard, if you do not wish to Description
keep it. ‘ ‘
7. You can also click Test Server to test the connection.
LDAP Server
‘ 10.200.30.40:1234 o ‘
(O usessL
Context
‘ cn=0racleCantext.dc=pbps.dc=dev [+

° Use Anonymous

Username

Password
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Add Applications to Password Safe

Applications can be managed by Password Safe. Requesters can request access to an application and launch a session through the
Password Safe web portal. This provides a secure and user-friendly way to manage application access, enhancing overall productivity
and security for both requesters and administrators.

Application sessions can be recorded.

Prerequisites

» The application or script must be hosted in a published Remote Desktop Services (RDS) container on the RDS server, that the
functional account and managed account can access.

+ The host must be accessible on port 3389.

+ The system where the application resides must already be added to Password Safe before you can add the application.
To add an application to Password Safe management, you must do the following:

o Set up the application details in Password Safe configuration.

« Associate the application with a managed account.

« Create an access policy that permits application access. Recording and keystroke logging can be turned on here.
o Create a user group that includes the Smart Group containing the managed accounts.

« Assign the Requester role to the Smart Group. This includes selecting the access policy.

Add an Application

Follow the steps below to add an application.

x Note: Confirm the application or script to be configured in Password Safe is configured and hosted in a published RDS
container on the RDS server prior to configuring it in Password Safe.

Please refer to this Microsoft article for more information: Create a Remote Desktop Services collection for desktops and apps
to run at

https.//docs.microsoft.com/en-us/windows-server/remote/remote-desktop-services/rds-create-collection.

If you require assistance with this process, please contact your system or network administrators, or Microsoft Support if

necessary.
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1. Select Configuration > Privileged Access Management > Applications.
Click Create New Application.

Enter a Name (required) and Version (optional) for the application. We recommend using
the name of the application for transparency.

4. Enter an Alias (required). By default, an alias combines the name and version, but can
also be edited to display any desired alias.

5. Enter the path to the application in the Application/Command (required) field. For
example, C:\Program Files\Windows NT\Accessories\wordpad.exe.

’ Tip: Use the PS_Automate utility to automate the launch and
authentication to a web page or to a standard Windows GUI
application, by seamlessly passing vaulted credentials to a
remote application. Enter the variable %PsAutomate% in the
Application/Command field to ensure the PS_Automate utility
is used regardless of the location of the application.

6. Enter the arguments to pass to the application in the Parameters (optional) field.

Default placeholders are as follows:

« managed account name = %u

« managed account password = %p
« managed asset name = %h

« managed asset IP = %i

database port = %t
« database instance or asset name = %d
e jump hostdns = %n
database dns = %s

o access URL = %w
Usage syntax for the PS_Automate utility is as follows:

« Web application: ps_automate.exe [ini=path to inifile][TargetURL=url]
[BrowserName=name of browser]

o Accepted values for BrowserName are: "chrome”, "firefox", "msedge"
« Windows application: ps_automate.exe [ini=path to inifile]
7. Selectan option under Where do you need the application to run?:

+ On the current system is the default and runs the application on the managed
system that the account is currently on.

« On a different system runs the application based on the selections in the

Functional Account and Managed System dropdown lists, i.e. an RDS server or

RDS farm.

o Select a Functional Account to connect to the Password Safe managed
system hosting the remote application.
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o Select a Managed System. The managed system must have the application (such as wordpad.exe) configured.
When starting an application session, an RDP session connects to this application server and starts the
application.

8. Select an option under Domain linked account behavior:

« No Association: The application is not associated with any Linked Systems or Smart Groups. This applies only when the
application is assigned to a directory-type managed account, i.e. Active Directory, LDAP, etc.

+ Associate with Linked Systems: The application is associated with linked systems. Select one or both of the following
system types:

o Windows

= |f you associate the application with a linked Windows system, standard users see all Windows-based
systems applied to the Domain Linked Account when they log in to Password Safe. This excludes Unix
systems.

o Unix

= |f you associate the application with a linked Unix system, standard users see all Unix-based systems
applied to the Domain Linked Account. This excludes Windows systems.

o If both options are selected, all systems associated to the Domain Linked Account are shown.

+ Associate with Smart Group: The application is associated with a managed system Smart Group. Select a Smart Group
from the dropdown list. The application is only associated with linked systems that belong to the selected Smart Group and
are linked to the account.

9. Enable Autolt Passthrough to automatically pass the credentials for the application through an RDP virtual channel. Using
Autolt Passthrough provides a secure way to access applications through a remote session. The user requesting the session is
not required to enter the application credentials.

10. Enable Launch Application in RemoteApp mode to initiate a remote app session rather than a full desktop session. This limits
use to the specified app and the user is presented with an application window. This setting is defined per application.

11. Select Active to make the application available for remote sessions.
12. Click Create Application.

To edit an application:

1. Navigate to the application and then click the vertical ellipsis to the right of the application.
2. Select Edit Application.
3. Make the necessary changes and then click Save Changes.

To view advanced application details from the Edit Application pane, click View Advanced Details.

1 For more information, please see the following:

» Onusing the PS_Automate Utility, "Use the PS_Automate Ulility" on page 118
o Forthe prerequisites for Autolt Passthrough, "Use Autolt Passthrough" on page 119

View Application Details

Once an application has been created, you can view advanced application details by following these steps:
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1. Select Configuration > Privileged Access Management > Applications.
2. Click the vertical ellipsis to the right of the application.
3. Select Go To Advanced Details. Under Advanced Details, you can select:
« Details & Attributes - This displays a read-only grid containing application information.

+ Managed Accounts - This displays a read-only grid listing managed accounts that are linked to the application.

You can edit application details or delete the application using the Edit and Delete icons, located in the upper-right of the Advanced
Details page.

Use Encryption Module for RemoteApp

The Encrypted Module for RemoteApp is an application which is automatically enabled to hide sensitive information from the terminal
service logs.

To use this encryption, the managed system must be configured with a functional account which is also an administrator on the server the
user is connecting to.

Associate the Application with a Managed Account

Now that the application is configured, the application must be associated with a managed account.

In the console, click Managed Accounts.
On the Managed Accounts page, click the vertical ellipsis for the managed account, and then select Edit Account.
In the Edit Managed Account pane, scroll down to Applications and click + to expand the Applications section.

Ll .

From the drop-down list, select the applications, and then click Update Account.

You can select the application by editing the managed account. For more information about managed accounts settings,
please see "Add a Managed System Manually"” on page 17.

Set Up the Access Policy

You can create an access policy or use an existing policy. The access policy is part of the Requester role setup, described in the next
section.

x Note: Application access policies apply to all applications.

1. Select Configuration > Privileged Access Management Policies > Access Policies.

2. Create a new access policy and schedule or edit an existing access policy and schedule. Within the schedule settings, enable
Application, under Policy Types, and save the access policy.

For more information on creating and editing access policies and schedules, please see "Configure Password Safe Access
Policies" on page 70.
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Set Up Role-Based Access

Users who need to access an application must be managed accounts that are members of a group.

x Note: Access to applications is also available to admins and ISA users, without the need to configure an access policy.

The Requester role and application access are assigned as part of creating the user group.

Use the PS_Automate Utility

Overview

The Password Safe PS_Automate utility helps to avoid the need to manually enter credentials when launching Windows GUI applications
from Password Safe, saving time and increasing security.

The PS_Automate utility allows you to seamlessly pass vaulted credentials from Password Safe to a remote application using the pass
through option (using token pass instead of credentials). This includes the ability to launch and authenticate to a web page or to a standard
Windows GUI application.

To ensure a seamless experience, the utility supports Incognito mode for popular web browsers, such as Chrome, Firefox, and Microsoft
Edge, with Edge being the default. By using an INI file, you can easily specify the input and operational behavior for the utility.

The PS_Automate utility, as well as INI files for Amazon Web Services, Azure, Office 365, and Google, are made available when
enhanced session auditing is enabled in Password Safe. The files are deployed by the session proxy when a session is created in
Password Safe.

The system where the PS_Automate utility is deployed must have internet access, in order to automatically download the latest version of
the required browser drivers on first use:

e chromedriver.exe
« msedgedriver.exe

» geckodriver.exe

The utility uses the browser drivers, and the versions of the drivers must match the versions of the browsers used.

x Note: PS_Automate is a utility for Windows only. It is not supported on macOS.

Usage

The usage syntax for the PS_Automate utility is as follows:

Web Applications

ps_automate.exe [ini=path to inifile][TargetURL=url] [BrowserName=name of browser]
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Windows Applications

ps_automate.exe [ini=path to inifile]

x Note: For testing purposes the utility also accepts username and password on the command line: [username=username]
[password=password]. However, this is not recommended for production use, as command line parameters can be written
to Windows logs, such as the event log.

p Example:

ps_automate.exe ini="BIWebApp.ini"
TargetURL="https://localhost/WebConsole/index.html#!/dashboard" BrowserName="chrome"

ps_automate.exe ini= "C:\automate\AWSWebApp.ini"
TargetURL="https://534949981440.signin.aws.amazon.com/console/" BrowserName="firefox"

ps_automate.exe ini="MSWebApp.ini"
TargetURL="https://login.microsoftonline.com"BrowserName="msedge"

ps_automate.exe ini="ssms database.ini"

For more information on defining the command line arguments in the INI file used by PS_Automate, please see Define
Command Line Arguments in INI File at https://www.beyond(trust.com/docs/beyondinsight-password-safe/ps/integrations/ps-
automate/command-line-arguments.htm.

Use Autolt Passthrough

The following prerequisites must be in place before you can use the Autolt Passthrough feature:

« The application must be launched through an Autolt script.

o The wrapper Autolt script must call the Password Safe Passthrough library through pspassthru.dll (provided as part of the
Password Safe Resource Kit).

i For information about turning on the feature, please see "Add an Application" on page 114.

Autolt Script Details

The Autolt example script uses the following functions:
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o pspassthru.dil
* ps_get_credentials
o DLLCall: An Autolt function. The first argument takes in the location of the DLL file to call.

P Example: Here the pspassthru.dll is located in the same directory as the Autolt script.

Func get credentials (Stoken)
Local SaResult = DLLCall ("pspassthru.dll", "str:cdecl", "pbps get
credentials", "str", Stoken, "bool", 0)

Local Scredentials = StringSplit ($aResult[0], "™ ")
return $credentials
Endfunc

ps_get_credentials Function

char* ps get credentials(char* token, bool respond with json)

Parameters

char* token: A one-time use token provided by Password Safe as the last command line argument passed to the Autolt script.

bool respond_with_json: A flag to toggle the format of credentials. When this value is True, the credentials are in JSON format.
Otherwise, they are in a white-space delimited list.

Return Value

The token is sent to Password Safe to be validated.

« Ifthe token is valid for the current session and has not been used, the return value is a string with credentials in the desired format.
« Ifthe token is invalid or has been used, the return value is NULL.

Tokens are validated and credentials are sent over an encrypted RDP virtual channel not visible to the end user.

Add SAP as a Managed System

You can add your SAP environment to Password Safe management.

Password Safe supports SAP NetWeaver.

Requirements

o Instance Number: When adding the system to Password Safe you must know the SAP instance number.
o Client ID: An ID that is unique to the SAP instance.

x Note: The instance number and client ID are provided in an email when you purchase SAP.
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+ SAP permissions: The Password Safe functional account requires RFC privileges.

SAP RFC privileges are needed for password changes. RFC permissions assigned to the functional account permit the password
change. However, the password cannot be tested.

If an account has RFC privileges, that account can change their password and others. It can also test its own password.

o The username and password in Password Safe must be the same as in SAP.

Set Up the Functional Account

The functional account requires the Client ID. All other settings are the typical functional account settings.

1 For more information on creating a functional account, please see "Create a Functional Account” on page 16.

Add SAP

You must add SAP manually. You cannot add SAP using a Smart Rule.

In the console, click Assets.
Select the asset where the SAP instance resides, and then select Add to Password Safe.
Select SAP from the Platform list.

Enter the instance number.

o & b=

All other settings are the typical managed system settings.

1 For more information on adding Managed Systems, please see "Add a Managed System Manually" on page 17.
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Configure API Registration

Administrators can configure two types of API registrations in BeyondInsight, allowing you to integrate part of the BeyondInsight and
Password Safe functionality into your applications. One method uses an API key and the second method uses an Open Authorization
(OAuth) authentication access policy for application users. Setting up each type of registration is detailed in the below sections.

Add an API Key Policy API Registration

To create an API key policy API registration:

Go to Configuration > General > APl Registrations.
Click Create API Registration.

Select APl Key Policy from the dropdown list. The Details screen New A7l Regisration 2 Detalls | Creste New Authentication Rule >
is displayed. Fill out the new APl registration details, as detailed i
below: “

o Select the Authentication Rule Options you wish to
enable:

o Enforce multi-factor authentication: This setting
is enabled by default. When enabled, requires users °
to abide by multi-factor authentication settings i e ©
configured for Password Safe. Disabling this setting
bypasses multi-factor authentication when
accessing user accounts through API. This allows
applications integrated with Password Safe using an
API key to abide by multi-factor authentication
settings configured for the application, as opposed
to using the Password Safe settings.

Shoning o0 Authentcation s

PSRUN Rules

o Client Certificate Required: When enabled, a
client certificate is required with the web request,
and if not enabled, client certificates are ignored and do not need to be present. A valid client certificate is any client
certificate that is signed by a Certificate Authority trusted by the server on which BeyondInsight resides.

o User Password Required: When enabled, an additional Authorization header value containing the RunAs user
password is required with the web request. If not enabled, this header value does not need to be present and is
ignored if provided.

Square brackets surround the password in the header. For example, the Authorization header might look like:

Authorization=PS-Auth key=c479a66f..c9484d; runas=doe-main\johndoe; pwd=[unlqu3];

o Verify PSRUN Signature: The PSRUN signature is an extra level of authentication. It's computed from the factors
using a shared secret between the client and server. PSRUN sends the signature as part of the header during its
APl request. If enabled, the server recomputes the signature during factor validation and compares it against the
one sent by the client. If the signatures match, the client’s identity is considered verified. The signature effectively
keeps the client in sync with the server. Changing the secret on the server requires the client to be rebuilt and
guarantees that out-of-date clients cannot authenticate.
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« An authentication rule must be included. Click Add Authentication Rule.

o Atleastone IP rule or PSRUN rule is required, providing a valid source IP address (IPv4 or IPv6), an IP range, or
CIDR from which requests can be sent for this APl key (one IP address, IP range, or CIDR per line).

o X-Forwarded-For rules can also be created, providing a valid source IP address (IPv4 or IPv6), an IP range, or
CIDR from which requests can be sent for this API key. In a load-balanced scenario, IP authentication rules are
used to validate the load balancer IPs, and the X-Forwarded-For header is used to validate the originating client IP.
Existing rules cannot be changed from an IP rule to a X-Forwarded-For rule, or vice versa.

o Ifan X-Forwarded-For rule is configured, it is required on the HTTP request (only a single header is allowed on the
request). If the X-Forwarded-For header is missing, the request fails with a 401 Unauthorized error.

o Click Create Rule.

4. Click Create Registration.

BeyondInsight generates a unique identifier (API key) that the calling application provides in the Authorization header of the web request.
The APl key is masked and can be shown in plain text by clicking the Show Key icon next to the Key field. The APl key can also be
manually rotated, or changed, by clicking the circular arrow.

Note: Once the key has been changed, any script using the old key receives a "401 Unauthorized" error until the new key is
used in its place. Read access and rotation of the key is audited.

Add OAuth Authentication for APl Access for Application Users

OAuth is an open standard protocol that allows users to grant limited access to their resources on one website or application to another
website or application without sharing their credentials, such as username or password. By enhancing Password Safe authentication to
support OAuth, Password Safe application users can benefit from improved overall security and the ease of integration that this feature
provides.

OAuth uses access tokens, which are short-lived secrets that grant access to specific resources or APIs on behalf of the application user.
Users can revoke access to Password Safe for any connected application or service. This provides more robust control over access to
sensitive information.

Application users are a user type that represent applications that interface with the public API. These users can’t log in to the web console.
They can only authenticate and interact with the public API and they can only authenticate using the OAuth client credential flow for the
public API. When creating an application user you must provide an API registration of the type APl Access Policy, which is specifically
used for application users. This API registration is used for processing IP rules instead of the API Key Policy registrations typically
assigned to user groups.

Configure API Access Policy Registration

The API Access Policy registration is used specifically for OAuth. To create this in the BeyondInsight console:

Go to Configuration > General > API Registrations.
Click Create API Registration.
Select APl Access Policy from the dropdown list. The Details screen is displayed.

L h =

Fill out the new API registration details, including the Access Token Duration. This field determines how long the OAuth token
stays active.

5. Click Add Authentication Rule, enter the required information, and then click Create Rule.
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Add an Application User

Application users represent applications that interface with the BeyondInsight public API. Application users cannot log in to the
BeyondInsight console. They can only authenticate and interact with the public API, using Client ID and Client Secret for credentials within
the OAuth client credential flow.

An API Registration type of APl Access Policy must be assigned to an application user, and is used for processing IP rules. To create an
application user:

Go to Configuration > Role Based Access > User Management > Users.

Click Create New User.

Select Add an Application User from the dropdown list. The Create New Application User screen is displayed.

Add a username.

Under API Access Policy, select the policy.

Copy the information from the Client ID and Client Secret fields for later use.

Click Create User.

© NN

Assign the user to a group that has the required permissions to access Beyondinsight and Password Safe features.
o Click the vertical ellipsis for the user, and then select View User Details.
o From the User Details pane, click Groups.
« Locate the group, select it, and click Assign Group above the grid.

Recycle the Client Secret for an Application User

When editing an application user, you have an option to recycle their secret. Once recycled, you can copy or view the new secret. When a
secret is recycled and the user account is updated with this change, the previous client secret is no longer valid.

To recycle the secret for an application user:

Go to Configuration > Role Based Access > User Management > Users.
Locate the application user in the grid.

Click the ellipsis to the right of the user, and then select Edit User Details.
Click the Recycle icon to the right of the Client Secret.

Click Recycle on the confirmation message that displays.

Copy the new secret for later use.

Click Update User.

No o~ eDdhd-=

View and Update OAuth Secret Expiry

The user's secret will eventually expire. The Users grid has an OAuth Secret Expiry column, which you can use to view what is close to
expiring. The default duration of a client secret is 365 days. You can adjust the lifetime of the secret from the Authentication Options
configuration area in BeyondInsight. Updating this value only changes the secret expiry date for new application users and recycled client
secrets. Older secrets cannot be updated.

To view the OAuth Secret Expiry for an application user:

1. Goto Configuration > Role Based Access > User Management > Users.
2. Locate the application user. The OAuth Secret Expiry column lists the date and time that a client secret for that user expires.
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To update the duration for client secrets:

1. Go to Configuration > Authentication Management > Authentication Options.

2. Under Application User Authentication Settings, enter the new duration of the client secret in the Client Secret Expiry field.
3. Click Update Application User Authentications Settings.

i For more information, please see the following:

« For more detailed information on API Registrations using the Auth/SignAppln API function, the Beyondinsight and
Password Safe API Guide at https.://www.beyondtrust.com/docs/beyondinsight-password-
safe/ps/api/authentication.htm

o Forinformation on how to grant APl access to Beyondinsight users, "Configure Role Based Access" on page 56
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Add a Custom Platform

On the Custom Platforms page, you can add SSH and Telnet platforms, as well as SSH application platforms, tailored to your
environment. Password Safe contains several built-in SSH and Telnet platforms designed for the most common configurations, such as
Linux, Solaris, and Cisco. You can modify the details of built-in custom platforms to meet the needs of your environment. You can create
new custom platforms for advanced configurations that are not supported by the built-in platforms, or for a platform that is currently not
supported by Password Safe. You can also create new custom platforms by cloning a built-in or user-created custom platform.

All custom platforms work in the same way: by connecting to a remote SSH or Telnet server and waiting for a response. Once a response
is received, a regular expression is evaluated against the response and the platform replies with a command that starts the process of
changing a password on the relevant system.

Create a New Platform

1. Inthe Beyondinsight Console, go to Configuration > Privileged Access Management > Custom Platforms.
2. Inthe Custom Platforms pane, click Create New Custom

Platform, and then select Create New Platform. Beyondinsight =~ Configuration
lal BeyondTrust > Privileged Access Management > Custom Platforms
Alternatively, click the vertical ellipsis button for a platform in the list,
and then select Clone to clone an existing platform and modify its CUSTOM PLATFORMS < AXDetails
settings as desired. Q“ Options | Steps  CheckiChange Password

Platform Name

@ Create New Custom Platform & CoAx

¢ Platform ID
© Create New Platform

@ AIX
Built-in
@ BIG-IP (FS

Built-in

Platform Type
@ Create New Application Platform Built-in

° Cassandi & Import Platform (XML) Acive @

User Creat(

Checkpoint . O Enable Login Account
@ i :

@ Cisco : O Eenable Account Name Format
Built-in :

@ Cisco Secret

3 Communications Protocol
Built-in Options

© Cisco WLC . QO Telnet @ ssH
Built-in -

@ CloneofAx
User Created €2 Clone 2

@ Clone of Axagain
User Created & Export e

Delet
@ Delete Discard Changes

@ Clone of Clone of AXagain
User ite

o)) DRAC

3. Configure the settings on the Options, Steps, and Check/Change Password tabs as detailed in the following sections.

Configure the Options Tab

+ Platform Name: Enter a name for the custom platform. The given name appears in the Platform lists throughout BeyondInsight
and Password Safe and must be unique. Platform names cannot be changed after they have been created.

o Platform ID and Platform Type are assigned by the system and cannot be entered or edited.
« Active: Check this option to make the platform active in BeyondInsight and Password Safe.

« Enable Login Account: Check this option to display the Use Login Account for SSH Sessions option under the Credentials
section in the settings for a managed system. Use this feature when an account other than the functional account is used to log in
to the managed system.
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« Enable Account Name Format: Check this option to display the Account Name Format dropdown under the Credentials
section in the settings for a managed system.

« Communications Protocol: Indicate if the custom platform uses Telnet or SSH.
o Port: Use the default port of 22 for SSH or 23 for Telnet. Optionally, enter a port to test the settings.
« Template Fields and Scripting:

o Prompt regex: Regular expression that evaluates to the shell prompt of the remote system; for example, ~ 1#.

o Config prompt regexand Elevated prompt regex: These two regular expressions are mainly meant for network
appliances that have multiple prompts, depending on a mode.

o End of line: The end of line field specifies how the platform indicates to the SSH or Telnet server that it is sending a
command. The default is the carriage return character (\r).

o Exit Command: Leave the default command as exit, or specify a new command for the platform to exit SSH or Telnet.
o Password command: Enter the command to change the password.

+ Enable Account Elevation: Check this option, if you want to select an Elevation Command.

« Elevation Command: Select an elevation command from the list to enable the option to elevate the functional account
permissions on a managed system. The following elevation command types are supported:

o sudo

o pbrun

° pmrun

o pbrun jumphost

« Enable Jump Host: If you use the elevation command pbrun jumphost, you can configure the Privilege Management for Unix &
Linux policy server host name to connect to. Check this option to enable the jump host, and then enter the policy server host name
details when configuring the Check Password options on the Check/Change Password tab.

« Enable Cisco Enable Password: Check this option to display the Change Enable Password option on the Functional
Account tab under Advanced Details for a Cisco managed system.

Configure the Steps Tab

From the Steps tab, define the responses that you expect from the server and the replies the platform sends. The options include two
groups: After Login and Error Handling.

1. Onthe Steps tab, select the Step Type from the list. The template New Custom Platform Detais
for expect statements changes depending on which of the following ‘
types is chosen:

« Change Password: Manually changes the password for
the custom platform.

o Check Password: Tests the password by attempting a - men oo
logon. PS—

fnshwihsuce. v <<exteommand>:

+ Replace Public Key: Runs a script to replace the public
key.

2. Use the default statement group to start the custom platform.
Additional statements and statement groups can be created as
required.

« To create a new statement, click Add New Statement + at
the bottom of an existing statement group.
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« Todelete a statement, click the X at the right end of the Expect statement line.

« To create a new statement group, click Add New Statement Group + at the bottom of the last statement group.

« Todelete a statement group, click the X and the right end of the statement group name.

« To edit the name of the statement group, hover the cursor over the group name, click in the field, and then enter the name.

3. Enter an Expect statement. There are two ways to populate the Expect field:

« Type text or a regular expression in the field.
« Use atemplate field variable: Click in the field, enter <<, and then select a template from the list.

4. Enter a Response statement. There are two ways to populate the Response field:

o Type text or a regular expression in the field.
« Use a template field variable. Click in the field, enter <<, and then select a template from the list.
5. The Response type can be changed by selecting an option from the Send Response dropdown list. If goto is selected you need
to select a statement group from the resulting list.

6. Error Handling is enabled by default. Uncheck this option if error handling is not required. If error handling is required, ensure an
error message is entered in the Expect statement for Error handling.

7. The order of statement processing can be changed by clicking the Up or Down icons at the left of each Expect statement.

The following is an explanation of the functionality for each setting on the Steps tab, using a Linux platform as an example:

o Error Handling: The error handling check ensures that when the statement comes in, all of the statements in the error handling
section are evaluated first, before Enter your reason for login. For example, when the platform connects to the remote SSH
server, the SSH server replies with:

Welcome to Linux Mint

* Documentation: http://www.linuxmint.com

Last login: Mon Apr 13 10:45:51 2015 from dev-machine
Enter your reason for login:

The platform tries try to find a match, in the following order:

BADCOMMAND

- Usage:

BAD PASSWORD

Enter your reason for login:
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New Custom Platform Details

If a match is found for Enter your reason login, the platform

replies with changing password. The platform expects the SSH CHECKICHANGE PASSHORD
server to send back the shell prompt and the platform replies with s et e S
passwd <<manacctname>>.
When the platform communicates with the remote server, it Statements
replaces the tags with data. In the image shown, e D 9 e < s r e oo
<<manacctname>> is replaced by the managed account
associated with the platform. These are template field variables that e ke
are inserted into the Expect box and Response box. If you have a © e B ©
prompt defined in the options tab as ~] $, the platform converts the “"M e
tag <<prompt>> to this value when it evaluates the regular R o
expressions. B
Error Handling
« Expect Statement: \We recommend that you include the prompt in S °
the regex of the Expect field to ensure the platform waits until all the e —
data from the previous command is read from the target system voranaing
before proceding to the next statement. + © Expert Retype new UNK pasord )
The final Expect statement says expect all authentication tokens Zpdg o
updated successfully and the response statement is finish with o e e e e sy °
success. When you create a custom platform, you must be able to i sic. .
detect when a password has been successfully changed on the
remote server. When you have detected this event, you must set Addew stement ©
the Action dropdown to finish with success.

« Goto statements: The flow jumps to the group specified by the goto statement. Flow does not return to the original group. If a
group is to be used as a goto, it should be designed such that the intended task of the platform is completed there.

Configure the Check/Change Password Tab

Once you complete the fields on the Check/Change Password tab, Password Safe runs the credentials. Log in to the host using the
managed account name and follow through the configurations provided on the Steps tab.
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1. Select the Host from the dropdown. New Custom Platform Details

2. Ifyou use the elevated credential pbrun jumphost, enter the IP
address for the PBUL policy server in the Jumphost field. ’ s —"

Change password v
Manage steps.

f Note: Ensure the Enable Jump Host box is checked on the
Options tab. Otherwise, the Jumphost field is not displayed on
the Check/Change Password tab. 8 =

Functional Account Credentials

3. Use the default port for SSH or Telnet. Optionally, enter a port to .
test the settings.

Provide the details for the Functional Account Credentials.

In the Elevation Command field, enter an elevated account such
as sudo or sudoer to elevate the functional account permissions.

Provide Managed Account Credentials and a new password.

(0 Use Mansged Account to Change Passiord Dissblec)

Click Change Password or Check Password, as applicable.

When the test returns a successful connection, go to the Options
tab, check the Active box, and then click Create Platform.

CHANGE PASSWORD

Change Password Results

Results for

CREATEPLATFORM | DISCARD
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Create a New Application Platform

Custom application platforms leverage the custom platform functionality, with the added capability of providing an intermediary target
(application host) for the custom platform using a script-based approach to managing accounts on application servers specific or
customized to your environment.

x Note: Custom application platforms only support SSH; Telnet is not supported.

Prior to creating a new application platform, you must configure a managed

system to be an application host by enabling the Allow Managed System Create New Managed System >
to be an Application Host setting in its properties. The application host is -
the managed system where the scripts for the application are run. :;ﬁiWIvPE
Sel -
x Note: Once a managed system is configured as an application :'i";""“ .

host, other managed systems can be configured to use it, as
indicated by the Associated Managed Systems indicator. You
cannot disable the Allow Managed System to be an
Application Host setting if other managed systems are currently
configured to use this application host.

B Collapse All | Expand All

Identification (3

Name

Description

DNS Name

IP Address

Associated Managed Systems: 0

Warkgroup -

To create the new application platform, follow the following steps:

1. Inthe Beyondlnsight Console, go to Configuration > Privileged Access Management > Custom Platforms.
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2.

In the Custom Platforms pane, click Create New Custom
Platform, and then select Create New Application Platform.

PASSWORD SAFE CLOUD 24.1
ADMIN GUIDE

CUSTOM PLATFORMS

Q Search Custom Platforms

Create New Custom Platform o

sha @ Create New Platform

AlX (Active)
Built-in

© Create New Application Platform

@ BIGHP (F5) (A

Built-in oL, Import Platform (XML)

(@ Cassandra CAP Test (Active) .

3. Configure the settings on the Options, Steps, and Check/Change Password tabs as detailed in the following sections.

Configure the Options Tab

Platform Name: Enter a name for the custom platform. The given
name appears in the Platform lists throughout Beyondinsight and
Password Safe and must be unique. Platform names cannot be
changed after they have been created.

Platform ID and Platform Type are assigned by the system and
cannot be entered or edited.

New Custom Application Platform Details

OPTIONS

Platform Name

ot o
. . . . . New Custom Application Platform
Active: Check this option to make the platform active in P
. Platform names cannot be changed after they have been created.
BeyondInsight and Password Safe.
Enable Login Account: Check this option to display the Use Plesform D
Login Account for SSH Sessions option under the Credentials Platform Type  User Created
section in the settings for a managed system. Use this feature when
an account other than the functional account is used to log in to the Adive ©
managed system.
Enable Account Name Format: Check this option to display the Enable Login Account
Account Name Format dropdown under the Credentials section Enable Account Name Eormat
in the settings for a managed system.
Enable Account Elevation: Check this option if you want to select Enable Account Elevation
an Elevation Command.
B . . Elevation Command

Elevation Command: Select an elevation command from the list to sudo -
enable the option to elevate the functional account permissions on a
managed system. The following elevation command types are
supported:

o sudo

o pbrun

°© pmrun
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Configure the StepsTab

The Steps tab is configured in the same way as it is for all custom platforms. However, for application platforms there are 6 additional
fields available for Expect statements, as follows:

o Address

+ App Host Functional Account Keypass
« App Host Functional Account Key

+ App Host Functional Account Name

« App Host Functional Account Password
+ Port

Configure the Check/Change Password Tab

The Check/Change Password tab is configured in the same way as it is for e Cotom ApptcatonFatorm Detts
all custom platforms; however, you must also select an Application Host.

Manage steps.
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Once your custom application platform has been created, you can

) . L Create New Managed System
configure a managed system to use it by selecting it from the Platform g y >
dropdown. Also select the Application Host for this manged system. When Entity Type ~
Password Safe rotates or checks a password for an account that exists on Asset M
this managed system, it connects to the application host and then runs the
t defined on the Steps tab for this custom application platform peem
.S eps as P pp p New Custom Application Platform v
instance.
& Collapse Al | Expand All
Identification (&
Name
Port
8 =2
Description
DNS Name
1P Address
Application Host
AIX -
Workgroup -
Automatic Password Change Options
v
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Export or Import a Custom Platform

Export a Custom Platform

Exporting a custom platform can assist you with troubleshooting.

1. Inthe Beyondlnsight Console, go to Configuration > Privileged Access Management > Custom Platforms.
2. Click the Actions (vertical ellipsis) button for the platform you wish to export, and then select Export.
3. Save the XML file.

Import a Custom Platform or Application Platform

In the BeyondInsight Console, go to Configuration > Privileged Access Management > Custom Platforms.
In the Custom Platforms pane, click Create New Custom Platform.
Select Import Platform (XML).

Locate and select the exported platform file. If the platform currently exists, it modifies the existing platform. If the platform does not
currently exist, a new custom platform is added.

Bwnh o=

P Example: Linux Platform

In this short synopsis of the Linux platform, you can see how it works by expecting data and responding to the data based on
the evaluation of regular expressions. It examines the output of each command to determine if an error occurred or if it can
continue sending replies to the server.
Platform establishes a connection to the remote SSH server with the provided credentials.
2. SSH server replies with:

Welcome to Linux Mint

* Documentation: http://www.linuxmint.com

Last login: Mon Apr 13 10:45:51 2015 from dev-machine
dev@dev-machine ~ ]#

3. The platform evaluates a regular expression, looking for the shell prompt "~J#", and replies with the passwd command
for the specified managed account.

passwd managedaccount complexpassword

4. Ifthe arguments passed to the passwd command are valid, the server replies with:

Enter new Unix Password:

5. The platform waits for the server’s response and evaluates a regular expression, looking for Enter new Unix
Password.

6. Ifthe response is not Enter new Unix Password, the platform waits for other possible responses such as User does not
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P exist.

7. Ifthe regular expression evaluates to true, the platform exits with an error.
8. Ifthe regular expression Enter new Unix Password evaluates to true, the platform replies with the new password.
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Configure SSH and RDP Proxy Connections

In the Password Safe web portal, requesters can request access to use SSH or RDP remote connections. To permit remote connections,
you must configure an access policy.

i For information on access policies, see "Configure Password Safe Access Policies” on page 70.

The following section provides additional information on setting up SSH or RDP connections.

x Note: All registry changes must be done on each machine hosting a resource broker.

Host Key Algorithms

Below is a list of host key algorithms enabled for use by Password Safe's SSH client and server. Supported algorithms in default order of
preference are:

o ecdsa-sha2-nistp256

» ecdsa-sha2-nistp384

o ecdsa-sha2-nistp521

e ssh-ed25519

e rsa-sha2-512

e rsa-sha2-256

» ssh-rsa (disabled by default)

« ssh-dss (disabled by default)

Use the following registry key to change the available client host key algorithms:

HKEY_LOCAL_MACHINE\SOFTWARE\BeyondTrust\PBPS\SessionManager\ssh_proxy\client_host_key_algorithms (REG_
MULTI_SZ)

Use the following registry key to change the available server host key algorithms:

HKEY_LOCAL_MACHINE\SOFTWARE\BeyondTrust\PBPS\SessionManager\ssh_proxy\host_key_algorithms (REG_MULTI_SZ)

KEX Algorithms

Below is a list of key exchange (KEX) algorithms enabled for use by Password Safe's SSH client and server. Supported algorithms in
default order of preference are:

o curve25519-sha256

o ecdh-sha2-nistp256

o ecdh-sha2-nistp384

o ecdh-sha2-nistp521

« diffie-hellman-group-exchange-sha256

« diffie-hellman-group16-sha512

« diffie-hellman-group18-sha512
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« diffie-hellman-group14-sha256

« diffie-hellman-group14-sha1 (disabled by default for incoming client connections only)
« diffie-hellman-group-exchange-sha1 (disabled by default)

« diffie-hellman-group1-sha1 (disabled by default)

Use the following registry key to change the available key exchange algorithms for the client side of Password Safe's SSH proxy (between
the proxy and the managed systems):

HKEY_LOCAL_MACHINE\SOFTWARE\BeyondTrust\PBPS\SessionManager\ssh_proxy\kex_algorithms (REG_MULTI_SZ)

Use the following registry key to change the available key exchange algorithms for the server side of Password Safe's SSH proxy
(between the user's SSH client and the proxy):

HKEY_LOCAL_MACHINE\SOFTWARE\BeyondTrust\PBPS\SessionManager\ssh_proxy\client_kex_algorithms (REG_MULTI_
SZ)

MAC Algorithms

Below is a list of message authentication code (MAC) algorithms enabled for use by Password Safe's SSH client and server. Supported
algorithms in default order of preference are:

e hmac-sha2-256

* hmac-sha2-512

e hmac-sha1

« hmac-sha1-96 (disabled by default)

+ hmac-md>5 (disabled by default; not supported in FIPS mode)

Use the following registry key to change the available mac client host key algorithms:
HKEY_LOCAL_MACHINE\SOFTWARE\BeyondTrust\PBPS\SessionManager\ssh_proxy\client_macs (REG_MULTI_SZ)
Use the following registry key to change the available mac server host key algorithms:
HKEY_LOCAL_MACHINE\SOFTWARE\BeyondTrust\PBPS\SessionManager\ssh_proxy\macs (REG_MULTI_SZ)

When Password Safe is running in FIPS mode, every supported MAC algorithm is enabled by default.

Ciphers

Below is a list of ciphers enabled for use by Password Safe's SSH client and server. Supported ciphers in default order of preference are:

e aes256-ctr

o aes192-ctr

e aes128-ctr

o aes256-cbc (disabled by default)

» aes192-cbc (disabled by default)

« aes128-cbc (disabled by default)

» blowfish-cbc (disabled by default; not supported in FIPS mode)
« 3des-cbc (disabled by default)

Use the following registry key to change the available client cipher algorithms:
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HKEY_LOCAL_MACHINE\SOFTWARE\BeyondTrust\PBPS\SessionManager\ssh_proxy\client_ciphers (REG_MULTI_SZ)
Use the following registry key to change the server cipher algorithms:
HKEY_LOCAL_MACHINE\SOFTWARE\BeyondTrust\PBPS\SessionManager\ssh_proxy\ciphers (REG_MULTI_SZ)

When Password Safe is running in FIPS mode, every supported cipher is enabled by default.

RSA Host Key Size

You can configure the size (in bits) of the RSA private host key generated and used by Password Safe's SSH server.

Use the following registry key to change the host key size:
HKEY_LOCAL_MACHINE\SOFTWARE\BeyondTrust\PBPS\SessionManager\ssh_proxy\rsa_host_key_size (REG_DWORD)
Valid values are: 2048 (default), 3072, and 4096.

Auto-Launch PuTTY Registry File

To launch the SSH client automatically, the SSH protocol must be associated with an application. To register an application, such as
PuTTY, which is used in the example below, change the references to PuTTY to point to the application.

Windows Registry Editor Version 5.00

[HKEY CLASSES_ROOT\ssh]

@="URL:Secure Shell Protocol"

"URL Protocol"=""

[HKEY CLASSES ROOT\ssh\DefaultIcon]
="%%ProgramFiles%$\\PuTTY\\putty.exe"

[HKEY CLASSES ROOT\ssh\shell]

[HKEY CLASSES ROOT\ssh\shell\open]

[HKEY CLASSES ROOT\ssh\shell\open\command]

@="cmd /V:ON /s /c Recho off && set url=%1 && for /f \"tokens=1,2,3 delims=:/ \" %%a in
(\"'!'url!\") do set protocol=%%a&set host=%%b&set port=%%c && start \"\"
\"$%ProgramFiles$$\\PuTTY\\putty.exe\" -P !port! !host!"

Supported SSH Session Protocols

You can use the following protocols with an SSH session: X11, SCP, and SFTP. You also have options to allow local and remote port
forwarding.

Note: When transferring files using SCP, there may be some incompatibilities with specific clients (e.g. WinSCP). We
recommend using SFTP or a different client.

Use the Registry Editor to turn these settings on. These settings are all type DWORD with toggle values of either 0 (no) or 1 (yes).
o X11:

HKEY_LOCAL_MACHINE\SOFTWARE\BeyondTrust\PBPS\SessionManager\ssh_proxy\allow_x11 = 1(DWORD)

« SCP:
HKEY_LOCAL_MACHINE\SOFTWARE\BeyondTrust\PBPS\SessionManager\ssh_proxy\allow_scp
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« SFTP:
HKEY_LOCAL_MACHINE\SOFTWARE\BeyondTrust\PBPS\SessionManager\ssh_proxy\allow_sftp

+ Local Port Forwarding: Whether or not to allow local port forwarding requests from the user's SSH client through to the managed
system (default: 0)
HKEY_LOCAL_MACHINE\SOFTWARE\BeyondTrust\PBPS\SessionManager\ssh_proxy\allow_local_port_forwarding

+ Remote Port Forwarding: Whether or not to allow remote port forwarding requests from the user's SSH client through to the

managed system (default: 0).

HKEY_LOCAL_MACHINE\SOFTWARE\BeyondTrust\PBPS\SessionManager\ssh_proxy\allow_remote_port_forwarding

i For more information, please see Issues with WinSCP Using SCP Mode at https.//beyondtrustcorp.service-now.com.

Multiple SSH Sessions

To avoid a potential security risk, more than one SSH session is not permitted through a single SSH connection.
You can turn on the following registry key to permit more than one session on a connection:

HKEY_LOCAL_MACHINE\SOFTWARE\Beyondtrust\PBPS\SessionManager\ssh_proxy\allow_multiplex = 1

Enable Login Accounts for SSH Sessions

Creating a login account allows the user to open an SSH session in environments where remote shell access is not permitted, for
instance, the root account. A login account will be used to establish the initial shell connection and then switch the session to the managed
account.

Note: The functional account used should be a low privilege user and not the same elevated functional account that has
elevated privileges to change passwords.

This feature supports the following platforms: AIX, HPUX, Linux, and Solaris.

Enable Login Accounts Manually

To manually enable login accounts, you must enable the function on both the managed system and the managed account you want to use
for the SSH session.

From the Managed Systems page, create a new managed system, or select one from the grid.
From the menu actions, select Edit Managed System.

Within the Credentials section, toggle the User Login Account for SSH Sessions option to yes.
Select your account from the Login Account dropdown.

Click Update Managed System and dismiss the configuration slide-out.

From the Managed System menu, select Go to advance details.

Select the Managed Accounts tab.

© N oGk wNd =

Select the managed account you wish to edit.
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9. Within the Credentials section, toggle the Login Account for SSH Sessions option to yes.
10. Click Update Account.

Enable Login Accounts with a Smart Rule

For organizations managing many assets and accounts, administrators can enable login accounts with a Smart Rule as follows:

Create a Smart Rule to manage the assets to use to access the SSH session.

Select the action Manage Assets using Password Safe.

Select the platform and the functional account.

From the Enable Login Account for SSH Session list, select yes.

Select a login account.

Create a Smart Rule to manage the managed accounts to allow users to log in for an SSH session.
In the Actions section, select Managed Account Settings.

© N o g RN

Scroll to Account Options and select Enable Login Account for SSH Sessions.

Use Direct Connect for SSH and RDP Session Requests
You can use Direct Connect for remote session requests for SSH and RDP sessions. Direct Connect requests access to a managed
account on behalf of the requester. The requester accesses the system without ever viewing the managed account's credentials.

If the requester is not granted auto-approval for a session, the user receives a message stating Request requires approval. If the request
is not approved within 5 minutes this connection will close. After 5 minutes the client disconnects and the user can send another
connection request. When the request is approved, the user is automatically connected.

When there is an existing request for the system and account, the request is reused and the session created.

SSH Session Requests

Using an SSH client, a user can use the Password Safe Request and Approval system for SSH remote connections. The requester's
information, including the Reason and the Request Duration, are auto-populated with default Password Safe settings.

To access a managed account or application using Direct Connect, the requester has to connect to Password Safe's SSH Proxy using a
custom SSH connection string with one of the following formats:

« For UPN credentials:

<Requester>+<Username@Domain>+<System Name>@<Password Safe>

« For down-level logon names\non-domain credentials:

<Requester>@<Domain\\Username>@<System Name>@<Password Safe>

You can override the default SSH port and enter port 4422. The requester is then prompted to enter their password, which they use to
authenticate with Password Safe.
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« For UPN credentials:

ssh -p 4422 <Requester>+<Username@Domain>+<System Name>@<Password Safe>

o For down-level logon names\non-domain credentials:

ssh -p 4422 <Requester>@<Domain\\Username>@<System Name>@<Password Safe>

o For an SSH application:

ssh -p 4422 <Requester>@<Account name>:<Application alias>@<System name>@<Password Safe>

Once the requester is authenticated, they are immediately connected to the desired machine.

RDP Session Requests

x Note: RDP Direct Connect supports push two-factor authentication. An access-challenge response is not supported.

LDAP users that use the mail account naming attribute cannot use RDP Direct Connect.

To request an RDP session using Direct Connect:

1. Click the arrow to download the RDP Direct Connect file from
Status Platform @ Application @® Workgroup @ ISA

Password Safe.

T
This is a one-time download. Each account and system Tof1avalable  Windows
combination requires that the user download the unique RDP file i

associated with it.

2. Run the file to establish a connection to the targeted system.
3. Therequesteris then prompted to enter the password they use to authenticate with Password Safe.

Direct Connect Delimiters

You can customize the character delimiters accepted in a Direct Connect connection string (in addition to + and @) by setting the following
registry key:

HKEY_LOCAL_MACHINE\SOFTWARE\BeyondTrust\PBPS\SessionManager\direct_connect\delimiters (REG_SZ)

Additionally, you can enable support for a dynamic delimiter. When this is enabled, any connection string that starts and ends with the
same non-alphanumeric character is split on that character.

p Example: /' used as the delimiter:

ssh -p 4422 /requestor/maccount/msystem/@bihost

To enable dynamic delimiters (default is off), set the following registry key:
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HKEY_LOCAL_MACHINE\SOFTWARE\BeyondTrust\PBPS\SessionManager\direct_connect\dynamic_delimiter =1 (REG_
DWORD)

Use Two-Factor Authentication Token

RDP and SSH Direct Connect sessions support using a two-factor authentication token.

+ RDP session: A delimiter (,) must be entered after you enter the password. For example: password, token
The delimiter can be changed using the following registry key:
HKEY_LOCAL_MACHINE\SOFTWARE\BeyondTrust\PBPS\SessionManager\rdp_proxy\2fa_delimiter

The delimiter must be excluded from user login passwords.

« SSH session: You are prompted to enter a token after you enter the password.

Configure RDP Sessions

Enable Smart Sizing

When in an RDP session, the user can choose to smart size the client window so that no scroll bars display.

You can enable Smart Sizing on the Session Monitoring Configuration page by checking the box.

Turn Off Font Smoothing

Font smoothing is turned on by default. To turn off font smoothing, change the following registry key value from 0 to 1

HKEY_LOCAL_MACHINE\SOFTWARE\Beyondtrust\PBPS\SessionManager\rdp_proxy\disable_font_smoothing = 1 (DWORD)

Configure RDP Port for Connection to Target System

Administrators can set an RDP connection port for a specific Windows managed system on a per-system basis. One or more RDP ports
can be configured. Administrators can also use a Smart Rule to target a set of managed systems with the new RDP connection port.

+ To setthe RDP port for a managed system, go to Configuration > Privileged Access Management > Global Settings >
Sessions, and then enter the Default RDP port for new Managed Systems.

« Toeditan RDP port, go to Managed Systems and then click the ellipsis to the right of the Windows managed system. Select Edit
Managed System. Under Identification, edit the port.

o Tosetan RDP port using a Smart Rule, go to Smart Rules. Select Asset under the Smart Rule type filter. Click Create Smart
Rule. Under Actions, select Windows as the Platform, and then set the port.

« To set more than one port, go to Smart Rules. Select Managed System under the Smart Rule type filter. Click Create Smart
Rule. Under Actions, select Set port on each system, and then enter the port. Click Add another action for each additional
port.

Configure Session Proxy Ports
Ports are configured in the registry.
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RDP:

HKEY_LOCAL_MACHINE\SOFTWARE\BeyondTrust\PBPS\SessionManager\rdp_proxy\listen_port (DWORD, default 4489)
SSH:

HKEY_LOCAL_MACHINE\SOFTWARE\BeyondTrust\PBPS\SessionManager\ssh_proxy\listen_port (DWORD, default 4422)

Session Countdown Duration

You can configure the maximum amount of time for which the session countdown timer is displayed by setting the following registry key:

HKEY_LOCAL_MACHINE\SOFTWARE\Beyondtrust\PBPS\SessionManager\rdp_proxy\countdown_duration (DWORD value in
seconds, default is 1800)
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SSH Client Check and Change Password Algorithms

When Password Safe checks and changes passwords, it uses the below list of algorithms to connect and communicate.

Authentication Methods Password, Public key, Keyboard interactive

Encryption Algorithms AES, Triple DES, Blowfish, blowfish-ct, blowfish-cbc,

Encryption Modes CBC, CTR

Host Key Algorithms RSA, DSS, ecdsa-sha2-nistp256, ecdh-sha2-nistp384, ecdh-sha2-nistp521, ssh-ed25519

Key Exchange Algorithms curve25519-sha256, ecdh-sha2-nistp256, ecdh-sha2-nistp384, ecdh-sha2-nistp521, diffie-hellman-

group-exchange-sha256, diffie-hellman-group16-sha512, diffie-hellman-group18-sha512, diffie-
hellman-group14-sha256, diffie-hellman-group14-sha1 (disabled by default), diffie-hellman-group-
exchange-sha1 (disabled by default), diffie-hellman-group1-sha1 (disabled by default)

MAC Algorithms MD5, SHA-1, SHA-2, HMAC-MD5, HMAC-MD5-96, HMAC-SHA1-96
Symmetric Key Algorithms arcfour256, arcfour128, arcfour

The Following Algorithms Are Disabled by Default

diffie-hellman-group1-sha1 arcfour256 HMAC-SHA1-96
diffie-hellman-group-exchange-sha1 arcfour128 aes256-cbc
blowfish-ctr arcfour aes192-cbc
blowfish-cbc HMAC-MD5 aes128-cbc
3des-cbc HMAC-MD5-96

Use the Following Registry Keys to Turn on the Algorithms

e HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\eEye\RetinaCS\SshKeyExchangeAlgorithms (DWORD) = 1023
(enables all key exchange)

e HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\eEye\RetinaCS\SshEncryptionAlgorithms (DWORD) = 31 (sets all
encryption algorithms)

e HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\eEye\RetinaCS\MacAlgorithms (DWORD) = 15 (sets all MAC
algorithms)

;{ Note: These values are in decimal.

Weak RSA server host keys shorter than 1024 bits are rejected by default. Use the following registry key to change this setting:
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\eEye\RetinaCS\SshMinimumRsaKeySize (DWORD) = 1024 (size of key

and bits)
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Configure Session Monitoring

Session monitoring records the actions of a user while they access your password-protected managed systems. The actions are recorded
in real time with the ability to bypass inactivity in the session. This allows you to view only the actions of the user.

You configure session monitoring when you add or edit a managed system.

There are additional settings you must configure, such as concurrent sessions and screen resolution.

x Note: All registry changes must be done on each machine hosting a resource broker.

File Location

When a session is complete, the logs are copied to your Azure storage account and they can be played from there. If the copy fails, logs
are saved in the folder C:\program files\beyondtrust\resource broker\session manager\data\sessionmonitoring\failed. By default,
the file save is attempted three times over a 60 second retry period before it is copied to this folder.

We allocate whatever space is required to retain the data. Session data is retained for 1 year.

Configure Concurrent Sessions

Remote sessions can be limited to a set number of concurrent sessions.

Create New Schedule
The option to increase or limit the number of sessions a user can open at one time is configured @) =ratie Locaton Resictons (sablec
from the schedule settings within an Access Policy.

Policy Types

At least one Policy Type must be enabled in order for the Access Policy to take effect.

To modify the number of concurrent sessions:

@ ViewPassword (disabled)

1. Navigate to Configuration > Privilege Access Management Policies > Access Q@ R0 (enabie

Policies. topraners
-] 1 O Auto Approve

Select an Access Policy or create a new one.
8 O unlimited

From the Schedule tab, select an existing schedule or click Create New Schedule to
create a new one.

@ Record (enabled)

Scroll down to Policy Types and select RDP or SSH. e

Enhanced Session Auditing

Set the number for the Concurrent option.

[ Loseff on Disconnect @

6. Click Update Schedule or Create Schedule to save the schedule. .

O RoP Admin Console @

@ ssH(enabled)
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If a user tries to open more sessions than allowed, a message displays on

Approval History

the Requests page. Approvals Required: 0 @

For more information, please see "Configure Password Safe
Access Policies" on page 70. require duak-control

Date Submitted By Response Comment

Auto-approved because
7/5/2016 10:36 AM John Doe Approved this account does not

@® Check-in Request © Open SSH Session

This session may be recorded

| Cannot create a new session. The limit for concurrent sessions has been reached. |

Back to Requests List

Use Session Masking

Passwords can be hidden from session replays by applying a mask. When session masks are active, an SSH session recording at that
time checks the keystrokes against the mask. Any matches are replaced. When the keystroke session is replayed, the viewer sees
asterisks instead of the password. More than one mask can be active at a time.

Masks can be created, changed, and deleted. These actions are captured in user auditing.

1. Navigate to Configuration > Privileged Access Management > Session Masks.

2. Tocreate a mask:

Click Create New Mask above the grid.

Enter a name for the mask and provide the mask pattern.
Leave the Active option checked.

Click Create Session Mask.

3. Toedita mask:

Locate the mask in the grid and click the vertical ellipsis button for it.
Select Edit Session Mask.

Edit the name and pattern for the mask as desired.

Check or uncheck the Active option as appropriate.

Click Update Session Mask.

4. To delete a mask, click the vertical ellipsis button for the mask, and then select Delete.

Configure Keystroke Logging

Password Safe records keystrokes for all recorded sessions. Keystroke logging is enabled by default. When you open a recorded session,
the pane on the right displays keystrokes. You can select a keystroke entry to view where that keystroke occurred. You can also filter
keystroke entries by date, time, or keystroke in the Search box.

Turn Off Keystroke Logging

You can turn off keystroke logging for ISA users and admin sessions as follows:

1. Navigate to Configuration > Privileged Access Management > Global Settings.
2. Under the Session Monitoring settings, clear the applicable keystroke logging options.
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3. Click Update Session Monitoring Settings.

Keystroke logging can be enabled for all other users when setting the scheduling options for an access policy.

i For more information, please see "Configure Password Safe Access Policies" on page 70.

Enhanced Session Auditing

Enhanced session auditing captures and records all mouse activity in the Keystrokes menu of Recorded Sessions for RDP and RDP
application sessions. Enhanced session auditing is enabled by default. It uses the rules in the access policy for Admin Session multi-
session checkouts. During a recorded RDP session, an agent called pbpsmon is installed on the host for the duration of the session. The
agent monitors and audits Windows click events.

x Note: Session monitoring captures text that is copied in an RDP session window. The copied text is captured only the first
time. Any subsequent copy tasks of the same text are not captured for the session.

x Note: To use enhanced session auditing, the functional account of the managed Windows host or Remote Desktop Services
host must have administrative rights.

Turn Off Enhanced Session Auditing ISA Users

1. Navigate to Configuration > Privileged Access Management > Global Settings.
2. Under the Session Monitoring settings, clear the applicable enhanced session auditing options.
3. Click Update Session Monitoring Settings.

You can turn off enhanced session auditing for admin sessions and all other non-ISA users, when setting the scheduling options for an
access policy.

Troubleshoot Enhanced Session Auditing

The following files are deployed as part of enhanced session auditing:

« pbpsdeploy (Password Safe Deployment Agent service)

o pbpsmon

+ pbpslaunch

« pbpsmon and pbpslaunch (These are contained in a cab file that is copied to the Windows directory and extracted to C:\pbps\.)

pbpsdeploy

The pbpsdeploy.exe file resides in the Windows directory (C:\Windows).

« Access to ADMINS is required to copy pbpsdeploy.exe from Password Safe to the target server.
« Confirm the service is displayed in the Services snap-in after deployment.
o The output from the deployment service should be in the pbsm logs.
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P Example:

2017/03/07 15:47:12.186 2292 6548 INFO: Pushing pbpsdeploy service to 10.200.28.39 as
user backupadmin

2017/03/07 15:47:13.528 2292 6548 INFO: Starting pbpsdeploy service on 10.200.28.39 as
user backupadmin

2017/03/07 15:47:13.593 2292 6548 INFO: Copied pbpsmon.cab

2017/03/07 15:47:13.716 2292 6548 INFO: pbpsmon install:
Using binary directory C:\Windows\
Created directory C:\pbps
Extracting File "pbpsmon.exe" (Size: 15872 bytes) -> "C:\pbps\pbpsmon.exe"
Extracting File "pbpslaunch.exe" (Size: 145408 bytes) -> "C:\pbps\pbpslaunch.exe"
Extracting File "msvcpl20.dll" (Size: 455328 bytes) -> "C:\pbps\msvcpl20.dl1l"
Extracting File "msvcrl20.d11" (Size: 970912 bytes) -> "C:\pbps\msvcrl120.d11l"
Extracting File "vccorlibl20.dl11"™ (Size: 247984 bytes) -> "C:\pbps\vccorlibl120.d11"
Extracting File "libeay32.d11" (Size: 1359872 bytes) -> "C:\pbps\libeay32.d11"
Extracting File "ssleay32.dl1l" (Size: 252928 bytes) -> "C:\pbps\ssleay32.dl11l"
Creating registry keys
Registry keys successfully created
Creating task
Task successfully created

pbpsmon

Verify the following setup has been performed by the deployment service:

« In Task Scheduler, confirm the following task is P _—
created: BeyondTrust Password Safe Monitoring Task, or €9 |7[=]Him _ |
BeyondTrust Password Safe Disposable Monitoring Task. The e m ; — =
task name depends on how enhanced session monitoring was R e Sl e
installed. -

< ] »( | & Enable Al Tasks Hstory
Genersl | Triggers | Actions | Conditions | Settings | History (disablec) | L] :: Folder... ,
Name: [BeyondTrust Password Safe Monitoring Task B et
Location:  \ s
Author: BeyondTrust Password Safe
osrpton I —
o o
When running the task, use the following user account: - - :::ﬂ 1
e et 9 " _»_l_‘ m‘ | -

« Inregedit, the following registry key is created, which creates the disconnect event:

HKLM\System\CurrentControlSet\Control\Terminal Server\Addins\PBPSMON

pbpslaunch

Verify the following setup has been performed by the deployment service:
« Inregedit, the following registry key is created:

HKLM\Software\Microsoft\Windows NT\CurrentVersion\TerminalServer\TSAppAllowList\Applications\pbpslaunch
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« A pbpslaunch entry exists in RemoteApp Manager.

¢ m Ao
RemoteApp Manager

- i

RD Session Host Server Settings.
Overview B
RD Gateway Settings.
Digital Signature Settings.
24 InportRemotedpp Setings
Refresh

\gs Change

view »

b

tion Options
eApp program and choose an

@ Clients will connect with custom RDP setings. it
© More sbout disribution optons

ome T TR web Ace. [ Argumerts |
Tcacutor CWndowhpemiBalies | Yes  Disaled

« Locate the log statement Accepting RDP Channel <name>. There should be one for pbpsmon, and if it is an application session,
one for pbpslaunch.

p Example:

2017/03/07 15:47:14.659 3672 4788 INFO: Accepting RDP Channel PBPSMON

« The Event Viewer on the target server includes setup and cleanup results of pbpsmon and pbpslaunch sent to pbsmd.
Open Event Viewer.

Expand Windows Logs.

Click Application.

L h o=

Filter the application log on Source = pbpsdeploy.

Configure Algorithms used by the Session Monitoring Proxy

The encryption algorithms (ciphers), host key algorithms, key exchange (kex) algorithms, and MAC algorithms that may be used by
Password Safe between the user's SSH client and the SSH proxy are configurable using the following registry keys:

e HKEY_LOCAL_MACHINE\SOFTWARE\BeyondTrust\PBPS\SessionManager\ssh_proxy\host_key_algorithms

o HKEY_LOCAL_MACHINE\SOFTWARE\BeyondTrust\PBPS\SessionManager\ssh_proxy\kex_algorithms

e HKEY_LOCAL_MACHINE\SOFTWARE\BeyondTrust\PBPS\SessionManager\ssh_proxy\macs

The encryption algorithms (ciphers), host key algorithms, key exchange (kex) algorithms, and MAC algorithms that may be used by
Password Safe between the SSH proxy and the managed system are configurable using the following registry keys:

« HKEY_LOCAL_MACHINE\SOFTWARE\BeyondTrust\PBPS\SessionManager\ssh_proxy\client_ciphers

« HKEY_LOCAL_MACHINE\SOFTWARE\BeyondTrust\\PBPS\SessionManager\ssh_proxy\client_host_key_algorithms

« HKEY_LOCAL_MACHINE\SOFTWARE\BeyondTrust\PBPS\SessionManager\ssh_proxy\client_kex_algorithms
« HKEY_LOCAL_MACHINE\SOFTWARE\BeyondTrust\PBPS\SessionManager\ssh_proxy\client_macs

Each of these keys, if defined, must hold a multi-string value (REG_MULTI_SZ), with one algorithm name per line.
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For example, ciphers might be:

o aes128-ctr
e aes192-ctr
o aes256-ctr

This restricts the available encryption algorithms to those named.
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Use DSS Authentication

Applying DSS authentication on a managed system is a secure alternative to using password authentication. DSS authentication is set on
the functional account and managed account properties.

DSS authentication is supported on the following systems: Linux, AlX, HP-iLO, HP-UX, DRAC, MAC OSX, Solaris, Juniper, and RACF.

Generate and Distribute the Key

You can generate keys using puttygen.exe on Windows systems and ssh-keygen on Unix-based systems. Consult the system
documentation for other platforms.

P Example: How to generate a 2048-bit RSA key pair with ssh-keygen. The user account used to perform the scan is admin.

# ssh-keygen -t rsa -m PEM

Generating public/private rsa key pair.

Enter file in which to save the key (/home/admin/.ssh/id rsa):
/home/admin/.ssh/retina_ rsa

Enter passphrase (empty for no passphrase):

Enter same passphrase again:

Your identification has been saved in /home/admin/.ssh/retina rsa.
Your public key has been saved in /home/admin/.ssh/retina rsa.pub.
The key fingerprint is:
T7f:5f:e3:44:2e:74:3c:c2:25:2b:82:7c:£8:0e:2a:da

/home/admin/.ssh/retina_rsa contains the RSA authentication identity of the user and should be securely transferred to the system
running your scanner.

The file lThome/admin/.ssh/retina_rsa.pub contains the RSA public key used for authentication. The contents of this file should be added
to the file ~/.ssh/authorized_keys on all machines that the user wishes to scan using public key authentication.

Create a Functional Account with DSS Authentication

Before you can create the account you must generate a private key. Copying or importing a key is part of setting the functional account
properties with DSS authentication.

In BeyondInsight, go to Configuration > Privileged Access Management > Functional Accounts.
Click Create New Functional Account.

For the Type, select Asset.

Select a platform.

Select the elevation if desired.

Enter the username and password.

From the Authentication Type list, select DSS.

Upload the DSS key file.

Provide an alias and description, and then click Save New Account.

© © N gk ebh-=
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i For more information, please see "Generate and Distribute the Key" on page 152.

Create a Functional Account on the Unix or Linux Platform

Create an account on the Unix or Linux platform with a name like functional_account.
Ensure that the su command is available on the platform.

To assign necessary privileges to the functional account, invoke the command sudo visudo in the terminal and place the following lines
under the root ALL=(ALL) ALL line:

x Note: Be sure to add sudo elevation to the functional account on the managed system. These commands are adjusted to
reflect password changes and DSS key changes and are OS-specific.

MAC OSX

functional account ALL=(ALL) NOPASSWD: /usr/bin/grep, /usr/bin/sed, /usr/bin/tee, /usr/bin/passwd

UBUNTU/REDHAT

functional account ALL=(ALL) NOPASSWD: /usr/bin/grep, /usr/bin/sed, /usr/bin/tee, /usr/bin/passwd

SOLARIS

functional account ALL=(ALL) NOPASSWD: /usr/bin/grep, /usr/bin/cp, /usr/bin/tee, /usr/bin/sed,
/usr/bin/passwd, /usr/bin/rm

HPUX

functional account ALL=(ALL) NOPASSWD: /usr/bin/grep, /usr/bin/cp, /usr/bin/sed, /usr/bin/tee,
/usr/bin/passwd, /usr/bin/rm

AIX

functional account ALL=(ALL) NOPASSWD: /usr/bin/grep, /usr/bin/pwdadm, /usr/bin/tee,
/usr/bin/passwd, /usr/bin/sed, /usr/bin/cp, /usr/bin/rm

Test the Functional Account

The key can be tested from the managed system.
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1. From the menu, select Managed Systems.
2. Select the managed system, and then click the More Options button.
3. Select Go to advanced details.
4. Select Functional Accounts. _ < .
Advanced Details
5. Click Test Functional Account. Vanaged Accounts Credentials ©
Smart Groups [T change Password no)

Linked Accounts

Server Keys
SSH Key File

Functional Account

(or dlick)

UPDATE FUNCTIONAL ACCOUNT DISCARD CHANGES

Set DSS on the Managed Account

An alternate and secure way to set up a managed account is with DSS authentication.

Before you can create the account, you must generate a private key. Copying or importing a key is part of setting the managed account
properties with DSS authentication.

To create a managed account with DSS authentication:
1. From the menu, select Managed Systems.

2. Select the managed system, and then click the More Options button.
c & D *
3. Select Create Managed Account. K

rAa
LdJ

Description

1

sdfs
0 Create Managed Account
ip )
(& Edit Managed System...
(i) Go to advanced details...
1 Delete
SALES: www.beyondtrust.com/contact SUPPORT: www.beyondtrust.com/support DOCUMENTATION: www.beyondtrust.com/docs 154
©2003-2024 BeyondTrust Corporation. All Rights Reserved. Other trademarks identified on this page are owned by their respective owners. BeyondTrust is not a chartered bank or trust company, or TC: 5/2/2024

depository institution. It is not authorized to accept deposits or trust accounts and is not licensed or regulated by any state or federal banking authority.



PASSWORD SAFE CLOUD 24.1

I BeyondTrUSt ADMIN GUIDE

4. From the Authentication Type list, select DSS.
Create Managed Account >

Credentials &

Password

Confirm Password

[Athertication Type
DSs v
L

SSH Key File

(or click)

Passphrase

Confirm Passphrase

5. Configure all other settings as required, and then click Create Account.

i For more information, please see the following:

o "Generate and Distribute the Key" on page 152

o "Work with Managed Accounts"” on page 33

DSS Key Auto Management

A DSS key policy is set on a managed system that supports DSS authentication.

The Auto-Managed DSS key option enables DSS key auto-management to take place when the password for the account is changed,
either manually or scheduled. It follows the same schedule as password changing.

Generating a new DSS public/private key pair results in the removal of the old public key (if there is one) from the authorized_keys file
and appends the new public key.

i For more information, please see "Create a DSS Key Policy"” on page 156.

Get the Public Key

1. Go tothe Managed Accounts page.
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2. Select the account and then click the More Options button.

3. Select Public Key. [E] Go to advanced details... i
Note: If a public key has been supplied, a popup displays the (£ Edit Account... P
current public key.

i Delete

Create a DSS Key POIICy Test Password
Password Safe ships with a default DSS key policy: B Sync Account I

e Type: RSA

. Bitsize: 2048 Password History...

« E tion: Auto M P h is Default P Poli

ncryption: Auto Managed Passphrase is Default Password Policy
You can change the settings for the default policy but you cannot delete the policy. G
~

Optionally, you can create additional policies. @ m

1. Select Configuration > Privileged Access Management > DSS Key Policies. g

2. Click Create DSS Policy.

3. Provide a name and description.

4. SelectaKey Type: RSA or DSA.

5. Enable encryption.

6. Selecta password policy.

7. Click Create DSS Key Policy.
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Configure Password Safe Agents

Configure the Password Change Agent

Password Safe automatic password changes are controlled by the change agent that runs as a service on the U-Series Appliance. When
the change agent runs, it checks the configuration to determine operational parameters of the U-Series Appliance. Logs provide a record
of the change agent activities and messages, and indicate success or failure.

The following overview explains how the change agent runs:
1. The change agent retrieves a process batch from the database. A process batch consists of one or more managed accounts that
have been flagged for a password change.
The passwords are changed on the managed accounts, and the change is recorded.

The change agent waits a set period of time for a response from the change job and moves to the next process batch in the
database batch.

Recommendations

To maximize efficiency, we recommend a small batch size (such as 5) and a short cycle time (such as 60 seconds). If a password change
fails, the change agent reprocesses it according to the retry value in the change agent settings.
1. Inthe Beyondlnsight Console, go to Configuration > Privileged Access Management Agents > Password Change Agent.
2. Setthe following:
« Enable Password Change Agent: Leave enabled to PASSWORD CHANGE AGENT
activate the agent when Password Safe starts.
* Retry failed changes after (minutes): The amount of time

before a failed password change is tried again. E. Enable Password Change Agent
o Maximum retries: The maximum number of times an
attempt is made to change the password after a failed Retry failed changes after (minutes)
assword change attempt occurs.
§ g e 8 w

« Unlimited Retries: Enable to allow retries when a

password change attempt fails.
Maximum retries

3. Click Save Configuration. =
3

[j:] Unlimited Retries
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Configure the Password Test Agent

The password test agent allows you to manually test all managed accounts and functional accounts. The test ensures that there is an
open connection between the assets and Password Safe. BeyondlInsight sends a notification email.

1. Inthe BeyondInsight Console, go to Configuration > Privileged Access Management Agents > Password Test Agent.
2. Check the Enable Password Test Agent box.

3. Setthe schedule, and then click Save Configuration. PASSWORD TEST AGENT

Enable Password Test Agent

Active Test Tasks
@

schedule Interval

Daily v
Start Time
213 AM. ®

SAVE CONFIGURATION DISCARD CHANGES

Configure Resource Zones

A resource zone is a group of resources on your network. You can have a maximum of 51 resource zones to meet the requirements for
how your network is segmented; however, one zone for your entire network is sufficient. At least one resource zone is required. Password
Safe Cloud creates a default resource zone called Default, which is a catch-all for all domains and workgroups in your network, and
cannot be edited.

Password Safe Cloud uses resource brokers to communicate with the systems in your resource zones. A resource broker is a bundle of
software that contains all of the services and components required for Password Safe Cloud to interact with your on-premises servers
using TCP 443 for communication.

You must download the Resource Broker Installer from the Password Safe Cloud portal and install the broker on a Windows Server
2019 x64 or greater system in your network. Each resource zone must have at least one resource broker installed, but we recommend you
install two or more for efficiency and redundancy of functionality. You may install up to 200 resource brokers across all of your zones. All
200 may be in one zone or dispersed across each of your zones. You cannot generate an install key or run the installer once this threshold
is reached.

x Note: Installing a resource broker on Windows 2016 x64 is supported; however, Windows 2019 x64 is recommended.

A resource zone uses a collection of resource brokers to handle the following four core Password Safe functions. Azure uses a round-
robin technique to communicate with the resource brokers within the zone to handle these functions.

o Authentication against LDAP/Active Directory: Allows authentication into Password Safe against your local LDAP/Active
Directory domains.

SALES: www.beyondtrust.com/contact SUPPORT: www.beyondtrust.com/support DOCUMENTATION: www.beyondtrust.com/docs 158
©2003-2024 BeyondTrust Corporation. All Rights Reserved. Other trademarks identified on this page are owned by their respective owners. BeyondTrust is not a chartered bank or trust company, or TC: 5/2/2024
depository institution. It is not authorized to accept deposits or trust accounts and is not licensed or regulated by any state or federal banking authority.



PASSWORD SAFE CLOUD 24.1

lEI BeyondTrUSt ADMIN GUIDE

+ Asset and Account Discovery: Uses a discovery scanning agent to discover assets and accounts in your network.
« Credential Management: Changes passwords or SSH keys on a scheduled or on-demand basis.
« Session Proxy: Acts as a proxy to allow a standard user to open SSH or RDP sessions on systems in your network.

For more information on configuring resource zones and installing resource brokers, please see the Password Safe Cloud
Resource Broker Installation and Configuration Guide at https.//www.beyondtrust.com/docs/beyondinsight-password-
safe/ps/cloud/resource-broker/index.htm.
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Add Ticket Systems to the List on the Requests Page

Password Safe can be configured to allow references to ticketing systems in the password release requests. This provides a method to
include information that can be cross-referenced to an existing ticket or change control system for auditing purposes, or to be used in the
approval process.

You can create a list of ticket system labels to populate the Ticket System list on a request.

1. In BeyondInsight, go to Configuration > Privileged Access

Management > Ticket Systems. Beyondinsight = Configuration
lal BeyondTrust > Privileged Access Management > Ticket Systems.
2. From the Ticket Systems pane, click Create New Ticket System.
. . TICKET SYSTEMS < New Ticket System Details
3. Select BeyondTrust Ticket System from the Platform list.
4. Enter a name and description. a | || [Boomdrost e syt ’
Create New Ticket System @) Functional | Account
5. Click Create Ticket System. v
KH-Lab Snow Ticketing o e
‘ BT Ticket System ) ‘
Description (optional)
BT Ticket System o
\ |
PR
\ |
Make Ticket System the Default
For information on integrating third party ticket systems, such as BMC Remedy, CA Service Desk, Jira, and ServiceNow with
Beyondinsight and Password Safe, please see the following:
» BeyondTrust Beyondinsight Guides at https://www.beyondtrust.com/docs/beyondinsight-password-safe/bi/index.htm
o BeyondTrust Password Safe Guides at https.//www.beyondtrust.com/docs/beyondinsight-password-
safe/ps/index.htm
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Customize Email Notifications

Email notifications are used to alert users on particular Password Safe actions, such as connection profile alerts, release requests, and
password check failures.

Email Notifications Sent by Password Safe

The below table lists the email notifications that are sent to Password Safe users. It includes the event type that occurs to initiate the email
notification and the account types that receive the email.

Local Accounts (Includes Non-Domain Asset and Database Managed Systems)

m Not configurable Configurable by template settings

Release Request Managed Account's Approver
» Requester (CC)
o Asset's ISA
Request Response Managed NA o Account's Approver (CC)
+ Requester
o Asset's ISA
Password Change Managed o Managed System's ISA NA
Failure

o Built-in Administrators group members
o Managed System contact person
(Managed Systems settings Ul)
Functional « Managed System's ISA NA
 Built-in Administrators group members
» Managed System contact person
(Managed Systems settings Ul)

Password Check Managed » Managed System's ISA NA

Failure o Built-in Administrators group members

o Managed System contact person
(Managed Systems settings Ul)
Functional + Managed System's ISA NA
o Built-in Administrators group members

o Managed System contact person
(Managed Systems settings Ul)

Propagation Event Managed + Managed System contact person NA

Failure (Managed Systems settings Ul)
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Privileged Password | Managed « Managed Account Release NA
Release Notification Recipients (Managed

Accounts settings Ul)
Non-Managed Managed » Managed Account Release NA
Release Expiration Notification Recipients (Managed

Accounts settings Ul)

Domain Accounts

m Not configurable Configurable by template settings

Release Request Managed Account's Approver

o Requester (CC)
« Domain Management permission (with
Read/Write)
Request Response Managed NA « Account's Approver (CC)
+ Requester
« Domain Management permission (with
Read/Write)
Password Change Managed « Domain Management permission NA
Failure (with Read/Write)
o Built-in Administrators group members
o Managed System contact person
(Managed Systems settings Ul)
Functional » Domain Management permission NA
(with Read/Write)
o Built-in Administrators group members
o Managed System contact person
(Managed Systems settings Ul)
Password Check Managed « Domain Management permission NA
Failure (with Read/Write)
o Built-in Administrators group members
« Managed System contact person
(Managed Systems settings Ul)
Functional + Domain Management permission NA
(with Read/Write)
o Built-in Administrators group members
o Managed System contact person
(Managed Systems settings Ul)

Propagation Event Managed « Managed System contact person NA
Failure (Managed Systems settings Ul)
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Privileged Password | Managed o Managed Account Release NA
Release Notification Recipients (Managed

Accounts settings Ul)
Non-Managed Managed » Managed Account Release NA
Release Expiration Notification Recipients (Managed

Accounts settings Ul)

Customize Mail Templates

The subject line and message body for a template can be customized in Password Safe configuration.

In the BeyondInsight console, go to Configuration > Privileged Access Management > Mail Templates.

Select a mail template type from the list. Beyondinsight | Configuration 7 ez 13 ©
. . ) BeyondTrust > Prvleged Access Managemens > Mail Templates

Type the subject line text.

MAIL TEMPLATES < Propagation Action Failure Template Details

amessage body tag,click the copy button and
sage body.

e nh o=

In the Message Body field, add the text for the email: -

« Copy atag from the Body Tags section to a location in the

message body. . :
+ When working within cumulative alert emails, ensure you

add any additional body tags within the <ROW></ROW>

elements.
« Toinclude hyperlinks that link directly to the approval and s

denial pages for a file or password request, use the

Propagation Acton Failure

:approvallink: and :denylink: message body tags.

Release Request

5. Click Save Template.

Note: Only one <ROW></ROW?> tag can be added to the mail template. If you wish to add more tags, they must be added to
the row already present within the template. For example:

<ROW>:AlertTimeUTC: | :AlertTimeClient: | :ComputerName: | :AccountName: |
:AccountDomain: | :DNSName: | :IPAddress: | :EventCode: | :EventReferenceId: |
:SubjectSID:</ROW>
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Configure Workgroups for Advanced Environments

Password Safe allows you to assign Resource Zones to workgroups to give the user more granularity on password changes. Password
Safe uses workgroup assignments at the managed account level to allow Password Safe resource brokers to process password changes,
password tests, and account notifications for their designated workgroup.

If a resource zone is not assigned to a workgroup, the resource broker functions on a global level and can change any account that does
not have a designated workgroup assigned.

Assign a Workgroup to a Managed Account

You can assign a workgroup to a particular managed account by editing the managed account or by using a Smart Rule.

To assign a workgroup to particular managed account, go the Managed Accounts page and select the account to edit. On the Edit
Managed Account page, select a workgroup from the dropdown list.

x Note: If you set the workgroup value to None, the account can be
changed by any Password Safe agent.

To assign a workgroup using a Smart Rule, go the Smart Rules page, and
create or a edit an existing rule. Under Actions, select Assign workgroup Create New Managed Account Based Smart Rule
on each account. Norme

Assign Workgroup o Active

Description

Reprocessing limit

Default v ©
Selection Criteria &
Include Items that match | ALL v | of the following

Asset Smart Group v ‘ [x)

‘ All Assets v ‘

Managed Account Fields - ‘ [x]

‘ Account Name v ‘

and
‘ equals (=) - ‘

‘ pbps.eng [} ‘

Add another condition  Add a new group

Actions B

Assign workgroup on each account - O

BeyondTrust Workgroup -

Add another action

CREATE SMART RULE DISCARD
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Configure and Use Secrets Safe

The Secrets Safe feature minimizes the risk of unauthorized access to secrets. It allows you to securely store secrets owned by
developers and small groups in a controlled environment that you can audit. Secrets Safe supports 3 different types of secrets: credential,
file, and text. Password Safe administrators can assign groups in BeyondInsight to teams, in which each team has its own isolated store
where users can secure secrets used within that team. The creator of the secret becomes the owner and can assign ownership of the
secret to the entire team or one or more individual members. Password Safe administrators and secret owners can manage secret
ownership, edit secrets, and delete secrets, while team members may only view and retrieve secrets. Team members can create a folder
structure to organize their secrets. Secrets can be found and accessed easily using search and filtering options.

Assign the Secrets Safe Feature to a Group

Access to Secrets Safe is granted to users by assigning permissions for the Secrets Safe feature to a group in which the users are

members.
1. In Beyondlinsight, go to Configuration > Role Based Access > User Management.
2. Click the vertical ellipsis for the group you want to assign the Secrets Safe feature to, and then select View Group Details.
3. From the Group Details pane, select Features. e e mrm—— ® Mmesrems
4. From the Features pane, select the Secrets Safe feature. 'Mm — .
v s =6= : -
‘@ Tip: You can filter the list of features by All Features or Disabled . < | e
®  Features, and Feature Name to quickly locate the Secrets Safe
feature.

5. Click Assign Permissions, and then select Assign Permissions
Read Only.

6. Users who are members of the group are granted access to the
Secrets Safe page, where the group is listed as a parent level
folder representing the team.

Beyondinsight = Secrets Safe

(8) BeyondTrust b=

Folders < SECRETS

Allowners ~ Ve

Note: The Secrets Safe feature cannot be removed from a group pssaee © saaseat
if secrets are still contained within the team.

Create a Secret in Secrets Safe

Users can create secrets in the parent folder for any of their teams or in any of their team's subfolders. The user who creates the secret is
its owner and may change its folder at any time after it has been created.

1. From the left menu, click Secrets Safe.
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2. From the Folders pane, select a folder, and then click Add Secret

above the grid FOLDERS {  SECRETS
’ Owner Filter by
3. Select your secret type: Add Credential, Add File, Add Text, or Creste NewFoder @ |l owners K
Import Secrets, and then fill out the form for each type as detailed 8 siisecress

in below steps.

BB Personal Folder
& Add Credential...
]

O addrFie...
=
5 Add Text...
& Import Secrets
Add Credential
Enter a Title, Description, and Username.
Create New Secret >
2. Setthe password: This secret will be owned by you. You may chang its
folder at any time after it has been created.
o Select Manual Input to manually enter a password. Folder
BIPS Engineering Team
+ Select Auto Generate and select a Password Policy from the list to have the password T
created based on the defined policy. Click Generate Password. | Example cregential o
3. Add anote if you require additional information to display for this credential other than its ‘D ::;:cmmial 3
description. You can add Notes as a column when viewing the list of credentials in the grid, and N
you can also filter the list by Notes. ‘ ‘
4. Click Manage Ownership if you wish to assign ownership to individual team members or to the Username
entire team. | agministrator o]
5. Click Create Secret. SetPassword @
@ Manualinput ) Auto Generate
x Note: The Manage Ownership feature will not display if you \ [ show ]
create a secret within your personal folder. et ‘

Owneris)

Manage Ownership
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Add File

Enter a Title and Description. Create New Secret N
Drag the file into the Upload File box or click the box to select a file to upload. erreencronag O Y eI oty e
Click Manage Ownership if you wish to assign ownership to individual team members or to the DevTeneassors2
entire team. P °
4. Click Create Secret. i -
f Note: There are no restrictions on file type; however, files must kA
be 5MB or less. z:;?geizng;/’:ﬁgp‘rgd

Example File Secret °
Ma;age Ownership
Add Text
Enter a Title and Description. Create New Secret >
2' Enter the body Of the teXt ::‘:rs::::::;:i;:’;e: by you. You may change its folder at any time
3. Add a note if you require additional information to display for this credential other than its e
description. You can add Notes as a column when viewing the list of credentials in the grid, and rampe Tex st °
you can also filter the list by Notes.
Bampl Tocgere: e
4. Click Manage Ownership if you wish to assign ownership to individual team members or to the oy
. Example Text Secret °
entire team.
5. Click Create Secret. Exampl ex secet °
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Import Secrets

1. Drag the file into the Import CSV File box or click the box to select a file to upload.

Import Secrets >
2. Select afolder or create a new folder to save the imported secret to. Importthe €SV file with your exported secrets by
following the steps below,
3. Click Import Secrets. mpon S Fle
A
x Note: File type must be CSV. Files must be 200KB or less. v an crop or ik
to select a file o upioad,

Accepted File Types: CSY
Maximum File Size: 200 KE

Selecr Folder

Personal Folder -

o Create Mew Folder

IMPORTANT!

o Import Secret file type must be CSV
o Files must be 200KB or less.

o CSVfiles must contain the following:

o CSV (comma is the only supported field separator)
o Header row (the first row in the file is skipped and seconds are processed starting on line two)
o Eight columns are required (not all columns are used)

= URL

®  Username

= Password

® TOTP <Not Used>

®  Extra <Not Used>

= Name

®  Grouping <Not Used>
= Fav <Not Used>
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o Example: CSV File - url,username,password,totp,extra,name,grouping,fav

e URL Username | Password | TOTP | Extra Name Group | Favourite
https://www.testsite00001.com | TestUser01 | password01 TestName001
https://www.testsite00002.com  TestUser02  password02 TestName002

Manage Folders in Secrets Safe

Users can organize their team secrets into subfolders under the parent team folder to make locating a secret more efficient.

1. From the left menu, click Secrets Safe.
2. To create a new folder, select the parent folder or one of its subfolders, and then click Create New

FOLDERS

Folder. <
Search

3. Enter a name for the folder, and then click Create Folder. Q
Create New Folder A
Folder Name
This folder will be placed under “Dev-TeamPasswords2"
‘ Dev Team Secrets (<]

Create Folder

Showing all 18 Elements

All Secrets

I Dev-TeamPasswords2

4. To edit a folder name or to delete a folder, expand the parent folder, click the vertical ellipsis for a

. FOLDERS < SECRETS
subfolder, and then select Edit Folder or Delete.
Q All owners.
Create New Folder @) © Addse
x Note: You cannot edit the name of a parent folder or delete o :
parent folders. Only subfolders may be deleted. Also, if you do not P—— & o]
own all of the secrets in a subfolder, you are not able to delete it. — N RS
& EditFolder e
1@ Delete

1 For more information on how to move a secret to a new subfolder,
please see "Edit and Delete a Secret in Secrets Safe" on page
170.

View and Copy a Secret in Secrets Safe

Users can view details for their team's secrets, such as who owns the secret, when the secret was created and modified, and the folder
path for the secret. Users can also copy the username and password for a team secret so they may use it.

1. From the left menu, click Secrets Safe.
2. From the Folders pane, select a folder.
3. From the Secrets grid, click the vertical ellipsis for the secret.
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4. Each secret type, as indicated by its Type icon, has specific actions sEcRers
available from the options menu, as follows:

Al owners. - v -

« Forcredential secrets, you can Copy Username, Copy © seaseart ~ cxme
Password, and Copy Notes.

Title ype Description Username File Name Owner(s

o Forfile secrets, you can Download File and Copy Notes. o o :
o For text secrets, you can Copy Text and Copy Notes. g 2 2 ;
5. To view the details for any secret, select View Details from the o | SIS () e Deals
menu. o @ # couseas
= & @ Delete secret
« While viewing the details for a credential secret type, you can: Example Credentil N
o Click the applicable copy icons to copy the username, password, notes, folder B edentil R
path, and secret ID. WL e
o Click the eye icon to show the password. usemame
« While viewing the details for a file secret type, you can: @&
o Click the download icon to download the file. P
o Click the applicable copy icons to copy the notes and folder path. @ e
« While viewing the details for a text secret type, you can: N:;
o Click the applicable copy icons to copy the text body, notes, and folder path. é?ﬁé;ina::?néﬁam
@g :
2

Edit and Delete a Secret in Secrets Safe

Secret owners can edit the properties and manage ownership for secrets they own, as well as delete secrets they own. Password Safe
administrators can edit the properties, manage ownership, and delete all secrets in Secrets Safe.

1. From the left menu, click Secrets Safe.
2. From the Folders pane, select a folder, and then select a secret.
3. Click the vertical ellipsis for the secret. sECRETS
4. To delete a secret, select Delete Secret, and then click Delete on o = -
the confirmation message. © rasect + o LD o
5. Toeditasecret, select Edit Secret.
O o H
[m] [5) €3 CopyText
O & €2 Copy Notes
O b Sereen shor20f [ View Details
= & & Edit Secret
O a M Delete Secret
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6. Modify the properties for the secret as required. To manage the ownership of the secret, click

N Edit Example Credential >
Manage Ownership. . )

Title
‘ Example Credential ° |
Description
| Example Credentil o|
URL
‘ http://google.com ﬁ|
Username

of

Change Password

Notes

Folder

‘ BIPS Engineering Team - |

Owner(s)

Manage Ownership

Update Secret Discard Changes

7. Enable the Assign Ownership to Entire Team option to assign all members of the team as MANAGE GWNERS OF “BENE- N
owners of the secret. When new members are added to the team, they are automatically assigned s onneshp of e et ot team o1t one o e i
as owners of the secret. Alternatively, select individual team members as owners.

@ Assign Ownership to Entire Team @)

8. Click Apply Ownership Settings. s vembers —y ey

Search Members

pPage 1 |oft 25 v items per page

Apply Ownership Settings

9. Click Update Secrets once you have made your edits.
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Password Safe PS_Automate Utility User Guide

Overview

The Password Safe PS_Automate utility helps to avoid the need to manually enter credentials when launching Windows GUI applications
from Password Safe, saving time and increasing security.

The PS_Automate utility allows you to seamlessly pass vaulted credentials from Password Safe to a remote application using the pass
through option (using token pass instead of credentials). This includes the ability to launch and authenticate to a web page or to a standard
Windows GUI application.

To ensure a seamless experience, the utility supports Incognito mode for popular web browsers, such as Chrome, Firefox, and Microsoft
Edge, with Edge being the default. By using an INI file, you can easily specify the input and operational behavior for the utility.

The PS_Automate utility, as well as INI files for Amazon Web Services, Azure, Office 365, and Google, are made available when
enhanced session auditing is enabled in Password Safe. The files are deployed by the session proxy when a session is created in
Password Safe.

The system where the PS_Automate utility is deployed must have internet access, in order to automatically download the latest version of
the required browser drivers on first use:

e chromedriver.exe
o msedgedriver.exe

« geckodriver.exe

The utility uses the browser drivers, and the versions of the drivers must match the versions of the browsers used.

x Note: PS_Automate is a utility for Windows only. It is not supported on macOS.

Usage

The usage syntax for the PS_Automate utility is as follows:

Web Applications

ps_automate.exe [ini=path to inifile] [TargetURL=url] [BrowserName=name of browser]

Windows Applications

ps_automate.exe [ini=path to inifile]

x Note: For testing purposes the utility also accepts username and password on the command line: [username=username]
[password=password]. However, this is not recommended for production use, as command line parameters can be written
to Windows logs, such as the event log.
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P Example:

ps_automate.exe ini="BIWebApp.ini"
TargetURL="https://localhost/WebConsole/index.html#!/dashboard" BrowserName="chrome"

ps_automate.exe ini= "C:\automate\AWSWebApp.ini"
TargetURL="https://534949981440.signin.aws.amazon.com/console/" BrowserName="firefox"

ps_automate.exe ini="MSWebApp.ini"
TargetURL="https://login.microsoftonline.com"BrowserName="msedge"

ps_automate.exe ini="ssms database.ini"
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Define Command Line Arguments in INI File

INI files are commonly used configuration files for storing settings and preferences for applications. The PS_Automate utility uses INI files
to specify its own settings and parameters. It is generally provided as a command line parameter, for example, ini=login.ini. If no file is
specified, the utility looks for an INI file in the same source directory with the same name as the utility, i.e. ps_automate.ini.

When command line arguments are provided, they can technically be listed in any order as each is prefixed with the argument name, i.e.
argument=value.

The following common predefined INI files are included with the deployment of the PS_Automate utility.

« AWSWebApp.ini for Amazon Web Services logins

« BIWebApp.ini for Beyondinsight logins

* GoogleWebApp.ini for Google URL logins

o MSWebApp.ini for Microsoft URL Logins

« ssms_database.ini for SQL Server Management Studio v18 logins

The INIfile is in standard INI format consisting of one or more sections with each section containing one or more key/value pairs. Each of
the sections and their key/value pairs are described below.

General Section

The [General] section defines the main settings for the application. Each setting and its accepted values are listed below.

sting _[oofimiion
BrowserName Value: String (default is msedge)
Required: No
Description: Specifies the browser to launch for web app login (Edge, Chrome, Firefox). The browser can
be specified in the INI file or overwritten by command line parameters.

TargetURL Value: String
Required: Yes
Description: Specifies the web app URL. The URL can be specified in the INI file or overwritten by
command line parameters.
EnableLogging Value: Integer
» 0 Nologging (default)

o 1 Errorlevel
o 2 Warning level
¢ 3 Infolevel

o 4 Debug level (Used for troubleshooting issues. A new console window is launched.)
Required: No
Description: Specifies if logging should be enabled.
LogMethod Value: Integer
e 1 Log to file (default)
e 2 logtodebug window
o 3 Logtoboth

Required: No
Description: Specifies what log method to use.
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LogPath Value: Valid file path

Required: No

Description: Specifies the path to create log files. Defaults to script path.
FixupPassword Value: Boolean (1*|0)

Required: No

Description: Specifies a different method of parsing out the password parameter. This allows a wider
array of complex passwords to be used, such as space and quotes. Defaults to true.

RunApp Value: Any valid Windows executable. May include custom command line values.
Required: Only when TargetURL is not used.
Description: This is the initial application launched by the utility. The RunApp may also contain values
based from the command line.

FileChangeDir Value: Any valid Windows directory. May NOT include custom command line values.
Required: No
Description: This is the initial working directory for the app in RunApp. Some apps require a custom
WorkingDir value.

AppWindowTitle Value: Any valid Windows title name.
Required: No
Description: This is the window the utility initially connects to for targeting commands. We recommend
providing this value; otherwise, the currently active window is targeted, which may lead to undesirable
results.

WindowTitleMatchMode | Value: Integer (-1%,-2,-3,-4,1,2,3)
Required: No
Description: This is the method used to match the AppWindowTitle with the actual window text. The
default is a case-insensitive search from the start of the window text.

For more information, please see Windows Titles and Text at
https://www.autoitscript.com/autoit3/docs/intro/windowsadvanced.htm.

IgnoreCerts Value: Integer (1*|0)
Required: No
Description: Enabling this option causes the Certificate warning screen to be automatically bypassed
(accepted). This option only works on localhost for Chrome and Edge. Firefox does not have a localhost
limitation.

;{ Note: This setting is for testing purposes only as bypassing certificates is NOT secure.

GlobalSequenceDelay Value: Integer in milliseconds (default is 250)

Required: No

Description: How much time to wait in between each TaskSequence.
KioskMode Value: Integer (0 | 1) (default is 0)

Required: No

Description: Set to 1 to enable Kiosk mode in the browser. Application runs in full screen without any
browser user interface such as toolbars and menus.

Credentials Section

The [Credentials] section is an optional section used for hard coding the username and password values into the INI file. When this
section is provided, both keys are required and override any command line values provided.
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}{ Note: This section is used for testing. We recommend you secure any INI files containing credentials.

Seting | Detiniion

UserName Value: Valid username
Required: Yes
Description: The username to provide to the security dialog. Specified as %username% to the provided task.

Password Value: Valid password.
Required: Yes
Description: The password to provide to the security dialog. Specified as %password% to the provided task.

TaskSequences Section

The [TaskSequenceX] sections of the INI file define the tasks to take once the RunApp or TargetURL has been accessed.
Place each [TaskSequenceX] in its own section in the INI file in sequential order and ideally order them numerically as per the following

example:

[TaskSequencel]
task=value

[TaskSequence?2]
task=value

[TaskSequence3]

Each [TaskSequenceX] can perform one or more tasks. Generally, a specific task sequence consists of providing information to target
the appropriate dialog box/control and then send text or a command to it, for example click. Most pages generally require a minimum of
two task sequences, one to populate the username and one to populate the password. Since tasks can be combined within the
[TaskSequenceX], the submission (posting) of these values can be tasks of the same [TaskSequenceX].

Sometimes additional task sequences must be performed before or after supplying credentials. However, it is possible to automate many
actions with a single task sequence through the use of SendKeys for Windows applications only.

App and WebApp task sequences and their values are listed below. All tasks within a task sequence are optional, though some depend on
others or are mutually exclusive.

Each task can be defined only once within each [TaskSequenceX].

App Task Sequences

App task sequences begin after being initiated by a RunApp.

The standard function of a sequence is to enter a string of data (SendKeys) into a particular control (AppWindowControllD) on a
window. If a control is provided to the sequence, the utility attempts to attach to the control, focus it, and send it directly to the control. This
is a very accurate way of targeting commands. If no control is provided (or one can’t be found), the commands can still be issued to the
active window/control.

In addition to the tasks from the generic task sequences, the following tasks are applicable for the RunApp (App) task sequences.
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Setting Definition

SequenceDelay Value: Integer in milliseconds (default is 0)
Description: How much time to wait at the beginning of each task sequence. This is in addition to any
value provided in GlobalSequenceDelay.

SendKeys Value: Any valid string of characters
Description: A sequence of characters to send to the focused control/field. The utility supports the
special characters defined by Autolt({TAB}, {ENTER, etc.) when using the default mode of
SendKeysRaw.

j For more information on the special keys, please see the following:

« Send Command at https://www.autoitscript.com/autoit3/docs/functions/Send.htm

o Send Keys Command at
https.//www.autoitscript.com/autoit3/docs/appendix/SendKeys.htm

SendKeysDelay Value: Integer in milliseconds (default is 5)
Description: This is the amount of time the utility waits in between each key stroke sent by SendKeys. It
may be necessary to increase this delay if the interface cannot respond quickly enough to the send keys.

SendKeysRaw Value: Boolean (1*|0)
Description: Changes the interpretation of the SendKey sequence to be raw (literal). It will not interpret
any of the special characters as defined by the Autolt Send command. Due to the complexity of the
characters often involved, we recommend setting this when using SendKeys to send passwords .

AppWindowTitle Value: Any valid Windows title name.
Required: No
Description: This is almost identical to the AppWindowTitle specified in the generic task sequences.
However, this is used to target to a new window that may be open during the authentication attempt. This
value only needs to be provided if a new window requires focus. For instance, clicking on a login button
may present a security warning or legal disclaimer in a new window which requires targeting. While it is
not always required to target the new window directly, it can improve accuracy.

WindowTitleMatchMode Value: Integer (-1*,-2,-3,-4,1,2,3)
Required: No
Description: This is identical to the WindowTitleMatchMode specified in the generic task sequences;
however, it targets the AppWindowTitle App task sequence.

AppWindowControllD Value: Any valid window control ID name.
Description: When provided, the utility targets the control directly. Valid control names are found with the
Autolt Windows Info utility and can be provided in a variety of formats.

For more information, please see ControlCommand at
https.://www.autoitscript.com/autoit3/docs/functions/ControlCommand.htm.

AppWindowControlClick | Value: Boolean (1*|0)
Description: Sends a standard left click event to the control defined in AppWindowControlID. Often,
SendKeys can be used to simply send an {ENTER} command to a focused control, but in some
circumstances, it may be necessary to send a click directly.
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WebApp Task Sequences

The web application depends on a TargetURL from the General section. Task sequences use Xpath to find and click the web page
element.

The standard function of a web application task sequence is to enter an Xpath string for the element you want to interact with, as well as a
value for the element.

The webapp tasks rely on browser drivers to accomplish their tasks. The utility automatically downloads the browser driver to the same
location as the utility. The browser version (major.minor.build) must match the driver version or the utility may fail to launch the browser.
For example, chromeDriver 100.0.4896 will work with Chrome browser 100.0.4896.x.

Ensure the functional account used for the RDS Session has network permissions that allow the PS_Automate to access the internet. For
example, add the functional account to GPO, thereby allowing the functional account to use the proxy.

In addition to the tasks from the General section, the following tasks are applicable for the WebApp TaskSequences section.

Setting Definition

XPathElement Value: Xpath string for the element
Description: Goes to the element specified.

XPathValue Value: Xpath string for the element value.
Description: Enters the text specified into the element.

XPathAction Value: String value click, clear.
Description: Clicks on the element specified by XPathElement.

Certificates

For keeping sensitive web traffic information secure, certificates are used. The PS_Automate utility has the ability to IgnoreCerts, which
are provided for internal self hosted websites and for testing only.

Chrome and Edge browsers can ignore certificates for localhost only. The Firefox browser does not have this limitation.

Web App Known Issues

1. When multiple RDP sessions are launched for the same machine at the same time, the end user may experience a delay with the
automated logon for one of the sessions. One session blocks while the other loads. Once the session successfully loads
(maximum wait time 30 seconds), the other session is able to successfully load its browser and begin the automated login.

2. Manually clicking, opening new browser windows, or creating tabs on the launching of the automated browser can cause the
automated login to fail.

3. Issues automatically updating the Firefox driver (geckodriver) to the latest version. If PS_Automate fails to launch the Firefox
browser, one possible cause is that the driver version is out of date. PS_Automate attempts to update the driver; however, there is
a known issue where geckodriver updates may fail. In that case download the geckodriver, from
https://github.com/mozilla/geckodriver/ and place it in the same directory as ps_automate.exe.
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